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Notice

This CAD Modeler Getting Started Guide is applicable to GT STRUDL Version 43 and later versions for use on PCs under the
Microsoft Windows operating systems.

Copyright
Copyright © 2024 Hexagon and/or its subsidiaries and affiliates. All rights reserved.

Including software, documentation, file formats, and audiovisual displays; may be used pursuant to applicable software license
agreement; contains confidential and proprietary information of Intergraph and/or third parties which is protected by copyright law,
trade secret law, and international treaty, and may not be provided or otherwise made available without proper authorization from
Intergraph Corporation.

U.S. Government Restricted Rights Legend

Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was
developed at private expense and is "restricted computer software" submitted with restricted rights in accordance with
subparagraphs (a) through (d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal
Acquisition Regulations ("FAR") and its successors, and is unpublished and all rights are reserved under the copyright laws of the
United States. For units of the Department of Defense ("DoD"): This is "commercial computer software" as defined at DFARS
252.227-7014 and the rights of the Government are as specified at DFARS 227.7202-3.

Unpublished - rights reserved under the copyright laws of the United States.

Intergraph Corporation
305 Intergraph Way
Madison, AL 35758

Documentation

Documentation shall mean, whether in electronic or printed form, User's Guides, Installation Guides, Reference Guides,
Administrator's Guides, Customization Guides, Programmer's Guides, Configuration Guides and Help Guides delivered with a
particular software product.

Other Documentation

Other Documentation shall mean, whether in electronic or printed form and delivered with software or on Intergraph Smart Support,
SharePoint, or box.net, any documentation related to work processes, workflows, and best practices that is provided by Intergraph
as guidance for using a software product.

Terms of Use

a. Use of a software product and Documentation is subject to the Software License Agreement ("SLA") delivered with the
software product unless the Licensee has a valid signed license for this software product with Intergraph Corporation. If the
Licensee has a valid signed license for this software product with Intergraph Corporation, the valid signed license shall take
precedence and govern the use of this software product and Documentation. Subject to the terms contained within the
applicable license agreement, Intergraph Corporation gives Licensee permission to print a reasonable number of copies of the
Documentation as defined in the applicable license agreement and delivered with the software product for Licensee's internal,
non-commercial use. The Documentation may not be printed for resale or redistribution.

b.  For use of Documentation or Other Documentation where end user does not receive a SLA or does not have a valid license
agreement with Intergraph, Intergraph grants the Licensee a non-exclusive license to use the Documentation or Other
Documentation for Licensee’s internal non-commercial use. Intergraph Corporation gives Licensee permission to print a
reasonable number of copies of Other Documentation for Licensee’s internal, non-commercial use. The Other Documentation
may not be printed for resale or redistribution. This license contained in this subsection b) may be terminated at any time and
for any reason by Intergraph Corporation by giving written notice to Licensee.

Disclaimer of Warranties

Except for any express warranties as may be stated in the SLA or separate license or separate terms and conditions, Intergraph
Corporation disclaims any and all express or implied warranties including, but not limited to the implied warranties of merchantability
and fitness for a particular purpose and nothing stated in, or implied by, this document or its contents shall be considered or deemed
a modification or amendment of such disclaimer. Intergraph believes the information in this publication is accurate as of its
publication date.

The information and the software discussed in this document are subject to change without notice and are subject to applicable
technical product descriptions. Intergraph Corporation is not responsible for any error that may appear in this document.

The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used
or copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL
EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.



Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data.
Users should verify for themselves that the data is accurate and suitable for their project work.

Limitation of Damages

IN NO EVENT WILL INTERGRAPH CORPORATION BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL,
SPECIAL, OR PUNITIVE DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF
REVENUE OR PROFIT, LOSS OF DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF INTERGRAPH CORPORATION HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

UNDER NO CIRCUMSTANCES SHALL INTERGRAPH CORPORATION’S LIABILITY EXCEED THE AMOUNT THAT
INTERGRAPH CORPORATION HAS BEEN PAID BY LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS
MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN
CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2)
YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION HAS OCCURRED.

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN INTERGRAPH LIMITS ITS
LIABILITY TO THE MAXIMUM EXTENT ALLOWED BY SAID LAW.

Export Controls

The Software Products and any software products obtained from Intergraph Corporation, its subsidiaries, or distributors, including
any technical data related to these products (“Technical Data”) are subject to the export control laws and regulations of the United
States. Diversion contrary to U.S. law is prohibited. To the extent prohibited by United States or other applicable laws, these
Intergraph Corporation software products and any software products obtained from Intergraph Corporation, its subsidiaries or
distributors, Technical Data and any derivatives of either, shall not be exported or re-exported, directly or indirectly (including via
remote access) under the following circumstances:

a. to Cuba, Iran, North Korea, the Crimean region of Ukraine, or Syria, or any national of these countries or territories.

b. to any person or entity listed on any United States government denial list, including, but not limited to, the United States
Department of Commerce Denied Persons, Entities, and Unverified Lists, the United States Department of Treasury Specially
Designated Nationals List, and the United States Department of State Debarred List. Visit www.export.gov for more information
or follow this link for the screening tool: https://legacy.export.gov/csl-search.

c. toany entity if Customer knows, or has reason to know, the end use of the software product is related to the design,
development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive
nuclear uses.

d. to any entity when Customer knows, or has reason to know, that an illegal reshipment will take place.

Customer shall hold harmless and indemnify PPM for any causes of action, claims, costs, expenses and/or damages resulting to
PPM from a breach by Customer or any user of the export compliance restrictions set forth in this Agreement.

Any questions regarding export or re-export of these software products should be addressed to Hexagon PPM, Export Compliance
Department, 305 Intergraph Way, Madison, Alabama 35758, USA or at exportcompliance@intergraph.com.

Trademarks

Intergraph®, the Intergraph logo®, Intergraph Smart®, SmartPlant®, SmartMarine®, SmartSketch®, SmartPlant Cloud®, PDS®,
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or its affiliates, parents, subsidiaries. Hexagon and the Hexagon logo are registered trademarks of Hexagon AB or its subsidiaries.
Microsoft and Windows are registered trademarks of Microsoft Corporation. ACIS is a registered trademark of SPATIAL
TECHNOLOGY, INC. Infragistics, Presentation Layer Framework, ActiveTreeView Ctrl, ProtoViewCtl, ActiveThreed Ctrl,
ActiveListBar Ctrl, ActiveSplitter, ActiveToolbars Ctrl, ActiveToolbars Plus Ctrl, and ProtoView are trademarks of Infragistics, Inc.
Incorporates portions of 2D DCM, 3D DCM, and HLM by Siemens Product Lifecycle Management Software Il (GB) Ltd. All rights
reserved. Gigasoft is a registered trademark, and ProEssentials a trademark of Gigasoft, Inc. VideoSoft and VXFlexGrid are either
registered trademarks or trademarks of ComponentOne LLC 1991-2017, All rights reserved. Oracle, JD Edwards, PeopleSoft, and
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GT STRUDL® CAD MODELER
Getting Started Guide

1. Getting Started

CAD Modeler is an add-on to BricsCAD® or AutoCAD®, which allows you to create GT STRUDL
Input Files (GTI) graphically using their powerful CAD tools and graphical display capabilities and
also graphically review GT STRUDL results from an analysis and steel code check. AutoCAD® or
BricsCAD® must be installed in your computer before installing and running CAD Modeler. It is
highly recommended that you have AutoCAD/BricsCAD experience before using CAD Modeler.

1.1. Introduction
This document contains information about:

- Installing CAD Modeler

- Configuring AutoCAD/BricsCAD and running CAD Modeler for first time
- List of CAD Modeler Functions with detailed explanation for each one
- Tutorial examples

- Summary of CAD Modeler commands
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1.2. Installing CAD Modeler
CAD Modeler is installed during GT STRUDL installation. Double-click the GTS_Setup icon to

begin installation. Click the “Start Setup” button on the Welcome page.

Note: “XX” in the following screen captures is replaced by the version number being installed in
the installation dialogs you will see.

Welcome
GT STRUDL xX

You may begin setup

Start Setup
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Expand the “CAD Modeler” menu on the form shown below during the GT STRUDL main
installation procedure by clicking the triangle to the left of “CAD Modeler”. The versions of
BricsCAD® and AutoCAD® that CAD Modeler supports will be displayed.

Details and Features
GT STRUDL XX

User Mame

hexagon user

Company

Unknown Company

|E| All Features
GT STRUDL
P [ ] CAD Modeler

D Seismic Load Data

] Videos for GTMenu Example Models

Install Path
CAProgram Files\,

Requires 256 GB  Awailable Space 1133 GB
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Select one or more AutoCAD or BricsCAD versions to use with CAD Modeler and then press the
“Next” button. The supported versions of AutoCAD or BricsCAD usually change with each
version of GT STRUDL.

At least one version of AutoCAD (2020-2025) or BricsCAD (Platinum or Pro 19.x, 20.x, 21.x, 22.x,
or 23.x) needs to be installed in the computer prior to CAD Modeler installation.

Details and Features
GT STRUDL 43

User Name
hexagon user
Company

Unknown Company

|E| All Features

GT STRUDL
4 [m] CAD Modeler
(] AutoCAD 2020
[ ] AutoCAD 2021
(] AutoCAD 2022
] AutoCAD 2023
] AutoCAD 2024
AutoCAD 2025
[] BricsCAD 2019
BricsCAD 2020

Install Path
CA\Program Filesy,

Requires 259 GBE  Awailable Space 11.12 GB

13



If you select a CAD version that is not installed on your computer, an error message will be
displayed:

Validation Errors

Please install the below softwares to proceed with Installation or

deselect the features:
AutoCAD 2025

Otherwise, check the license agreement box and press the button “Install”.

License Agreement
GT STRUDL XX

Country or Region United States

(1 4 HEXAGON

@ Hexagon AB andfor its subsidiaries and affiliates. Al Rights
Reserved.

This License Agreement is Licensee's proof of license.
IF THE LICENSEE HAS A VALID SIGNED LICENSE WITH

HEXAGON, THEN THAT WRITTEN LICENSE SHALL TAKE
PRECEDENCE AND GOVERN THE USE OF THE SOFTWARE.

Software License Agreement for Hexagon's Asset Lifecycle
Intelligence Division Software Products

Licensee should carefully read the following terms and
condiions before installing the Software Product. This Software
License Agreement is a legal agreement between the Licensee
and Licensor (as defined herein) for the Software Product with
which this Software License Agreement is delivered. By
installing, copying, downloading, accessing or otherwise using
the Software Product, Licensee agrees to be bound by the terms
of this Software License Agreement (“Agreement”). If Licensee
does not agree with these terms, Licensee should promptly
retumn this media package for a full refund.

+| | agree to the license agreement and conditions

Cancel Install
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The next screen summarizes your selection.

Installing
GT STRUDL XX

Installing GT STRUDL

In progress...

Details

GT STRUDL

CAD Modeler
BricsCAD 2021
BricsCAD 2022

BricsCAD 2023

15



Press “Finish” to exit the installation process.

CAD Modeler is installed in the same installation directory with GT STRUDL, under the sub-
directory “CADModeler”. For example, the default CAD Modeler installation folder is
“C:\Program Files\GTSTRUDL\XX\CADModeler”, where “XX” is the version number being
installed.

Product Installation Completed
GT STRUDL XX

The following applications are ready to use:

[eags]  GT STRUDL XX

[[] View Readme

16



2. Using CAD Modeler

2.1.  Overview of Using CAD Modeler and configuring AutoCAD/BricsCAD

CAD Modeler can only be launched directly by GT STRUDL; by initializing an instance of AutoCAD
or BricsCAD and automatically loading CAD Modeler ARX/BRX Application (CADModeler) in the
same instance. CAD Modeler creates a separate AutoCAD/BricsCAD user profile, named
“CADModeler”, so the CAD Modeler menus, icons and ribbons do not affect your standard
AutoCAD or BricsCAD environment, or other applications running on the top of them.

CAD Modeler commands can be accessed from the menu, from the ribbon area, or by typing the
specific command in the command prompt.

- If AutoCAD/BricsCAD Menu is not turned ON, you have to type "MENUBAR" in the
command prompt, and then enter 1.

- If AutoCAD/BricsCAD Ribbon is not turned ON, you have to type "RIBBON" in the
command prompt.

All GT STRUDL structural data, which are created using CAD Modeler, are stored in two files: the
.dwg file which contains the AutoCAD/BricsCAD information, and the .db file which contains the
structural data. The two files have the same filename (only the extension is different) and they
are linked together by CAD Modeler.

CAD Modeler creates a GT STRUDL Input File (.gti) and is able to send this .gti file to the main
instance of GT STRUDL, which sits on the background. When analysis is performed in GT STRUDL
and results are available for reading, CAD Modeler is able to load them from GT STRUDL DBX
(data base exchange) files.

Since CAD Modeler is launched and licensed by the main GT STRUDL application you are not
allowed to close the main GT STRUDL window. If GT STRUDL is closed, CAD Modeler outputs a
warning and CAD Modeler commands are no longer functional.

2.2. Running CAD Modeler

CAD Modeler is launched from the GT STRUDL Welcome screen by selecting the “CAD Modeler”
icon in the Start a New Project group. A new instance of AutoCAD or BricsCAD, having CAD
Modeler automatically loaded, is created. You will be able to identify that CAD Modeler is
loaded successfully by having two additional menus (“GTS Modeling” and “GTS Display”) next to
the AutoCAD or BricsCAD main menus and the “GTS CAD Modeler” and “GTS Display” tabs in the
ribbon area.
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2.3, Menu Bar and Ribbon Area

CAD Modeler commands can be accessed from AutoCAD’s or BricsCAD’s Ribbon Area at the top
of the window by selecting the two tabs at the right: GTS CAD Modeler and GTS Display. CAD
Modeler now support BricsCAD version 23 including all new functionality and the dark scheme.

Home Inset Annotate Parametiic View Manage Output Collaborate  GTSModeling ~GTSDisply ~ @+

o g ﬁ A HigherLevel @ Generate I / l / / Merge g FindJoint ~ 17 Quad / .ﬁ [} ¥ Self Weight + B EditGn A Frame i 3D 7] Annotate
nits - = .

& Vet | Lovels g Y Lol | Atlwel S O spit Y e Changeleint Aiangie € B e = HloadCases 22—t G ReadResuits = Anabycl/Phyical © SetView | & Select

) € AliLevels ON & Support T Design (%) Joints Duplicates - [ Reverse  Cuve 2Cuves’ Ectrude’ Advanced  * B Combinations - GT GTSTRUDL [3 Import GTI &) Options © colors Clear

Model Levels Joints Members Find/Change/Check  Shells Meshing Advanced  Groups Loads GTSTRUDL Display Inquire

Home Insert Annotate Parametric View Manage Output Collaborate  GTSModeling  GTSDisplay (@)=

X Units & Joint Supports ', A7 shel Deformed = [V Displacements B Displacements [l Reactions A Frame i 3D
oint el
> Member Local Axes /' Releases @ Diagrams (& Code Check | [F] Member Forces [l Stresses == Analytical/Physical @ Set View
O Member JF Area Report Clear
IE7 Shell Planar Axes o Elements & Selection B Section Forces [} Code Check  Builder {5} Options & Colors
Display Model Display Loads Display Results Results Datasheets Report Display Clear

If the AutoCAD or BricsCAD menu is visible, then CAD Modeler commands can be accessed from
the Menu Area at the top of the window by selecting GTS Modeling or GTS Display.
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2.4.  AutoCAD/BricsCAD Commands

You can use AutoCAD or BricsCAD commands, such as Move, Copy, Rotate, Mirror and Delete to
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Results Datasheets
Options...

(@ Current Version...

generate your model faster. The assumptions made in the use of each command are:

- Move: By moving a joint, the members and finite elements connected to the joint

“follow” this movement

- Copy: Joint, Member and Element Loads and Supports are not copied

- Mirror: Joint, Member and Element Loads and Supports are not copied or mirrored. The
Beta Angle of members is not mirrored. Element incidence order is mirrored so that

element’s orientation, that defines the Z Planar Axis, remains the same.
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- Delete: If a joint is deleted, there is a prompt that asks for confirmation since members
and elements connected to this joint will automatically be deleted as well.

2.5. AutoCAD/BricsCAD Drawing Units

It is recommended that you set the AutoCAD/BricsCAD drawing units to Decimal. This can be
done from the lower right corner of the main application window, as displayed in the next
image, or by typing the command UNITS.

Architectural

v Decimal
Engineering
Fractional
Scientific
+ | Decimal
A Drawing Units E3
Lenath Angle
Type: Type:
Decimal v Decimal Degrees v &
Architectural Precision: ‘

Engineering Sets the current format for units of measure. The values include
Fractional Architectural, Decimal, Engineering, Fractional, and Scientific. The
Scientific Engineering and Architectural formats produce feet-and-inches

displays and assume that each drawing unit represents one inch.
Insertion scale | The other formats can represent any real-world unit.

Units to scale ins

SIey Conieric.

Millimeters v

Sample Qutput

1.5.2.0039.0 -
3<450

Lighting
Units for specifying the intensity of lighting:
Intemational v

Cancel Direction... Help

As written in AutoCADs’ documentation “The Engineering and Architectural formats produce
feet-and-inches displays and assume that each drawing unit represents one inch. The other
formats can represent any real-world unit”. Therefore, if you select Engineering or Architectural
formats you have to set CAD Modeler Length Units to Inches. (see Units Command)
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2.6. CAD Modeler Commands

2.6.1. Units

The following form is used to define the active units, either from ribbon command X Units or
from the menu “GTS Modeling>Units” or by typing GTSUnits at the command prompt.

Units e
Length Force Angles
() Inches {in) () Pounds (bs) (@) Degrees
() Feet (ft) (O Kips () Radians
(®) Meters (m) () Tone (") Cydes
() Centimeters {cm) () Kilograme
() Millimeters {mm) () Metric Tons Time
Temperature l:::l Mewtons @ Seconds
() Fahrenheit (@) KiloMewtons () Minutes
(®) Centigrade () Megalewtans () Hours
5E§|E nu:un-strun:b_!ral CAD entities
(grids, structural lines, curves etc) Cancel

You can change the Units any time during working in CAD Modeler. Moreover, you can choose if
the non-structural AutoCAD/BricsCAD entities, such as grids, structural lines, curves, polylines,
etc will be scaled together with the structure whenever you change the length units.

As noted in 2.5, if the Drawing Units are in Engineering or Architectural format then you have to
set the CAD Modelers’ Length Units to Inches (in) using this Dialog.

The current units appear at the top of the main CAD Modeler window:

GTS CAD Modeler | M KN DEG FAH SEC| Drawing1.dwg

Note: Some Edit Boxes appear in yellow background and green fonts, like the one at the picture
below. You can use mixed units in the yellow edit boxes. For more information about Mixed
Units and the valid syntax, please read GT STRUDL GT Menu Guide.

21



Joint Coordinates and Offsets
Coordinates

2487.85

1644.03

i

2.6.2. Materials
The following form is used to modify existing material properties or create new materials. You

— -
. . . = Material
can select this command either from the ribbon command = arenals or from the menu “GTS

Modeling>Materials” or by typing GTSMaterials at the command prompt.
Material *

Material Properties

D Name E G Density Poisson CTE

1 Steel 1.9994800E+08 7.5842000E+07 7.6901000E+01 3.0000000E-01 1.1700000E-05
Concrete 2.4821100E+07 9.9284600E+06 2.3561600E+01 1.7000000E-01 9.9000000E-06
Aluminum 6.8947600E+07 2.5855400E+07 2.6601800E+01 3.3000000E-01 2.34D0000E-05

AddMaterial | Delete Material oK

2.6.3. Levels

It is optional to define Levels (stories) in your structure. However, it is recommended that you
do so when modeling industrial or other building-like structures as this will save you time during
the creation of your model. You can access the level properties dialog from the ribbon icon

=

Levels or from the menu “GTS Modeling>Levels” or by typing GTSLevels at the command
prompt.

Using the Level Properties form you can:
- Set the Height for each level, in current length units
- Define the visible status of each level: if Visible or not
- Add Levels to the model
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- Delete Levels from the model

- Detect Levels Automatically using an algorithm to detect levels along the height of the
structure by identifying locations having at least four horizontal members.

- Merge Levels, by selecting two or more levels and merging them to one.

- Define if the Vertical Axis is the global Z or global Y.

- Update Levels for All Entities, in order to assign the correct Level to each entity (joint,
member or finite element) depending on its coordinates along the height of the

structure.
Level Properties
Level Heights Options
Levels Height  |Elevation | Visible | rr— |
1 4 4000000 [V
2 3000000 7000000 [V | Delete Level |
3 3.000000 | 10.000000 |[v
| Detect Levels Automaticaly |
l Merge Levels |
Base Elevation
[¥]z vertical Axis (else Y)
["Jupdate Levels for All Entities
| ok || cancel |

After defining Levels, you can switch between levels by either using the “Visible” check boxes

from the Level Properties form, or using the A Higherlevel |\ W LowerLevel ;¢ in the
ribbon area. You can also type GTSLevelUp and GTSLevelDown at the command prompt.

Moreover, you can define a grid system and/or generate vertical members (Columns) with a
single click. These commands will be explained below.

Finally, the current level, if defined, appears at the top of CAD Modeler window, next to the
Current Units.

GTS CAD Modeler | M KN DEG CEN SEC | Level: 2
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2.6.4. Grid

A Grid system can be defined and used as a pattern for entering beams and columns. In order to
be able to enter a Grid, you must first specify Levels in your structure (see the Levels command
above). You can access the Grid dialog by expanding the “Levels” tab from the ribbon icon

Grid  or from the menu “GTS Modeling>Grid>Create” or by typing GTSGrid at the command
prompt.

Grid [ x |

Placement Angles Apply to Levels
@®) Hori Os ) L 0.00 T
@) Horizontal (_) Sidelong Grid Angle X-Axis : 1

2
Horizontal - Sidelong Angle : 90.00 3
Spacing 4
Labeling
Distance: | 7-0000
5.0000 Show Labels
6.0000
7.0000 Add Text Height : i
- Numbers Distance : 1.00
Edit
I Position
Deete @ Left () Right
Type
(®) Numbers (O Letters
Start From : 1 v

OK Cancel

Using the Grid form you can:

- Set different parameters for the Horizontal and Sidelong directions of the grid.

- Define and control the spacing in each direction, by entering the desired spacing —
Distance of the new grid line and pressing Add button. Later on you can edit a specified
spacing or delete it, using the corresponding buttons Edit and Delete.

- Define the Angle between the Grid X-Axis and the global X-axis

- The Angle between the Horizontal and Sidelong lines (default equal to 90 degrees)

- Control the Height of fonts

- Control the Position of the labels

- Control the Type of identification to be either Number or Letters

- Control the Starting From item, which can be a number or letter depending on the Type.

- Select the levels that this grid will be applied to. You can apply the grid to more than
one levels and/or have multiple grids per level.

By pressing OK, you are prompted to enter the Insert Point of the grid, meaning the coordinates

of the lower left corner of the grid. The grid lines are then created as shown in the figure on the
next page.
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You can also change the properties of an existing grid from the menu “GTS
Modeling>Grid>Change” or by typing GTSGridChange at the command prompt, and then
selecting the Grid to be edited.

2.6.5. Creating Joints

You can generate individual joints from the ribbon command B Gen€rte or £rom the menu

“GTS Modeling>Joint>Generate Joint” or by typing GTSJoint at the command prompt. You
then must enter the X,Y,Z coordinates (separated by comma) or click at the corresponding point
at the screen. However, for frame structures, it is recommended to start generating members
(and joints will be automatically generated at their ends).

If you have already defined Levels at the structure, you can generate individual joints at the
current lever from the ribbon command & Atlevel o fom the menu “GTS
Modeling>Joint>Generate Joint at Level” or by typing GTSJointLevel at the command

prompt. You then have to enter only X and Y coordinate (Z will be calculated using the current
Level’s Elevation).
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2.6.6. Finding Joints

You can find an individual joint from the ribbon command pecicns or from the menu “GTS

Modeling>Joint>Find” or by typing GTSFJID at the command prompt and enter the name of
the Joint. If the joint name exists, the joint will be selected (by clicking on “change”, you can
modify it without making a new selection).

2.6.7. Joint Supports

You can find an individual joint from the ribbon command B Support 1 from the menu “GTS

Modeling>Joint>Support” or by typing GTSJointSupport at the command prompt and
select the joint or the joints to be supported. The Joint Properties form then appears, where you
can define which degrees of freedom are fixed and also enter a spring value in case of elastic
supports. Using the Quick Selection, you can quickly define a Fixed, Pinned or Free Joint (by

default all joints are free)
Restraints & Spring values

Quick Selection : Pin v
Restraint Spring Restraint  Spring

Fx 0 [ Imx 0
Fy 0] Cmy .
Fz 0! Mz 0

2.6.8. Joint Properties

You can change the properties of a joint from the ribbon command '@ Change Joint or from the

menu “GTS Modeling>Joint>Change” or by typing GTSJointChange at the command
prompt and select the joint or the joints to be edited or by double-clicking on an existing joint.
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Jaint Properties X

Model  Joint Generalized Loads

General Joint Coordinates and Offsets
Name : Coordinates
Level: o L 1
'
0
2,
Rotation
theta X : I:I Restraints & Spring values
tewr: | O]
Quick Selection : w
tewze | O]
Restraint Spring Restraint  Spring
Groups [ IFx | 0 | [T | 0 |
Inactive Remove [IFy | 0 | [y | . |
Groups that joint belongs [JFz | D| [Imz | D|

Cancel Apply Help

The “Joint Properties” form appears, and at the “Model” tab you can enter the Name of the Joint
(up to 8 characters) the Level that the joint belongs (optional), the theta rotation angles for
rotated support joints, the Groups that the joints belongs to, the coordinates of the joint in the
current unit system, the restraints of the joint and the spring values.

If you select more than one joint, then “Multiple Selection” appears at the top of the Joint
Properties form, and all data entered in the form will be applied to all selected joints.

2.6.9. Sections

For models which contain frame members, you should select the cross sections to be added to
your project either from the default cross section library or by creating user defined prismatic
cross-sections or by importing user defined cross sections that have been created in GT STRUDL.

Prismatic cross sections can be created from the Menu “GTS Modeling >Cross

Sections>Prismatic” or by typing GTSPrismatic at the command prompt.
In the dialog shown below, you enter the cross-section properties in the current unit system.
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Prismatic Properties EX

New Section Properties ' oK }

Section Name (Up to 15 Characters) : Cancel
Ax: Ix:
Ay: Iy:
Az: Iz:
Sy: By =
Sz: Ez:
Yd: Yc:
Zd: Zc:
Shape Code :

You can access the existing cross section library (GT STRUDL tables) from the ribbon command

XL

Sections or from the Menu “GTS Modeling>Cross Sections>Table” or by typing GTSParams at

the command prompt.

Using the following form, where all GT STRUDL built-in TABLES are available, you select the cross
sections for your project by double clicking on them, at the right part of the screen. The list of
selected cross-section profiles appears at the left part of the screen and the selected profiles
have a large black dot in front of them. Check the Release Guide for your version to see the
newest built-in tables.

User defined cross sections, that have been created in GT STRUDL, can be imported in CAD
Modeler from the Menu “GTS Modeling >Cross Sections>Import from User Dataset” or by typing
GTSOpenDS at the command prompt. Using the “Select User Dataset DS File” dialog you can
select the dataset file (*.ds) that includes the user defined cross sections to be imported. By
pressing “Open”, the cross sections of the selected .ds file are added to the available built-in
TABLES, presented in the previous paragraph.
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B Profile Browser *

=[] AISC 15th Edition 2015 A W-AISC15
.- A -
E I: W44x335 W35x325 W33x291 W27x335 W24x 104 W21x44
i W44x290 W35x853 W33x253 W27x307 W24x 103 W1gx311
- M/S/HP15 Wa4 262 \W35xE02 W33x241 W27x251 W24x94 W18x253
-] RECHSS15 W44x230 W35x723 W33x221 W27x258 W24x34 W18x258
- c-AIsC1S W40x655 W3EXE52 W33x201 W27x235 W24x76 W18x234
T WTAISC15 W40x593 W35x529 W33x169 W27x217 W 24xE8 W1gx211
A LEO-15 W40x503 W3EK4ET W33x152 W27x194 W24x52 W1Sx192
o LUN-1S W40x431 W3sx441 W3ax141 W27x178 W24x55 W1gx175
W40x397 W35x395 W33x130 W27x161 W21x275 W18x 158
N L-ALL-15 W40x372 W3sx361 W33x118 W27x1%6 W21x248 W1Bx143
o AF ALEQ-15 W40x352 W36%330 W30x391 W27x129 W21x223 W18%130
e A 41-15 Wa0x324 W3ax302 W30x357 W27x114 W21x201 Wigx119
e 2L-5L-15 W40x297 W3Bx282 W30x326 W27x102 W21x182 W18 108
e 2L-ALLIS W40x277 W3sx252 W30x292 W27x94 W21x 165 W18x97
) RNDHS515 W40x249 W35x247 W30x251 W27x34 W21x147 W18x86
T waeam-15 W40x215 W3sx231 W30x235 W24x370 W21x132 W18x76
T weoL1s W40x199 VW 36x256 W30x211 W24x335 W21x122 W18x71
W40x392 W3sx232 W30x191 W24x306 W21x111 W18x55
QO PIPES15 W40x331 W36x210 W30x173 W24 279 W21x101 W18x50
F-E] AISC 15th Edition 2016 Metric Wa0x327 W3sx194 W30x143 W24 250 W21x93 W 18x55
[-E] AISC 15th Edition Spedial Tables for A10858 || w40x294 W3sx152 W30x132 W24x229 W21x83 W18x50
[]...E AISC 15th Edition Special Metric Tables for & Walx273 W3sx170 W3lx124 W24 207 W21x73 W 18x46
-] AISC 14th Edition 2011 W40x264 W3sx150 W30x116 W24x192 W21x58 W18x40
" ) W40x235 W38x150 W30x108 W24x 178 W21xs2 W 18x35
SS :i:g :‘E ES:EE: r:;jtrs'c W40x211  W3Sx135  W30x99 W24x162  WZIXSS W 16x 100
i . W40x183 W33x387 W30x30 W24x 145 W21x48 W 16x89
[ ATSC 13th Edition 2005 Metric W40x167 W33x354 W27x539 W24x131 W21x57 W16x77
B-f ] AISC 9th Edition 1339 W40x 149 W33x318 W27x358 W24x117 W21x50 W16x57
[-F ] AISC LRFD 3rd Edition v
L4 > £ >
Cancel
Moreover, you get a notification at the . Unistrut
command prompt, regarding the number of <, User Defined Sections
tables that exist in the dataset. For example: L MYAISC14
“Number of tables in ds = 5”. Cac
N MYLUN13
[ MYRECHSS

i I ABEAMS

Next time you select the command Sections
you will be able to see the user defined
sections at the bottom of the list.

Note: Whenever you import a TABLE of sections that has been previously imported in CAD
Modeler, all new data will overwrite previous TABLE section data.

Note: Whenever you use a User Defined Section in CAD Modeler, you must manually open the
corresponding .ds file in GT STRUDL prior to the “Execute GTSTRUDL” Command.
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2.6.10. Creating Members

Y

You can generate individual members from the ribbon command Generate or from the menu
“GTS Modeling>Members>Generate Beam Members” or by typing GTSBeam at the command
prompt. You must then enter the X,Y,Z coordinates (separated by commas or click at the
corresponding point at the screen) of the member start and then of the member end. Joints are
automatically generated at both member ends, unless a joint already exists at the specific point.
If so, the member is connected to the existing joint(s).

If you have already defined Levels at the structure, you can generate vertical members

[

(columns) at the current lever from the ribbon command Vetical or from the menu “GTS
Modeling>Member>Generate Vertical Member” or by typing GTSColumn at the command
prompt. You then have to enter only one point (starting top point) in the floor plan. The ending
bottom point will be automatically calculated, having the same X and Y coordinates, and Z
coordinate will be calculated by the current level’s height.

After giving the command the “Place Member” form appears, where you define the properties
of the member.

Note: Each time you create a member, the orientation of the cross section will appear in the
middle of the element, unless you clear it with command “Clear” (see 2.6.86).
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You can select:

- A Table Section from the list of
available  sections in  the
project, or give the dimensions

or Membar Dimansions: of the typical shapes available
or match the section properties

Cross Section
Table Section:
<5elect Table Section = w

Rectangle Concrete e o

of one existing member to save
or Same as Member: time typing the values.
<Select Existing Member = w - The Material from the list of

available materials in the
Material project

- Common Member

Steel w . .

Releases configuration
Relemne Beta (o) - Betaangle (in degrees)

- To split intersecting members,

00 Pin-Pin i along new member’s length,

including the new member

[] split Intersecting Members [ physical Member - To split ending members, if the
[ spit Ending Members member starting and/or ending
joints are placed along existing

Place Member(s) == members.

-  To place a physical member
Section Properties together with the analytical
members. If the new physical
I:I member is crossing other
B .

physical members, the new
I:I physical member will be split

into more parts.

I
H +_§ Then, you must click on the “Place
l Member(s) >>” button and start placing
_____ . members.

% B #

You can change the properties while
the command is active, and the next
member(s) will be placed using the new
values.

When you are done, press ESC to exit from the command. The form is hidden automatically.

2.6.11. Finding Members

. Find Memb
You can find an individual member from the ribbon command R or from the

menu “GTS Modeling>Member>Find” or by typing GTSFMID at the command prompt and
enter the name of the Member. If member name exists, the member will be selected (by clicking
on “change” you can modify it without making a new selection).
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2.6.12. Splitting Members

/

You can split a member into two or more parts from the ribbon command Pt or from the
menu “GTS Modeling>Member>Split Member” or by typing GTSSplitMember at the
command prompt and select the Member to be split. You then define “Distance for splitting the
member or the number of equal parts (negative number)”, entering:
- the position of the split, meaning the length of the 1° part starting from starting joints,
or
- the number of equal parts that will be generated after the split, by typing a negative
number. For instance, entering -3 means to split the original member into 3 equal parts.

2.6.13. Splitting to Crossing Members

You can Split Members to Crossing Members, after being placed. You select the member to be
spit and if there are any crossing members the selected member is split automatically at their
intersections. You can split a member into crossing members, from the ribbon command

X Split to Members
or from the menu “GTS Modeling>Member>Split to Crossing Members” or
by typing GTSSplitToMembers atthe command prompt and select the Member to be split.

2.6.14. Merging Members

You can merge two members to one member from the ribbon command / Merge or from the
menu “GTS Modeling>Member>Merge Members” or by typing GTSMergeMembers at the
command prompt and select two members. The two members must have a common joint
(middle). After merging the middle joint is NOT deleted and you have to delete it manually. This
joint can be removed manually, using AutoCAD’s/BricsCAD’s erase command, or by using CAD
Modeler’s “Remove Floating Joints” Command.

2.6.15. Member Properties

You can change the properties of a member from the ribbon command ange MEmbEr op

from the menu “GTS Modeling>Member>Change” or by typing GTSBeamChange at the
command prompt and select the member or the members to be edited or by double-clicking on
an existing member.

The “Member Properties” form appears, and at the “Model” tab you can enter the Name of the
Member (up to 8 characters), the Level that the member belongs to (optional), the Type of the
Member (Space Frame or Space Truss), Starting and Ending Joints, Beta Angle, the Groups that
the member belongs to, the Cross-Section applied to this member and the corresponding
section properties, the Material of the member, member releases and elastic end connection
spring values, End Sizes and global Member Eccentricities.
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Member Properties =

Model  Section Properties  Member Loads Member Temperature Loads  Member Distrortions

General Section Properties Releases & Elastic Connection spring values

Mame : Section : Quick Selection : w
Level : Ax -

| | o: | | start Spring End  Spring
we | | e | | oow [ ffo=[ ¢
Type - Incidences ne: | | x| = I:I Oy I:I
Type:  |SPACEFRAME v v | e | | LlFz Ijl LlF Ijl
Start 1 Sz: | | Ez: | | [mx I:| [Trx I:|
2 e | Cowl lowl ¢
Beta Angle : l:l : | |Zc: | | [z I:l (L I:l

Physical Member

Shape Code : I:I
End Sizes OR Member Eccentricities {Offsets)

Groups Start End
Material Properties

Inactive e Remave . I:I
Material ; | Steel s o Sizes : :
Groups that Member belongs
e [199Be ey ] o [ o)k [ 9
P e I e P S—

Cancel Apply Help

Using the “Section Properties” tab, you can define typical concrete shapes or other shapes that
appear in the next image. Shapes having the identifier “Concrete” should be used for thick
sections.

F Yy
m
¥

— T —
N

% B *
Rectangle (Concrete) Circle (Concrete)
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If you select more than one member, then “Multiple Selection” appears at the top of the
Member Properties form, and all data entered in the form will be applied to all selected
members.

Physical Member Properties

Model | Section Properties | Member Loads
General Section Properties Releases & Elastic Connection spring values
Name : pM000003} | Section : IPE270 IPE European Quick Selection : N
Level: ol | I 0.00459 | 1. 16607 | Start Spring End  Spring
Ay: 0.00164736 Iy: 4.2e-06 D Fx 0 D Fx 0
Type - Incidences Az: 0.001836 | ,, 5.79e-05 Cry 0 Cry 0
6.2222e-05 0
Type: |SPACEFRAME v| Y By: CF2 °/ Or °
. 4.
ot = Sz: 0.00042889 Ez: 0 [Imx 0 [Imx 0
. 0.27 . 0.135
— 18 Yd: Yc: [Imy 0 My 0
. 0.135 . 0.0675
Beta Angle : S0 &d; 763 [(Imz 0| Ome 0
" 1.0
Physical Member PMO00003 Shape Cotle :
End Sizes OR Member Eccentridities (Offsets)
Groups Start End
= Material Properties
Inactive emove i 0 0
| | & Material ; |Steel hd Sizes :
Analytical Members
14 E: 1.99948e+08 Density 76.901 X: 0 X: 0
29
;.‘{ G: 7.5842e+07 CTE: 6.49865e-06 v 0 Ve 0
Poisson 0.3 Zs . s .
OK Cancel App Help

If you select a physical member, then “Physical Member Properties” appears at the top of the
Member Properties form, and you can modify the properties of the Physical Member. You can
only modify the Name, Beta Angle, Section Properties, Releases and Eccentricities. Any
modification applies to all analytical members, except Releases and Eccentricities that apply only
to the start of the first analytical member and to the end of the last analytical member.
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Moreover, you can see the list of labels of the Analytical members that are part of this Physical
Member.

If you apply any loads to the physical member, the load parameters are copied to each analytical
member belonging to it.

2.6.16. Member Filters

You can select members of the structure, that fulfill several criteria, using the icon Y Filter or
from the menu “GTS Modeling>Member>Filter” or by typing GTSFilterMembers at the
command prompt.

Members can be filtered forming queries of three different categories:
- Their Properties, that can be: Name, Level, Section, Material, Beta Angle, Group,
Release Statues, Kf values, Eccentricities and End Sizes
- Their Loading Data, that can be: Load Case, Load Type, Load Direction, Load Values and
Location.
- Their Analysis Results, that can be: Load Case, Member Forces Fx — Fy — Fz — Mx — My —
Mz for both ends and section forces Fx - Fy — Fz - Mx — My — Mz.

You can set multiple (up to 5) conditions of the same category using logical expressions (AND,
OR). For example, filter members that their section is IPE330 AND they belong to level < 3 AND
their beta angle is greater than or equal to 90.

After the query is formed, your press “Execute >>” and the IDs of the members fulfilling the
criteria appear in the “Results” list.

Filtered members may be:
- Added to any Group
- Selected as AutoCAD’s/BricsCAD’s selection (to be edited, moved, copied, moved etc),
using the option “Keep Selected after closing form”
- Made the only visible entities of the structure, by hiding all other entities, using the
option “Make them the only visible”
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Filter Members n

SELECT Members oK
Section v = v | | IPE330 IPE European v Cancel
AND V| |Level v < v||3 v
AND V| |Beta Angle v >= v| | %0 v
v v = v v
v v = v v
Member Loads (Units: kN, m) Member Results / Section Forces
v v v v v v
v v v v v v v v
v v v v v v v v
v v v v v v v v
5 v v v v v v v
SQL Query (WHERE) Result
9
(nSection ='2') 10 "
AND (nLevel <'3') 1
AND ( betaAngle >="90") 12
13
14
15
16
Execute >> Clear 17
18
19
Action 20
Items Selected: 70 3;
23
24
ADD To Group >> v 25
26
["]Keep Selected after dosing form [[IMake them the only Members Visible 3 v

2.6.17. Creating Shell Finite Elements

Shell finite elements are generated automatically using the meshing functions described below.
However, you can generate individual quadrilateral or triangle shell elements one by one.

Quadrilateral elements can be created using the icon ** 2 or from the menu “GTS
Modeling>Shell>Generate quad at joints” or by typing GTSShell at the command prompt.
You must then enter the X,Y,Z coordinates (separated by commas or click at the corresponding
point at the screen) of the four corners of the quad element. Joints are automatically generated
unless a joint already exists at the specific point. If so, the element is connected to the existing
joint(s).

a -
Triangular elements can be created using the icon ¢ B or from the menu “GTS

Modeling>Shell>Generate triangle at joints” or by typing GTSShellT at the command
prompt. You must then enter the X,Y,Z coordinates (separated by commas or click at the
corresponding point at the screen) of the three corners of the triangular element. Joints are
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automatically generated unless a joint already exists at the specific point. If so, the element is
connected to the existing joint(s).

2.6.18. Reverse Incidence Order
The Incidence Order (clockwise or counterclockwise) of selected shell elements can be reversed

using the icon & Reverse 1 from the menu “GTS Modeling>Shell>Reverse Incidence Order” or
by typing GTSShellReverse at the command prompt. The Incidence Order defines the
orientation of the Element’s Planar Z and Local Z Axes which then also affects the Local and
Planar X and Y Axes.

2.6.19. Finding Shells

. — . 1] Find Shell
You can find an individual shell element from the icon ** " © or the menu “GTS

Modeling>Shell>Find” or by typing GTSFEID at the command prompt and enter the name of
the element. If the element name exists, the shell element will be selected (by clicking on
“change” you can modify it without making a new selection).

2.6.20. Shell Properties

You can change the properties of a shell finite element from the icon - Change Shell or the

menu “GTS Modeling>Shell>Change” or by typing GTSShellChange at the command
prompt and select the shell or the shells to be edited or by double-clicking on an existing shell
element.

The “Element Properties” form appears as shown below, and from the “Model” tab, you can
enter the Name of the Element (up to 8 characters), the Level that the element belongs to
(optional), the Type of the Element, Joint Incidences, the Thickness of the shell, the Groups that
the element belongs to and the Material of the element.
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Element Properties Ea

Model | Element Loads

General Material Properties
Name : L2 Material : | Concrete A
e : 2.48211e+007 23.5616
E: ' £ Density '
s 9.92846e+006 cTE: 9.9e-006
Type - Incidences 0.17
Poisson
Type : SBHQ6 v
Groups
Joint 1: o
Inactive Remove
Joint 2: 14
Groups that Element belongs
Joint 3: N
Joint 4 : 18

Section Properties

Thickness : s

Area:

OK Cancel App Help

If you select more than one element, then “Multiple Selection” appears at the top of the
Element Properties form, and all data entered in the form will be applied to all selected
elements.

2.6.21. Joints Duplicates

In order to erase joints that have the same coordinates (one on the top of the other) that may
have been generated by mesh generation functions, you have to check the model for duplicate
Dn Joints Duplicates
joints from the ribbon command in the “Find/Change/Check” panel or select
“GTS Modeling>Checks>Joint Duplicates” from the menu or type
GTSCheckDuplicateJoints at the command prompt. You then must enter the desired
merge accuracy (Enter Merge Tolerance <0.001000>). If duplicate joints exist in the structure, a
new dialog appears having the full set of duplicate pairs, where you can select the joints to be

merged or not as shown on the next page:
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Merge Joints

Joint Duplicate Merge
, 5 2
2 5 v

3 25 I7

2.6.22. Joints Floatings

Floating Joints are the joints that are not connected to any member or finite element, therefore
they may cause instability in the solution of the mathematical model. Use the ribbon command

- Joints Floatings in the “Find/Change/Check” panel or select “GTS Modeling>Checks>Joint
Floatings” from the Menu or type GTSCheckFloatingJoints at the command prompt,
floating joints are automatically identified, and using the corresponding dialog as shown below,
they can be deleted.

Floating Joints
-
Joint Deleted
v

2.6.23. Joints Interference

In order to check in order to search for joints close to a member, not connected to it, you can

/ Joints Interference
use the ribbon command in the “Find/Change/Check” panel or select
“GTS Modeling>Checks>Joints Interference” from the Menu or type
GTSCheckInteferenceJoints at the command prompt. You then must enter the desired
tolerance (Enter Check Tolerance <0.050800>).
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2.6.24. Members Duplicates

In order to check if two members are one on the top of the other (having common joints in any
order), you must check the model for duplicate members from the ribbon command

@ Members Duplicates

in the “Find/Change/Check” panel or  select “GTS
Modeling>Checks>Members Duplicates” from the menu or type
GTSCheckDuplicateMembers at the command prompt. If duplicate members exist in the
structure, a new dialog appears having the full set of duplicate pairs, where you can select the
members to be deleted or not as shown in the following figure. For all the selected pairs, one
member is deleted (the member first created is kept).

Duplicate Members x
Member Duplicate Delete

Unselect Al
3 5 [v

4 6 v

[ oc ]

2.6.25. Members Zero Length

In order to check if a member has zero length, you can use the ribbon command
’ Members Zero Length . .

in the “Find/Change/Check” panel or select “GTS
Modeling>Checks>Members Zero Length” from the Menu or type
GTSCheckMembersZeroLength at the command prompt. Following the command
execution, you must enter the desired tolerance (Enter Check Tolerance <0.001000>) and then a
list of zero length members appears from where you can select which to delete.

2.6.26. Physical Members
Physical members in a frame model are consisted using two or more analytical members. In

order to check if physical members exist in the structural entities, you can use the ribbon

m=o=u Physical Members
command in the “Find/Change/Check” panel or select “GTS
Modeling>Checks>Physical Members” from the Menu or type GTSCheckPhysicalMembers
at the command prompt. The five (5) checks that are performed with their corresponding errors

are as follows:

#1. Check that all members have the same Beta angle. If not, there is an error message:
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Physical Member %s: Member %s has inconsistent BETA angle

#2. Check that all members have the same cross section. If not, there is an error message:
Physical Member $%s: Member $%$s has inconsistent CROSS
SECTION

#3. Checks that all member do not have internal releases. If not, there is an error messages:
Physical Member %s: Member %s has internal RELEASES
Physical Member $%s: Starting Member %$s has internal
RELEASES at its end
Physical Member %s: Ending Member %s has internal RELEASES

at its start

#4.Checks that there is a sequential order of members. If not, there is an error message:
Physical Member $%s: Members %s (end) and %s (start) do not
have common joint (are not SEQUENTIAL)

#5.Check that all members form a straight line. . If not, there is an error message:
Physical Member %s: Member $%s 1is not LINEAR with the
physical member

If all 5 checks are successful an informative message appears:
Physical Member $%s: OK

2.6.27. Shells Duplicates

In order to erase shells that coincide (one on the top of the other) that may have been
generated by mesh generation functions, you have to check the model for duplicate shells from

® Shells Duplicates

the ribbon command in the “Find/Change/Check” panel or select “GTS
Modeling>Checks>Shells Duplicates” from the Menu or type GTSCheckDuplicateShells
at the command prompt. If duplicate shells exist in the structure, a new dialog appears having
the full set of duplicate pairs, where you can select the shells to be deleted or not as shown in
the following figure. For all the selected pairs, one shell is deleted (the shell first created is kept).

Duplicate Shells

List
Shell Duplicate Delete
3 5 v Al
4 6 v

it
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2.6.28. Names Duplicates

In order to check if two joints have the same name or two members have the same name or a
member and a shell have the same name, you can use the ribbon command

® Mames Duplicates

in the “Find/Change/Check” panel or select “GTS
Modeling>Checks>Names Duplicates” from the Menu or type GTSCheckNames at the
command prompt. If duplicate names exist in the structural elements, a message appears in the
command prompt as follows:

Joints 4 and 4 have the same Name
Joints 5 and 5 have the same Name
2 Duplicate Names Found

2.6.29. Renumber Names

It is often convenient to have continuous numbering (labeling) of joints members and elements.
In order to renumber the names of structural entities in ascending order (only if their name is an

. . rz: Renumber Mames ]
integer), you can use the ribbon command ’ in the “Find/Change/Check”

panel or select “GTS Modeling>Checks>Names Duplicates” from the Menu or type
GTSRenumber at the command prompt. Following the command execution, you mmust
decide whether or not you want to renumber joints and members/elements by typing yes or no
(y or n) to the following questions:

Renumber Joints? (Yes/No)
Renumber Members and Elements? (Yes/No)

2.6.30. Database Integrity

In order to check that all CADM entities in a DWG have a unique database record, you can use

= , -
= atabase Integrity
the ribbon command in the “Find/Change/Check” panel or select “GTS

Modeling>Checks>Database Integrity” from the Menu or type GTSCheckDatabase at the
command prompt. There may be database records, without a dwg entity, or the opposite, dwg
entities without a database record. This may happen in very extreme cases (for example, a
power supply failure while saving, or out of disk space, etc). Entities/records with a problem are
deleted and you get an information message such as the one below:

Error Fixed: Joint %s deleted from DWG
Error: Joint %s does not exist in database
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2.6.31. Meshing along a curve
You can create several members along any selected AutoCAD/BricsCAD linear entity, that can be

e

1D

a Line, an Arc or a Circle, from the ribbon command “Y™€ or from the menu “GTS
Modeling>Mesh Generation>1D Along Line or Curve or Circle” or by typing GTSMesh1D at the
command prompt.

Select Mesh Properties After selecting the AutoCAD/BricsCAD linear
entity the Mesh Properties dialog appears,

Generate where you can define:
(@) Members Elements
Material |Steel ~

- The Material of the members to be
Element Attributes generated.
Type BPHQ Thickness 0.20 - The Type of the members (FRAME or

TRUSS)

Member Attributes - The Cross-Section of the members
Type [FRAME ¥ Beta 0.0 from a list of previously selected
cecton » project sections.

- The Beta angle that defines the

Spncing U Dibection orientation of the cross-section in 3D

r space.
© Uniform Y - The number of members, to be
() variable generated, that can be equally

spaced (uniform) or may have
variable spacing.

Spacing V Direction - The Labeling (optional) of the joints
and members to be generated

Pt _—
venned by Line/(

urve

- ” (“Enter Labeling Rules” form), where
ariable you can set the First ID for joints and
Defined by Line/Curve members and their labeling prefix.
- By clicking “Preview” you are able to
Spacing W Direction preview the members to be
® Uniform B generated (without creating any
entities).
e - By clicking “Create” the members are
Defined by Line/Curve generated and the Mesh Properties
form is closed.
Labeling
More >> U Primary Direction
Preview Create Close
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By selecting Variable spacing, the “U1-Curve Spacing” form appears, where you can enter the
Total Number of Spaces, and the Length of each part, either in absolute distance or as a
percentage of the line or curve’s total length using the dialog shownbelow:.

U1-Curve Spacing E3
Current Totals
Total # of spaces : ' Curve Length : 1847.094685
Current # Spaces : 0 Current Length : 0.000000
Remaining # Spaces : - Remaining Length : 1847.094685
Variable Spacing
# Spaces Distance or Percent A

The “Enter Labeling Rules” form allows you to set the First ID for joints and members to be
created and their labeling prefix. Note that the total length of the label cannot be more than 8
characters. Element and member labels (IDs) must be unique — you can’t have a member and
element with the same label (ID).

Enter Labeling Rules

Properties

Joints Prefix :]
First Joint's ID !
Elements Prefix

First Element's ID :
Members Prefix

First Member's ID i

< < Apply Calculate IDs
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2.6.32. Meshing between two lines
You can create Members or Finite Elements between two selected AutoCAD/BricsCAD linear

P

2D
entities such as Lines or Arcs, from the ribbon command 2CY™€S of from the menu “GTS
Modeling>Mesh Generation>2D Between 2 Lines or Curves” or by typing GTSMesh2D2L at the
command prompt. You are then asked to select two AutoCAD/BricsCAD curves that will define
the U and V boundaries of the Mesh.

The dialog has the same options as in the 1D mesh command and in addition you can also
define:
- Members or Elements to be generated (for Members the options are the same as in 1D)
- Type of Finite Elements, from the available GT STRUDL Finite Element library
- Thickness of Finite Elements
- Spacing in both the U and V directions

2.6.33. Meshing between four lines
You can create Members OR Finite Elements between four selected AutoCAD/BricsCAD linear

2D
entities, that can be Lines or Arcs, from the ribbon command 4Curves or from the menu “GTS
Modeling>Mesh Generation>2D Between 4 Lines or Curves” or by typing GTSMesh2D4L at the
command prompt. You are then asked to select four AutoCAD/BricsCAD curves that will define
the U1, U2, V1 and V2 boundaries of the Mesh as shown in the figure below with U2 opposite
U1l and V2 opposite V1:

The dialog has the same options as in the 2D mesh between two curves command.

2.6.34. Meshing inside a polyline

You can create Finite Elements inside an AutoCAD/BricsCAD closed curve, that can be a Polyline
2D

or a Circle, from the ribbon command A€ or from the menu “GTS Modeling>Mesh

Generation>Inside Polyline” or by typing GTSMesh2DPoly at the command prompt. You are

then prompted to select the closed AutoCAD/BricsCAD polyline or circular curve.
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Generate

Material | Steel v
Element Attributes

Type SBHT6 ™ Thickness | ©0-20
Mesh Geometry

External Boundary obj-581 ’ .

External Boundary Edge Size 0.000000

Maximum Element Edge Size

Minimum Element Edge Size 0.000000

< I!I

Mesh Quality |Very Low

Internal Boundaries Internal Joints

Add + Remove -

Multi+  Multi - Add Remove

Spacding Extrude Direction

Nafinad hv Cisva. Clhas
venned by Curve, Size.

[] sweep Function

Labeling

More >>

Preview Clear Create Close

After selecting the AutoCAD/BricsCAD entity the Mesh Properties dialog appears, where you
define:

The Material of the elements to be
generated

Type of Finite Elements from the
available GT STRUDL Finite Element
library

Thickness of Finite Elements

The Maximum Element Edge Size along
the Boundary. CAD Modeler will
generate additional joints along the
boundaries so that there is no finite
element edge, along the boundary
curve, longer than the entered value.
You can have the boundary curve to be
split in smaller parts than the Max, or
not. Additional splitting may be required
if you try to increase the quality of the
finite element mesh.

The quality of the triangles that are
going to be generated.

Add one or multiple (Multi+) internal
closed boundaries (polylines or circles),
or open boundaries (arcs or lines). If a
closed internal boundary is selected
there is a question asking if you want
the elements inside the boundary to be
removed (treat it as a hole) or not.
Moreover, you will be asked a question
regarding the size of elements along the
internal boundary curve, that can be 0,
so as to follow the current value of the
“Maximum Element Edge Size”, or it can
be a positive number which defines the
maximum length along the internal
boundary, or it can be a negative integer
which defines the number of equal parts
that the internal boundary will be split.

NOTE: Internal boundaries may intersect the external mesh curves, but it is
recommended that you manually spit the external curve at this point
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- Add internal joints (points) that will be additional corners of the finite element mesh.

- Labeling, Preview and Create functions are identical to the ones of the previously
described meshing forms.

2.6.35. Meshing by extruding a polyline
You can create Finite Elements by extruding an AutoCAD/BricsCAD closed curve, that can be a

t

—

3D
Polyline or a Circle, from the ribbon command Bdrude ¢ from the menu “GTS Modeling>Mesh
Generation>3D Extrude PolyLine” or by typing GTSExtrudePoly at the command prompt.
You are then prompted to select AutoCAD/BricsCAD curves, first the extruded curve, and then
the curve which defines the extrude direction which can be either a line or polyline. The finite
elements will be generated on the extruded surface.

The “Mesh Properties” form is similar to the “Meshing inside a polyline” properties form but you
must also define the “Spacing Extrude Direction”, meaning the parameters that control the size
of elements along the extrude direction. Uniform and Variable options are suitable if the
extrude entity is a line. “Defined by Curve, size” is suitable if the extrude entity is a polyline, so
that it is enforced that joints will be generated at the intermediate points of the polyline.
Labeling, Preview and Create functions are identical to the ones of the previously described
meshing forms.

2.6.36. Meshing using 3 curves
You can create Members OR Finite Elements between three selected AutoCAD/BricsCAD linear

L

3D
entities, that can be Lines or Arcs, from the ribbon command 3Curves or from the menu “GTS
Modeling>Mesh Generation>3D Between 3 Lines or Curves” or by typing GTSMesh3D3L at the
command prompt. You are then asked to select three AutoCAD/BricsCAD curves that will define
the U, V and W boundaries of the Mesh.

The dialog has the same options as in the 2D mesh command, between 2 lines, with the extra
parameters for the meshing in the W direction.

2.6.37. Array 3D Advanced
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You can create copies along the vertical direction, similar to AutoCAD’s and BricsCAD’s ARRAY

N

Array 3D
commands from the ribbon command “9**"“¢d or py typing GTSMesh3D3 at the command
prompt. This optimized command is useful for large models, or for multiple copies, when the
default AutoCAD’s and BricsCAD’s command take a lot amount of time. It produces the same

result in significantly reduced time.

2.6.38. Soil Springs

i3

Soil
You can create soil springs on individual/multiple shell element(s) from the icon P9 or by
typing GTSFoundationSprings at the command prompt and select the corresponding shell

element(s). After selection the “Soil Springs” dialog appears, where you can:

- Define in-plane spring ratio of Ks value if the “in-plane (orthogonal) springs” option is
checked. The in-plane spring ratio will be applied to the two remaining directions, other
than the selected.

- Define the direction of springs (in global system).

- Append new spring values in case of keeping the existing ones and adding the new ones.
Else, the new values replace the existing ones

- Define the value of modulus of subgrade reaction Ks.

After pressing “Place Springs”, a legend appears showing the Ks values distribution on the shell
elements. By double clicking on each node, you can see the value of Ks in “Restraints and Spring
Values” section of the Model tab in the “Joint Properties” dialog box. Note that if the spring’s
degree of freedom is not restrained by the user then it is restrained automatically.

General Information Ks Values
[]tn-plane (orthogonal) springs 000 . 00s
i lane Spring Rato: 008.. 015
015.. 0.23
Direction 0.23..03
(") Global % () Global ¥ (®) Global Z 031..038

0.32 .. 046

Append Existing Spring Values 0.46 .. 0.54
054 . 0E2

Modulus of Subgrade Reaction 062 .. 0k9
e 0E3.. 077
0.77..085

= 0.85 ... 0.92

Place Springs >> 0.82 ... 1.00
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2.6.39. Export to CAESAR II

The current drawing can be exported into CAESAR Il Modeler (str file) from the menu “GTS
Modeling>CAESAR II> Export STR” or by typing GTSExportSTR at the command prompt. You
select the members to be exported and an STR File is generated. Immediately after the log file
appears on the screen. A typical log file is:

GT STRUDL Version 2018.R1

GTS2CII Version 2018.R1.01

GTS2CII Binary Dir

C:\\Program Files (x86)\GTStrudl\2018R1I\Utilities\GTS2CITI\
Project Dir F:\\HexagonPPM\CaesarII\PlantStructure\

Total Number of Sections: 6

Total Number of Joints: 170

Total Number of Members: 233

The model will be saved in 1 STR file(s)

File
F:\\HexagonPPM\CaesarII\PlantStructure\\PStructure 0708 0l.str
created

If the cross sections used in CAD Modeler (and GT STRUDL) are not available in CAESAR’s section
library you get a warning like this:

WARNING: Section Llx1lx1/4 is not available in CII, please use another

one or edit
F:\\HexagonPPM\CaesarII\PlantStructure\\PStructure 0708 Ol.str file
manually

2.6.40. Convert Lines/Polylines to Members/Shells
Convert lines and polylines to members and shell elements through the utility “DXF converter”,

JXF| Convert Lines to Members
from the ribbon command - or by typing GTSDXFRead at the

command prompt. This command is not limited to DXF Files, but you can create new lines and
polylines on the DWG that is currently open and convert them to structural members. Or open
an existing DXF or DWG, select some lines and polylines, and convert them to members and
elements.
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Import Model in CAD Modeler? IEl
DXF - GTSTRUDL Converter Version 3.1.1 - o IEl P

D:\Hexagon\DXFReader\Run\DXFReader.dxf
- 477 Line 2 Polygon entities found!

Number of Joints Read: 243

Number of Members Read: 477
Output File: D:\Hexagon\DXFReader\Run\DXFReader.gti

Number of Shell Elements Read: 2
Done! 243 nodes 477 members 2 elements are created

Number of Sections Read: 0
& Create Joints, Members and/or Finite Element
Number of Groups Read: 0

€ Create Construction Points, Lines for Meshing
Number of Load Cases Read: 0
Read »» | Properties |
Number of Load Combinations Read: 0
Help | Exit |

2.6.41. Model Wizard

You can now use Model Wizard to create and import the model to CAD Modeler. This option is
very useful if you want to create a typical tank and further edit it in CAD Modeler, or append it
into an existing model. You can start the Model Wizard from the ribbon command

-

/" Model Wizard
or by typing GTSModelWizard atthe command prompt.

GTStrudl ModelWizard 4.3 X

To start using Modelwizard, select a structure type from the

palette below.

Braced Frame Space Frame

© m

Finite Element Circular Plate Bridge Truss
Mesh
y @ m_|

Tank Vault / Rect Tank Continuous Beam

0K I Cancel




2.6.42. Groups

It is optional to define Groups in your model, but it is strongly advised to do so, since it will be
easier to control the display and modeling of parts of your structure. Each Group is defined as a
set of joints, members and finite elements. Each structural entity can belong in more than one
group. Moreover, Groups defined in CAD Modeler are exported to the GT STRUDL Input file
(.gti), meaning you can also use them in GT STRUDL analysis and design commands.

You have to first define the name of each group from the ribbon icon List or from the menu
“GTS Modeling>Groups>Manage” or by typing GTSGroups at the command prompt.

Using the Groups Form you can:
- Set the Name of each Group (NOTE: not larger than 8 characters, due to a GT STRUDL
limitation)
- Add Groups to the model
- Delete Groups from the model

- Define if this Group is corresponding in a “Physical” member definition (used in Steel
Design commands).

Groups [ X |

Group Properties

ID Name Physical

Add Group

1 [ Delete Group

2 Beams []

3 Girders u [ x|
- Bracing I

5 Slabs [ Cancel

After defining a group you can add joints, members and shell elements to it using the
commands:
W} +Joints _ . “ . I . .
— ribbon icon, or “GTS Modeling>Groups>Add Joints” or by typing GTSGroupJoints
at the command prompt

== =

= ribbon icon, or “GTS Modeling>Groups>Add Members” or by typing
GTSGroupMembers at the command prompt

A1)

'-[-jf +Shells ribbon icon, or “GTS Modeling>Groups>Add Shells” or by typing GTSGroupShells
at the command prompt

52



2.6.43. Self - Weight
----- Self Weight

or from the menu “GTS Modeling>Loads>Self Weight” or by typing GTSSelfWeight at the
command prompt.

Self Weight or Dead Loads Bl The “Self-Weight” form appears where you
Load Information can define:
T sw v - the global direction of the self-weight
Desaription : | S¢If Weisht - the load factor (default = 1.0) for the
self-weight
Create New Save [ Modify Delete . . _
- if the self-weight of finite elements
Loads applied parallel to this Global Axis will be taken into account or not
() Negative Y () Positive Y
(®) Negative Z () Positive Z
() Negative X () Positive X
Factor: | Indude Finite Elements

2.6.44. Load Cases

A new load case can be created from the ribbon command _-E] Load Cases or from the menu

“GTS Modeling>Loads>Load Cases” or by typing GTSNewLoadCase atthe command prompt.
The “Load Case” form appears as shown below where you can enter new load cases, modify
existing ones, or delete them.

Load Case *
Load Case Information
Load ID (up to 8 chars) : Eeriioinles >
Description : | Live Load | Save [ Modify
Load D st Delete
PL
Exit
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Design variable associates the Load Case with the Design Load Variable. This information can be
used later on, when creating the standardized load combinations.

Create New

D Deadload

DI Weight of ice

E Earthquake load

F  Fluid loads having well - defined pressures and maximum heights or depths

FAl Flood loads Fain V - Zones or Coastal A - Zones

FA2 Flood loads F a in noncoastal A - Zones

HA  Lateral pressure load, H, due to earth, ground water, or bulk materials, when H adds to the primary variable(ive) load effect
HR  Lateral pressure load, H, due to earth, ground water, or bulk materials, when H resists the primary variable(ive) load effect
L Liveload

LR Rooflive load

R Rainload

5 Snow load

T  Self straining load, such as a temperature load that causes thermal stresses

W Wind load

WI  Wind - on - ice load

AK  Extra ordinary event load, such as blast, fire, etc,

M Motional load

L100 Live load that is permitted to be less than or equal to 100 psf.in & given load combination

LE¥ Loading conditions associated with LEX are live loads L that are treated as EXdusive loads in the creation of the standardized loading combinations

2.6.45. Joint Loads

A Joint Load can be entered from the ribbon command § Joint or from the menu “GTS
Modeling>Loads>Joint Load” or by typing GTSJointLoad atthe command prompt. You then
have to select the joint or the joints that the load will be applied to.

At the “Joint Generalized Loads” tab you can apply joint loads or displacements. On the left part
of the form, you can see a list of all available load cases: Load cases having loads already applied
to the specific joint appear at the top list box. Load cases that do not have any loads applied to
the specific joint appear at the bottom list box. Next to the name of each load case thereisa $
symbol followed by the total number of joints that are already loaded in the specific load case.

Joint Properties *

Model Joint Generalized Loads

Applied Load Cases Loading
Load Case - e
Description | Paint Load Save [ Modify
Loads in thisLoad Case : |1 bl Delete

Applied Load Values

rrcexs | O rreevs [ 0] e
womertx: | O] wamentv:[ 0] womemz:[ 9]
Applied Displacement Values
A [ ] [ ] [ ]
LL S Live Load S[0] TranX: Tran'Y: Tran Z:

Cancel Apply Help
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2.6.46. Member Loads

A Member Load can be entered from the ribbon command = MEMPE" o from the menu “GTS
Modeling>Loads>Member Load” or by typing GTSBeamLoad at the command prompt. You
then have to select the member or the members that the load will be applied to.

At the “Member Loads” tab or the Member Properties form as shown below, you can apply
member loads. In the left part of the form you can see a list of all available load cases: Load
cases having loads already applied to the specific member appear in the top list box. Load cases
that do not have any loads applied to the specific member appear in the bottom list box. Next to
the name of each load case there is a S symbol followed by the total number of members that
are already loaded in the specific load case. The load distribution can be Concentrated, Uniform,
Linear or Triangular and it can be applied in any local member or global direction. The Location
can be entered in fractional terms (0: start, 1: end) or absolute terms in current length units
measured from the start of the member.

Member Properties Ex

Model | Section Properties Member Loads | Member Temperature Loads | Member Distrortions

Applied Load Cases Loading

LL $Live Load §[125) |
- L Create New

Load Case :

Description : Live Load Save / Modify

Loads in this Load Case : 1 v Delete

Load Distribution

_) Concentrated Memb?' Start

W
®) Uniform f

) Linear — L1

L2

Empty Load Cases _) Triangular

PL $ Point Load $[0]
Load Type and Direction Loading Magnitude Loading Location from Start

®) Force X ) Local 5

= Vi: ®) Fractional L1: 0
'Y

) Moment @7 (®Global v2: 0 _) Absolute 12: -

oK Cancel App Help

Using the “Member Temperature Loads” tab, you can define Axial or Bending temperature
change along a part of the member, similar to the “Member Loads” tab as shown on the next

page.

Finally, using the “Member Distortions” tab, you can define concentrated of uniform distortion
of the member in any direction along the member as shown on the next page.
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Member Properties

| Model | Section Properties | Member Loads | Member Temperature Loads | Member Distrortions |

Applied Load Cases

Empty Load Cases

LL $Live Load $[0]
PL $ Point Load $[0]

Loading

W
Description : | ‘ | Save / Modify ]
Loads in this Load Case : [:,
Temperature Change

(® X Axial Uniform through cross-section

(Y Bending Vary through depth Change : E

(0 Z Bending Vary through width

Location: Length experiencing temperature change
(® Fractional (% 0-1) Starting Location : E

(O Absolute (len) Ending Location :

Member Properties

| Model | Section Properties | Member Loads | Member Temperature Loads | Member Distrortions |

Applied Load Cases

Empty Load Cases

LL $ Live Load $[0]
PL $ Point Load $[0]

Loading
P
Description : l ‘ | Save / Modify |
losdsin thstoadCase: | V]
Distortion Type Distrortion Direction - Value
O Concentrated @Displacement @)X

O vae:
(®) Uniform (O Rotation Oz
Distortion Location

(®Fractional (% 0-1) LA: lj]
OMbsolte (en) 15
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2.6.47. Shell Loads

A Shell Load can be entered from the ribbon command B Shell or from the menu “GTS
Modeling>Loads>Shell Load” or by typing GTSShellLoad atthe command prompt. You then
have to select the shell or the shells that the load will be applied to.

Using the “Element Loads” tab of the Element Properties form, you can apply element loads. In
the left part of the form, you can see a list of all available load cases: Load cases having loads
already applied to the specific element appear in the top list box. Load cases that do not have
any loads applied to the specific element appear in the bottom list box. Next to the name of
each load case there is a $ symbol followed by the total number of elements that are already
loaded in the specific load case. The Force type can be Body, Surface or Edge, in any Local,
Planar, Global or Projected direction with uniform or variable values.

Element Properties
Model | ElementLoads
Applied Load Cases Loading
Load Case : 101 Create New
Description : general Save [ Modify
Loads in this Load Case : 5 elete
Force Type Direction System Load Distribution Values (B or S)
(U Body Ox (OLocal (®) Uniform vl: -1.00
. O Planar v2:
(® Surface Oy R
(®) Global () Variable v3:
(OEdge @z (O Projected vt
Empty Load Cases
[oisf) |
T Cancel App Help

2.6.48. Area Load

An Area Load can be entered from the ribbon command . Area or from the menu “GTS
Modeling>Loads>Area Load” or by typing GTSAreal.oad atthe command prompt.
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Area Load

Generate

Name : ALl v

o Areaload 1
Description :

Create New Save [ Modify Delete

Load - Direction

Load Value :

Global Direction Perpendicular to the Loading Plane :

Ox Qv @z
Plane Tolerance : S
Elevation

Plane Perpendicular at :
(®) value (coordinate)
() Joint

Distribution
(®) Two way
() One way

Advanced Features

Define Outline Region >>

Exclude Area >>

Ignore Members >> Reset

Display >> Clear

OK Cancel

Using the Area Load form you can
define:

- The Name of the Load (up to 8
characters)

- The description of the load

- The Loading Value in current
units (force/length?). A positive
value is applied in the negative
global DIRECTION.

- The Global direction of the
loading plane (X, Y or Z) and the
tolerance

- The position (Elevation) of the
plane, defined by a coordinate
or an existing Joint. All
members belonging to the
plane having this elevation are
located and loaded by GT
STRUDL.

- The Distribution of the load
(one way or two way)

Advanced Optional Features:

- Outline Region: Select the
members that form the closed
perimeter of the loaded area. If
an Outline Region is defined
then the area load is applied
ONLY to the selected area and
NOT to the whole plane having
the elevation defined above.

- Exclude Area: Internal openings
or islands not being loaded may
be specified by selecting the
members that define the
perimeter of the excluded area.

- Ignore Members: Select members that you do not want to be loaded (eg bracing

members)

By selecting “Display >>" you are able to graphically view the loaded area, marked with a

yellow hatch pattern.



2.6.49. Wind Load ASCE 705
You can define Wind Loads using a similar form with GT Shell. A Wind Load can be entered from

the ribbon command e or from the menu “GTS

Modeling>Loads>Wind Load ASCE 705” or by typing GTSWindLoadsASCE705 at the
command prompt.

B " Wind Load Generation A5CE 7-05 =

Wind Load ID: I Wi Delete Wind Load |

Description: I Wind Load X

General Wind Load Data I Member Wind Load Data

Active Units; M KN DEG SEC StdMASS Change Unitsl

—Diesign Wind Speed

UE IZD & mph " mfs Gust Factor (3): IU.BE

—Elevation Axis

Gy 7 Wind Direction Angle: IU
Directionality Factor (Kd): I 1

— Exposure Category
“B Cc D Importance Factor (I): |1
— Topographic Factor
% Kzt Kzt: IU
" K1,K2,K3 Ki: |0 K2 |0 K3 |0

Minimum Velocity Pressure (QZmin): I 0.478303
Gross Area (Ag): I 0

Added Force Area (AFadd): I 0

Review Data |
Save Commands
Report Wind Load | Only Save Load I Daone Help

59



In addition, you can select members (to apply loads) interactively with mouse picks in the CAD

environment.

® " Wind Load Generation ASCE 7-05

Wind Load ID: I Wi Delete Wind Load |

Description: I Wind Load X

General Wind Load Data  Member Wind Load Data |

Active Units: M KN DEG SEC StdMASS Change Unitsl
Select Members | Selected Members: I 123

Wind Load Component Type: I Industrial Frame ;I

—Af and Cf Parameters

¥ Properties " Round D: IU

" Rectangle B: ID H: ID

" Af IEI
Hctrs: IEI Dictrs: ID C-T-R-5 ID: I

THice: IU THins: IU
CDag: IU

—Misc, Parameters/Cverrides

Add to Member Data | Clear Member Data | Delete Selection

Review Data |
Save Commands

Report Wind Load | Only

Save Load I Daone Help
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2.6.50. Wind Load ASCE 710

Wind Load ASCE 7-10

A Wind Load can be entered from the ribbon command
the menu “GTS Modeling>Loads>Wind Load ASCE 710" or by typing GTSWindLoadsASCE710

at the command prompt.

B | Wind Load Generation ASCE 7-10

Wind Load ID: | WLx

Delete Wind Load |

Description: I Wind Load ¥

General Wind Load Data I Member Wind Load Data

Active Units: M KM DEG SEC StdMASS

—Design Wind Speed

W IZD & mph " m/s

—Elevation Axis

— Exposure Category
“p "c D

Change Units |

Gust Factor (G): | 0.85

Cy @3 Wind Direction Angle: IU
Directionality Factor (Kd): I 1

X

—Topographic Factor

% Kzt Kzt:IU

K1, K2, K3 K1 |D

K2: IU K3: |0

Gross Area (Aag): I 0

Minimum Velocity Pressure (QZmin): | 0.756085

Added Force Area (AFadd): I 0

Review Data |

Report Wind Load |

Save Commands

Only

| Save Load

Help |
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# 7 Wind Load Generation ASCE 7-10

Wind Load ID: I Wilx Delete Wind Load |

Description: I Wind Load X

General Wind Load Data  Member Wind Load Data |

Active Units: M KN DEG SEC StdMASS Change Urlitsl
Select Members | Selected Members: I 127

wind Load Component Type: IIndustriaI Frame LI
—Af and Cf Parameters

{¢ Properties " Round D ID

" Rectangle B: ||:| Hs |u

i AF; IDi

Hctrs: Iﬂi Detrs: IU— C-T-R-51D- I—
THice: IU— THins: IU—

CDg: IU—

—Misc, Parameters/Overrides

Add to Member Data | Clear Member Data | Delete Selection

Review Data |
Save Commands

Report Wind Load | Only

Save Load I Dane Help
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2.6.51. Wind Load ASCE 716

A Wind Load can be entered from the ribbon command

Wind Load ASCE 7-16

or from

the menu “GTS Modeling>Loads>Wind Load ASCE 716" or by typing GTSWindLoadsASCE716

at the command prompt.

Wind Load ID: | Delete Wind Load |

Description: |

General Wind Load Data I Member Wind Load Data ]

Active Units: M KIPS DEG SEC StdMASS

—Design Wind Speed

V: |0 & mph  mfs Gust Factor (G):

Change Units l

0.85

~Elevation Axis
Gy 7z Wind Direction Angle: 0
Directionality Factor 1
~Exposure Category ¢ 2 &)
o ® (“
=48 < L Site Elevation: IO
~Topographic Factor
* Kzt Kzt: l 0
" K1,K2,K3 Kt: [0 K2 [0 K3: |0
Minimum Velocity Pressure (QZmin): | 0.111111
Gross Area (Ag): | 0
Added Force Area (AFadd): | 0
Review Data I
Save Commands
Report Wind Load | Only Save Load Done Help
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" Wind Load Generation ASCE 7-16

Wind Load ID: || Delete Wind Load

Description: |

General Wind Load Data MerrberWndLoadDatal

Active Units: M KIPS DEG SEC StdMASS Change Units

Select Members ISelectedMenbefs: I

Wind Load Component Type: |Indusu'iaIFrame |
~Af and Cf Parameters

( Propertes " Round D: |o

€ Rectange B: [0 H: [0

cat o

st [0 pees: [0 cTRsm: [
Tee: [0 st [0

- | C—

—Misc. Parameters/Overrides
Kz: IO cf: |0
Qz: IO FLD: |1

Add toMember Data | Clear MemberData | Delete Selection
Review Data
Save Commands
Report Wind Load | Only | l Save Load I Done
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2.6.52. Wind Load ASCE 722

A Wind Load can be entered from the ribbon command

Wind Load ASCE 7-22

or from

the menu “GTS Modeling>Loads>Wind Load ASCE 722" or by typing GTSWindLoadsASCE722

at the command prompt.

® ° Wind Load Generation ASCE 7-22

Wind Load ID: || Delete Wind Load |

Description: |

General Wind Load Data | Member Wind Load Data |

Active Units: M KIPS DEG SEC StdMASS

—Design Wind Speed

V: IO @ mph " m/s Gust Factor (G): | 0.85

ChangeUnitsl

* Kzt Kzt:lO

~Elevation Axis ———
Gy 3z Wind Direction Angle: 0
Directionality Factor 1
—Exposure Category by (kd)
BN ICRLID Site Elevation: IO
—Topographic Factor

iK1 K2, K3 K1: |0 K2: |0 K3: |0

Minimum Velodity Pressure (QZmin): |0.111111

Gross Area (Ag): I 0
Added Force Area (AFadd): l 0

Review Data |

Save Commands
Report Wind Load I Only | Save Load I Done Help
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" Wind Load Generation ASCE 7-22

Wind Load ID: | Delete Wind Load

Description: |

General Wind Load Data Member Wind Load Data |

Active Units: M KIPS DEG SEC StdMASS Change Units
Select Members |Select:edMembefs: |

Wind Load Component Type: IIndustriaIFrame ;I

—Af and Cf Parameters
% properties (" Round D: IO
¢ Rectangle  B: |0 H: [o

cat o

Hees: [0 b [0 cTRsm: [
Mee: [0 mes: [0

S

—Misc. Parameters/Overrides

Add toMember Data | Clear MemberData | Delete Selection
Review Data
ReportWindload | e oy | [ saveload |  Done Help
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2.6.53. Seismic Load

You can define Seismic Loads using a similar form with GT Shell. Seismic Loads can be entered

Jilw- Seismic Load
from the ribbon command
Load” or by typing GTSSeismicLoading

or from the menu “GTS Modeling>Loads>Seismic
at the command prompt. In addition you can

select joints (to define story heights) interactively with mouse picks in the CAD environment.

B " Seismic Load Generation

Load X Name I 51X

Load ¥ Marne I
Description ISeismic Load Global Description I Description I

X

Load Z Marme I

—Standard —General Data
" ASCE7-05 Height Axis &y 3z
 ASCE7-10 —Story Heights
Story heights from ¢ values % Joints  Tolerance |0.6096 IMeters LI
EXISTING 17 35 55 7797 117 |
—Load
Direction W X (Lateral) ¥ rz
Lateral Seismic Factor (LSF) | 1.00 Seismic Weight Load | SW -
Wertical Seismic Factor (WSF) | 0.00 Seismic Dead Load I DL vl
" specified Response Coeffident (Cs) 505 I

% Response Coefficent from Standard

—Ground Motion — Spectral Response Accelerations

Site Class IB: Rodk 'I
Long Period {TL) I 12 Seconds
@ 55, 51 from Map |u5r.\ vI

s |

51| a

© sos | so1 | st

Risk Category II'«': Essential Fadlities

Latitude I 36

=l

Longitude I -39 Degrees

r—Seismic Forces

¢ Fundamental Period from Standard |SMR: Steel Moment-Resisting

Analysis Mode, Direction k3 I i I

Response Modification Coeffident (R) I 3.5

Accidental Torsional Factor (ATMF) | 1.00

~ spedfied Fundamental Peried (Ta) I Seconds

z |

Redundancy Factor (RF) | 1.00
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2.6.54. Load Combinations

A new load combination can be created from the ribbon command B8 Combinations or from the
menu “GTS Modeling>Loads>Load Combinations” or by typing GTSLoadCombination atthe
command prompt. The “New Load Combination” form appears where you can enter new load
combinations. For each Load Case or Load Combination, that appears in the left list box, you
define a factor and using the “ADD>>" button the selected load case is added in the

combination.

When all load cases are added, press the “STORE” button to store the load combination.

Using the same form, you can also Edit an Existing Load Combination (remember to press
“STORE” after you are done with the modifications).

Combination using this form.

New Form Load or Load Combination

Load Information

Name : tH
S Load Combination 1
Description :
Combine
SW (Self Weight)

LL (Live Load)
PL (Point Load

'SW' 1.35000 'LL' 1.50000 'PL' 1.50000

All Formed Loads or Combinations

ADD >>

Factor :
1.00000

You can also Delete an Existing Load

Type
(®) Load Combination
() Form Load
SW 1.35000
LL 1.50000
PL 1.50000
Delete
Item
STORE \/

oute
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2.6.55. Standardized Combinations

You can Create Standardized Combinations using exactly the same form with GT Shell.
Standardized  combinations can be entered from the ribbon command

@ Standardized Combinations
or from the menu “GTS Modeling>Loads>Standardized
Combinations” or by typing GTSLoadCombinationStandardized at the command

prompt.

B " Create Standardized Load Combinations

Assodations | Create Loads

Unassocated Loads Loads Assocated with Design Load Variables (DLVs)
Load ID | Description DLV | Associated Load IDs |
D1 D1 D
D2 D1 DI ‘or'
F F E 'E1'E2 'E3
F
Assodate == | FA1 'FAT
FAZ
HA  HA'
HR. 'HR'
Remove L L
Association LR LRY
R
5 g
T T
W 1
ﬂl W1 WIT W2
AK
M N1 N2
L100
LEX 'LEX1''LEXZ'

Standard (Code)

Definitions of DLVs | IASCE 7-10 LRFD vl

Help |
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B | Create Standardized Load Combinations *

Standard (Code)

Definitions of DLVs ASCE 7-10LRFD +

Associations Create Loads

Combination Selection Load Creation Options
v All Combinations {* Load Combinations Start ID
; ¥ Print Load Combos Report
¥ Ice Loading Check " Form Loads Load Group | ASCEF10L
Selection of Basic Combinations Reference for All Derived Combinations
| Basic Combinations | | Derived Combinations A
CITIb. 1 14D Cmb. 1 14D +F)+T
Cmb. 2 1.2(0 +F) + L.6L + 1.6LEX +0.5(LR or Sor R) +0.5HR + 1
v . . . .
[cmb. 2 1.2D + 16L +0.5(RorSor R) - <Ice» 1.2(D +F) + L.6L + LELEX + 0,201 + 0.55 + 0.9HR
[ACmb. 3 1.2D + 1.6(R or S or R) + (L or 0.5W) Cmb. 3 1.2(D +F) + L6(R or Sor R) +L +0.51100 +LEX +0.9HR
Cmb.4 1.2D +W +L +0.5{ R or SorR) Cmb.4 120D +F) +W +L +0.50100 +LEX + 0.5{LR or SorR) + C
[Wlcmb. 5 1.2D +E 4L 40.25 120 +F) +W +L +0.50100 + LEX +0.5(LR or Sor ) + =
[Cmb. 6 0,90 +W 1.2(D +F) +0.5W +L +0.5.100 +LEX + 0.5{LR or 5 or R)
[Wlcmb. 7 0,90 +E <Ice> 1.2(D +F) +DI +WI +L +0.5L100 +LEX +0.55 +
o S+ Cmb. 5 1.2(0 +F) +E +L +0.5L100 +LEX +0.25 + 0.5HR + 1.6H
Bcmb. 8 12D +AK +0.50 +0.25 Cmb. & 0,90 +W +0.9HR + 1.6HA +T
Cmb. 9 LD +N+L+0.25 0,90 +W + 2.0FA1 +0.9HR + L.6HA +T
0.90 +0.5W +FA2 +0.9HR + L.6HA +T
<Ice>0.9D +DI +WI +0.9HR + 1.6HA +T
Prab 7 MM AFY L F LN aOHD 4 1 EH& 1T 4
< >
oK Help

2.6.56. Steel Design Parameters
You can specify steel design parameters for AISC16, AISC15, AISC14, EC3, I1S800, CSA-2019, CSA-
2014 and other codes as shown in the CODE Name dropdown. Steel design parameters can be

defined from the ribbon command = or menu “GTS Modeling>Steel Design
Parameters” or by typing GTSSteelDesignParameters at the command prompt.
Parameters can be applied to ALL members or to specific members that can be selected
interactively with mouse picks in the CAD environment.
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S1g Steel Design PARAMETERS Command - (] X
CODE Name Imsc“; j Units  METERS KILONEWTONS
Commonly Used I All Parameters | Alphabetic l ~Member List Processing
-~
Parameter Name 3::::)1& Values (Default 1= OK I
L All Members
Method LRFD
R 1.0
UNITS | Cancel |
CombEgs Computed Member List Selection
TBLNAM W-AISC16
CODETOL 0.0 Help
SUMMARY NO Same as Previous Member
List
Shortcut to Deflection Parameters (click here)
SECTYPE ROLLED =
Help
AISC16 Selected Order | Alphabetic |
Based on the Manual of Steel .
Member, Joint or
Construction, American Institute Parameter Names ‘ Parameter Values ‘ UNMS

of Steel Construction, Inc.,
Sixteenth Edition, Chicago, lllinois,
2022.

This code is applicable to the
following cross-sections:

1.1 shapes, Channels, Single
Angles, Round HSS (Pipes), and
Rectangular and Square HSS
(Structural Tubes) subjected to

2.6.57. Create GTI

Load

A GT STRUDL Text Input file can be generated from the ribbon command
menu “GTS Modeling>Create GT.STRUDL GTI” or by typing GTSExportGTI at the command
prompt. In the “Create GTSTRUDL Input File” dialog, you can enter the filename of the GTI File
and add additional commands to your GTI file, such as the Stiffness Analysis command to
perform a static analysis automatically and commands which control the analysis results data
that can be imported into CAD Modeler immediately after the analysis is complete.
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Create GT.STRUDL Input File [ x|

GTI Commands
GTIFile : F:\00.STRUDL Europe\05-ATLAS \Models\Southern\PG2. gti
[ ]Perform Stiffness Analysis

Append Other GTI Files/Macros

Up
Down
[]copy Commands from GTI Files/Macros (not CINPUT)
Create Commands to Read Results

[]read Joint Displacements
[read Member Forces
[[]Read Section Forces Number of Sections: i
["]Read Section Displacements N tber eof G Bcuncs 10
[]Read Finite Element Results
["]read Code Check Results

[ OK Cancel

Moreover, you can append additional GTI Files or Macros at the end of the GTI file of the model.
For example, additional GTI files may include static or dynamic analysis commands, result
output commands or member design commands. If you check “Copy Commands from GTI
Files/Macros (not CINPUT) then the above mentioned files or macros will be copied in your GTI
file. Otherwise, there will be a reference to them, with a CINPUT command.

2.6.58. Edit GTI

The GT STRUDL Text Input file can be edited from the ribbon command b Edi GTI or from the

menu “GTS Modeling>Edit GT.STRUDL GTI” or by typing GTSEditGTI at the command
prompt. The previously created GTl is opened for editing using the default text editor.

2.6.59. Execute GT STRUDL

GTSTRUDL can be launched, to process the previously created GTI, from the ribbon command

GTS

or from the menu “GTS Modeling>Edit GT.STRUDL GTI” or by typing GTSExecuteGTI
at the command prompt.
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2.6.60. Read Analysis Results

After performing the stiffness analysis in GT STRUDL, results can be read back to CAD Modeler,

@
from the ribbon command % e or from the menu “GTS Modeling>Read GTSTRUDL

Results” or by typing GTSResultsGTI atthe command prompt.

“Read GTSTRUDL Results” form appears, where you can choose to import Displacements,
Member Forces, Section Forces, Section Displacements, Finite Element Results and Code Check
Results. Depending on your selection a set of GTI DBX commands are created in the edit boxes
shown below. If you have selected the same options in “Generate GTI” command, then the DBX
commands are already included in your GTI file. Else, they should be copied and pasted into GT
STRUDL main window. Do not press OK before the writing of the files in the GT STRUDL main
window has completed.

Read GT.STRUDL Results | x|
Read DBX Results
F:\00.STRUDL Europe\05-ATLAS\Documentation

GTI Directory :

Read Joint Displacements

Read Member Forces
Read Section Forces Number of Sections: -
Read Section Displacements P T 10
[ ]Read Finite Element Results
Type of element result : <ALL>
Surface : <ALL>
[ JRead Code Check Results
GTI Commands

Corresponding GT STRUDL commands:

DBX BINARY

WRITE REPLACE JOINT RESULTS JOINTS EXISTING

WRITE REPLACE MEMBER RESULTS MEMBERS EXISTING

WRITE REPLACE SECTION FORCES NS 10 MEMBERS EXISTING

WRITE REPLACE SECTION DISPLACEMENTS GLOBAL NS 10 MEMBERS EXISTING

Cares
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By pressing OK you will get the confirmation message “Results Loaded Successfully”
at the command prompt. Else, you will get an error message informing you about the type of
analysis results that are missing and the corresponding DBX full path file names.

2.6.61. Import GTI
An existing GTlI file can be imported it into CAD Modeler from the menu “GTS Modeling>Import>

GT.STRUDL GTI” or by typing GTSGTIRead atthe command prompt. Note that the GTI should
be generated by the command “File>Save>Text Input File...” from GT STRUDL main menu.

2.6.62. Set Views

You can switch between different 2D or 3D views of the structure from the ribbon command

© SetView o from the menu “GTS Display>Set View” or by typing GTSSetView at the

command prompt.

It is strongly recommended to use Z as the vertical axis, so as to be able to use all built-in
AutoCAD or BricsCAD functions for Views (Top, Bottom, Left, Right, Isometric, etc). However, if
you use Y as the vertical axis, you can use this form to have identical 2D and 3D views, as in
GTMenu.

View Dialog B
View Options

[]z axis Up

Available Views :

GTS Isometric View

GTS XY Plane along -Z axis

GTS XZ Plane along -Y axis
GTS YZ Plane along -X axis

2.6.63. 3D or Wireframe View of the Structure

You can switch between the 3D view or wireframe view of the structure.

You can view the 3D display of your model from the ribbon command “E or from the menu
“GTS Display>3D Sections” or by typing GTSSet3D at the command prompt. When 3D view is
selected, all members appear as solid cross sections and shell elements are displayed in 3D view
taking into account their thickness.
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A F
You can view the wireframe display of your model from the ribbon command A Frame or from
the menu “GTS Display>Frame” or by typing GTSSet1D at the command prompt. When the
wireframe view is selected, all members and shell edges are displayed as lines.

If some parts of the structure are hidden (i.e. using Level’s form) you can display the whole

All Levels ON
structure from the menu “GTS Display>All Levels ON” & Ve or by typing

GTSSetAllVisible atthe command prompt.
2.6.64. Analytical/Physical Member View

You can turn ON or OFF the physical member view of the structure. When Physical Member
view is turned ON, all analytical members belonging to a physical member are hidden and the
physical members are displayed instead, as single objects. You can use copy, edit and move
commands on the physical member objects and they apply to analytical members as well.

You can switch between the physical or analytical member view of your model from the ribbon
command = AnabticalPhysical - o from the menu “GTS Display>Analytical/Physical” or by typing
GTSDisplayPhysicalMembers atthe command prompt.

2.6.65. Colors and Visible Elements
You can control the color of each member or element, and its visibility from the ribbon

3 Col . . .
command © Colors or from the menu “GTS Display>Colors” or by typing GTSColorView at
the command prompt.

Using the tab “Sections” in the “Color Options” form shown below, you can assign a different
color for each cross-section profile and set its visibility to ON or OFF. By pressing “Reset Colors”,
all colors are set to defaults. By clicking on the color value cell a pop-up dialog appears, where
you can select the color that you want to be assigned to this section. If you select “BYLAYER” or

256 then the color is assigned by the color set at GTS Disaplay>Options € Options , as
explained in 2.6.66.
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Color Options

Sections &mps,

Categories

Sections Visible
HE320B
IPE330
IPE120

BheB0n5

Mote:  you set a colorto 256 (BYLAYER) then the coloris defined by the color set
at View > Options Dialog

CncheckALL | [ CreokALL |

ok | [ Goos ]| oh

Using the tab “Groups” in the “Color Options” form, you can assign a different color for each
group and set its visibility to ON or OFF. Moreover, you can set a color for entities that do not
belong to any group (UnGrouped data). For entities belonging to more than one groups, the one
that appears last in the color list is the one that defines it’s color and visibility.
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Color Options
Growes

Categores

Visible

Groups

Columns

Beams
Girders
Bracing

UnGrouped data

Mote: f you set a color to 256 (BYLAYER) then the color is defined by the color set
at View > Options Dialog

ff @ member/shell/joint belongs to maore than one groups, the one that appears last
in this list is the one that defines its' color and visibility

reveck ALL | | CreckALL

Note, that if the “Sections” tab is active when pressing “OK”, then the colors will be selected
according to the “Sections” tab. If the “Groups” tab is active when pressing “OK”, then the
colors will be selected according to the “Groups” tab.

2.6.66. Display Options

You can set the display options from the ribbon command €} Options or from the menu “GTS
Display>Options” or by typing GTSDisplay at the command prompt. Using the “Display
Options” form shown below, you can:

- set which objects will be visible or not

- set object colors

- set which labels will be visible or not

- set font sizes for labels. NOTE: Font sizes are defined in length units, except Annotation
fonts that are entered in Points.
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- set type of Annotation Format: Decimal, Exponential or Generic (automatic) and the
number of decimal places

set object sizes
set the shrink factor for finite elements and members. This option makes it is easier for

you to detect members that lie along finite element edges.

Do Not Display Thickness in 3D. If you check this option, elements will be displayed as

being 2D instead of a 3D display which shows the thickness of the elements. This option
may increase the display speed in very large finite element models.

Display Members as Analytical or Physical (see 2.6.64 )

Display Options “

Visible Objects Visible Labels

Joints - Joints |

Members | Members |

2D Elements | 2D Elements |

3D Elements | 3D Elements |
Label Settings - Font Sizes Object Sizes

Tk = 9.842520 Joint : 1.968504

Members : SRS Load Arrowhead (pts): I

70 Elements = 9.842520

30 Elements : 9.842520 Display Members [ Elements

Aevakation b 10.000000 Shrink Factor : 1.0 v

Amnotation Format: | Decmal = [ ]Do Not Display Thickness in 3D

Decimal Places : 2 v Members As: Analytical v
Scale Factors

72.000000

Concentrated Load (pts) :

Distributed Load (pts) : | 72000000

2.6.67. Annotate
You can display information related to your model from the ribbon command kT Annotate or

by typing GTSAnnotate at the command prompt. The “Annotate” form appears where you
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choose the type information needed, press the “Annotate” button and select the corresponding

entities.

Annotate

Inquire
(®) Coordinates
() Dimensions / Distance
() Joint Names

(") Member - Element Names

) Member Forces

Arrowhead (pts): 10.000000
Font Size (pts) : 10.000000
Annotate Close

The available inquire options are:

Coordinates of a specific Joint or
AutoCAD/BricsCAD Point. Immediately after
selecting this you have to select one Joint or
Point.

Dimension/Distance between two Joints or
AutoCAD/BricsCAD points. Immediately after
selecting this you have to select two Joints or
Points.

Joint Names to display the name of a specific
joint. Immediately after selecting this you
have to select one Joint.

Member or Element Names. Immediately
after selecting this you have to select one
Member or Shell.

You can also control the size of the fonts (in
points) and the arrowhead.

2.6.68. Select CAD Modeler’s entities
You can use all AutoCAD’s/BricsCAD’s selection functions (window, crossing, pick, etc) to select
CAD Modeler’s structural entities. In addition, there is a command to help you selecting entities,

having functionality similar to GTMENU. You can access this command from the ribbon

command & Select by typing GTSSelect at the command prompt. The “GTS Select”

form appears where you can set the selection options.

GTS Select - Bounded Line Selection: All entities
that lie on a Line
Select Options - UnBounded Line Selection: All
@ Line (o) el entities that lie on a Line or its
extension
() Plane - Bounded Plane Selection: All entities
that lie on a Plane
() volume () UnBounded - UnBounded Plane Selection: All
entities that lie on a Plane or its
Filter Options extension

- Bounded Volume Selection: All
entities that are located inside a
Volume

- UnBounded Volume Selection: All
entities that are located inside a

Joints [ |Members [ |Elements
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Volume or its extension

Moreover, you can choose to filter only Joint, Members and Elements during the selection.

2.6.69. Display Member Local Axes

You can view the local axes of all members from the icon %" Member Local Axes (Ribbon GTS

Display) or from the menu “GTS Display>Member Local Axes” or by typing
GTSDisplayLocalAxes at the command prompt and immediately after you click at the
point where you want the legend to be displayed.

In the legend, the X axis is displayed in cyan, Y axis in red and Z axis in yellow. The size of the
arrow and its arrowhead is controlled by the value given at Display Options > Object Sizes > Load
Arrowhead and the size of the legend fonts is controlled by the value given at Display Options >
Label Settings — Font Sizes > Annotation (pts) (shown in 2.6.66).

2.6.70. Display Member Releases

. . Rel 3 .
You can view the member end releases of all members from the icon / Release (Ribbon GTS

Display) or from the menu “GTS Display>Member Releases” or by typing
GTSDisplayReleases at the command prompt.

A text identifying the released degrees of freedom appears next to members having releases. No
text appears for members that do not have releases. The size of the legend fonts is controlled by
the value given at Display Options > Label Settings — Font Sizes > Annotation (pts) (shown in
2.6.66).

2.6.71. Display Shell Planar Axes

[t7 Shell Planar Axes
You can view the planar axes of all shell elements from the icon = (Ribbon

GTS Display) or from the menu “GTS Display>Shell Planar Axes” or by typing
GTSDisplayPlanarAxes atthe command prompt and immediately after you click at the
point where you want the legend to be displayed.

In the legend, the X axis is displayed in cyan, Y axis in red and Z axis in yellow. The size of the
arrow and its arrowhead is controlled by the value given at Display Options > Object Sizes > Load
Arrowhead and the size of the legend fonts is controlled by the value given at Display Options >
Label Settings — Font Sizes > Annotation (pts) (shown in 2.6.66).

2.6.72. Display Joint Supports

Joint S rt
You can view the support status of each joint from the icon I S (Ribbon GTS

Display) or from the menu “GTS Display>Joint Supports” or by typing GTSDisplaySupports
at the command prompt.

A red arrow is displayed for the translational restrained degrees of freedom and a yellow arrow
is displayed for the rotational restrained degrees of freedom. The size of the arrow and its
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arrowhead is controlled by the value given at Display Options > Object Sizes > Load Arrowhead
and the size of the legend fonts is controlled by the value given at Display Options > Label
Settings — Font Sizes > Annotation (pts) (shown in 2.6.66).

2.6.73. Display Joint Loads

int
You can view the joint loads applied in the structure from the icon o (Ribbon GTS

Display) or from the menu “GTS Display>Joint Loads” or by typing GTSDisplayJointLoads
at the command prompt.

Display Loads The “Display Loads” form appears where you
can select the desired Load Case, the Scale
Load Case Factor for Joint Loads, Arrowhead Size and
PL v the Font Size. The “Show” button displays the
load arrows, and the “Clear” button erases

Display Loads Applied To them.

Joints [ |Members [ |Elements

Display Options

Scale Factor Concentrated (pts) 72.000000

Scale Factor Distributed (pts) : | 2200000

Arrowhead Size (pts) : 10.000000

Font Size (pts) : 8.000000
Show Clear Close

2.6.74. Display Member Loads

You can view the member loads applied in the structure from the icon =~ Member (Ribbon GTS
Display) or from the menu “GTS Display>Member Loads” or by typing
GTSDisplayMemberLoads atthe command prompt.
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Display Loads
Load Case
PL v
Display Loads Applied To

[ ] 30ints Members [ ]Elements

Display Options

Scale Factor Concentrated (pts) 72.000000

Scale Factor Distributed (pts) : | ~ > 000000

Arrowhead Size (pts) : 10.000000

Font Size (pts) : 8.000000
Show Clear Close

2.6.75. Display Shell Loads

You can view the finite element loads applied in the structure from the icon

GTS

Display) or from the menu

The “Display Loads” form appears where you
can select the desired Load Case, the Scale
factor for Concentrated or Distributed
Member Loads, Arrowhead Size and the Font
Size. The “Show” button displays the load
arrow, and the “Clear” button erases them.

B Area (Ribbon

“GTS Display>Shell Loads” or by typing
GTSDisplayElementLoads atthe command prompt.
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Display Loads The “Display Loads” form appears where you
can select the desired Load Case, the Scale

Load Case factor for Concentrated or Distributed
11 v Member Loads, Arrowhead Size and the Font
Size. The “Show” button displays the load

Display Loads Applied To arrow, and the “Clear” button erases them.

[ ] 30ints [ IMembers Elements

Display Options

Scale Factor Concentrated (pts) 72.000000

Scale Factor Distributed (pts) : | 2000000

Arrowhead Size (pts) : 10.000000

Font Size (pts) : 10.000000
Show Clear Close

2.6.76. Display Area Loads

You can view the area loads applied in the structure from the icon B Area (Ribbon GTS
Display) or from the menu “GTS Display>Area Loads” or by typing GTSDisplayArealLoads
at the command prompt. Loaded areas appear in yellow solid hatch. If you want to display only
one area load, you can use the area load command (2.6.48) to bring up the area load dialog,
select the specific area load and click “Display >>".

2.6.77. Display Deformed Structure

7 Def d
You can view the deformed shape of the structure from the icon |/ Deforme (Ribbon GTS

Display) or from the menu “GTS Display>Deformed Structure” or by typing
GTSDisplayJointDisplacements atthe command prompt. You must then immediately
select the load case, press ENTER, and then give the desired scale factor.

Select Load Case

Load Case

<Select Load Case> v

i f
You can switch back to original view from the icon || Undeformed (Ribbon GTS Display) or from

the menu “GTS Display>Undeformed Structure” or by typing
GTSResetJointDisplacements atthe command prompt.
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Note that Deformed Structure can be displayed in both 3D and Wireframe views of your model
and that you can also switch between levels using the Levels Form or the Upper Lever, Lower
Level icons.

2.6.78. Annotate Joint Displacements
At the deformed state, you can annotate joint displacements of the structure from the icon

/'. » -
Py Annotate Displacements

(Ribbon GTS Display) or by typing
GTSAnnotateJointDisplacements at the command prompt. This command is valid
when the deformed shape of the structure is visible, where you select a joint and then a pointin
screen for annotation position.

2.6.79. Display Displacements
You can view the displacements of the model (including a member’s deformation between
joints) from the icon F'? Displacements (Ribbon GTS Display) or from the menu “GTS

Display>Displacements” or by typing GTSDisplaySectionDisplacements at the
command prompt.
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Displacements

Load Case [ Load Combination

SW S Self Weight "
Display Options
Scale Factor (Values) : 0.100
Font Size (pt) : 10.00
Annotation Format; | Dedmal W
Decimal Places ; 2 (¥
[ ]Hide Madel
Display ==
Annotate = Legend =
Animation Options
Frames : 7
Animation Speed % : 1 W
Generate Animation i
Frames o =
Clear Close

2.6.80. Display Member Diagrams

You can view the force and moment diagrams from the icon
Display>Member

or

from the menu

“GTS

The
can

“Displacement” form appears where you
select:

The
Combination

The Scale factor

The Font Size (in pts) for Annotations
and the Annotation Format.

Choose to display the model or Hide
it, so that the deformed shape is
clearer.

The “Display >>" button displays the

desired Load Case or

deformed shape for the Vvisible
members and elements. If there are
any hidden members or elements
their deformed shapes are not
displayed.

The “Annotate >” button allows you
to annotate any value on the
deformed shape by fist clicking on
the deformed shape curve and then
at the position that annotation will
be placed.

The “Legend >” button allows you to
place a legend on screen, having
information about the load case.

The “Generate Animation Frames”
button creates the animation frames
that can then be played in a loop by
using the “Animate>>" button.

w Diagrams (Ribbon GTS Display)

Diagrams” or by

GTSDisplayMemberForces atthe command prompt.

85

typing



Member Diagrams

Load Case [ Load Combination

SW § Self Weight v
[ ]Envelope
Values

MZ Moment v
Display Options

Scale Factor (Values) 0-100
Font Size (pt) 10.00
Annotation Format: | Decimal v
Decimal Places : 2 v

[ ]Label Max &Min  [_|Positive Sign

Display >>
Annotate > Legend >

Clear Close

The “Member Diagrams” form appears where
you can select:

The desired Load Case or
Combination

The Envelope option and the load
cases that form the envelope.

The Forces or Moments to be
displayed (FX, FY, FZ, MX, MY, MZ)
The Scale factor

The Font Size (in pts) for Annotations
and the Annotation Format.
Automatically Label Maximum and
Minimum values for each diagram
Choose the direction of the diagrams
by switching the Positive Sign.

The “Display >>" button creates the
diagram for the visible members. If
there are any hidden members their
diagrams are not displayed.

The “Annotate >” button allows you
to annotate any value of the diagram
by first clicking on the member
diagram curve and then at the
position that annotation will be
placed.

- The “Legend >” button allows you to place a legend on the screen, having information

about the load case and member diagram.

2.6.81. Display Finite Element Results

You can view the finite element results from the icon h Elements (Ribbon GTS Display) or from
the menu “GTS Display>Element Results” or by typing GTSDisplayElementResults at

the command prompt.

NOTE: Hardware graphics accelaration may cause AutoCAD to incorrectly display the colors of
the contour. In such a case it is recomemded that you turn OFF Hardware Accelartion, during

displaying the stress contours, by typing the command GRAPHICSCONFIG. You can turn it

back ON afterwards.
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Graphics Performance

Hardware Setup
Video Card: NVIDIA GeForce GTX 660M

Driver Version: 9.18.13.697 Virtual Device: gdi13.hdi(Software)

Effects Settings

Hardware Acceleration

Element Results

Load Case
PL &% Pressure load W
Type
Resultants W
M W
Middle W

Display Options

Scale Factor (Values) 0.100
Fant Size (pt) 10,00
Annotation Format: | Dedmal W
Decimal Places 2 W
Display ==
Annotate = Legend =

Animation Optons
Frames :

Animation Speed % : 10 “

Generate Animation
Frames

Clear Close

The “Element Results” form appears where
you can select:
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The desired Load Case

The desired item to be displayed:
Stress, Strain, Resultants, Principal
Stress, Principal Strain, Principal
Membrane Resultant, Principal
Bending Resultant, Von Misses

The component of the desired item to
be displayed, i.e. Sxx, Syy, Szz

The Location: Top, Middle or Bottom
surface of the element which is
defined by the local or planar z axes of
the shell element. The top surface is
in the positive z direction.

The “Annotate >” button allows you to
annotate any value of the diagram by
fist clicking on a joint and then at the
position that annotation will be
placed.

The “Display >>" button creates the
contour and a popup legend showing
the limits of each color.

The “Annotate >” button allows you to
annotate any value of the diagram by
first clicking on the member diagram
curve and then at the position that
annotation will be placed

The “Generate Animation Frames”
button creates the animation frames
(contours and displacements) that can
then be played in a loop by using the
“Animate>>" button.



2.6.82. Display Finite Element Selection Results

Selecti
You can view the finite element results of selected elements from the icon z slection
(Ribbon GTS Display) or from the menu “GTS Display>Element Results Selection” or by typing
GTSDisplayElementResultsSel atthe command prompt.

This command is similar to the “Display Finite Element Results” of the previous paragraph. The
only difference is that you have to give a selection of members for the contours. This is useful in
cases where you want to examine only one surface of the structure, so display the limits of the
specific area. Or, if you do not want to take into account stresses from elements not belonging
to a specific plane.

NOTE: An “Execute GTI” command, including stiffness analysis, must be given prior to this
command.

2.6.83. Display Member Code Check Results

You can view the pass/fail result of a Steel Code check or design from the icon Eadethes

(Ribbon GTS Display) or from the menu “GTS Display>Member Code Check Results” or by typing
GTSColorCodeCheck at the command prompt. You must then select the members to be
displayed (or “ALL” for all of them).
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Code Check Results

Display Text
(®) None
(O) Actual/Allowable Stress Ratios
() Controlling Stress Code Provision
() Actual/Allowable KL/r Ratios

() Controling KL/r Code Provision

Values
(@ Al
() Greater Than 0.00

() Less Than 0.00

Display Options

Font Size (pt) 10.00

Display >>

Legend >

Clear Close

2.6.84. Results Datasheets

The “Code Check Results” form appears
where you can select:

- The text to be displayed for each
member, giving additional
information such as stress ratios,
controlling provisions and KL/r ratios.

- The Font Size (in pts)

- Limits for the Values to be displayed
(in example All of them, or Greater
Than a given value, or Less Than a
given value).

- The “Display >>" button regenerates
the view and members which passed
the code check will appear in blue,
those that fail the code check will
appear in red and those that were
not included in the code check will
appear in white

- The “Legend >" button allows you to
place a legend on screen, having
information about the colors used.

When you press the clear button,
member colors remain blue and red for
your convenience. If you want to change
them go to GTS Display > Colors.

In addition to the graphical display of results, you can also view the results in datasheets from
item “Results Datasheets” of the menu or ribbon tab “GTS Display”. In the table below, you can
find all the available results that can be viewed in datasheets and the corresponding command.

Description Menu Item Command

Displacements GTS Dlsplay>RP:sults GTSDataSheetJointDisp
Datasheets> Displacements

Member Forces GTS Display>Results GTSDataSheetMemberForces
Datasheets> Member Forces

Section Forces Gr1s D/splay>Resu!ts GTSDataSheetMemberForces
Datasheets> Section Forces

Reactions Grs D/splay>Result‘s GTSDataSheetReactions
Datasheets> Reactions

Stresses GTS Display>Results GTSDataSheetStresses
Datasheets> Stresses
GTS Display>Results

heck GTSDataSheetCodeCheck
Code Chec Datasheets> Code Check
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For example, click on the icon @ Displacements (Ribbon GTS Display) or from the menu “GTS

Display>Results Datasheets>Displacements” or by typing GTSDataSheetsJointDisp and
the “GTSTRUDL — Joint Displacement Datasheet” dialog appears where you can filter, sort, write
results to text file or change results units as shown in figure below:

B GTSTRUDL - Jeint Displacement Datasheet, display Units: Meters Degrees m} x
File Edit Columns Filter Sort Units Help
Joint Load Trans X Trans ¥ Trans Z Rotation X Rotation ¥ | ~
1 sW a. a. -0.0000128
2 SW 0. -0.
2 W 0.t -0.
4 SW 0.0 -0.
5 W 0. -0.
€ SW 0.0 -0.
7 SW a. -0.0000245 .
] W 0. -0.0000541 0.00000%93
i} SW a. 0,000 -0.0000440
10 W o. Q.00 0.0000193
11 SW a. 0.0 -0.00002283
1z W 0. 000 0.0000310
K] W 0. 000 -0.000020%
12 SW a. 0,000 0.00001&4
15 W o. Q.00 -0.0000253
1 SW a. 0.0 0.0000055
17 W 0. 000 0.0000016
12 W 0. 0.0 -0.c
13 SW a. 0,000 a.
20 SW 0. 000t 0.t
21 SW a. a. -0,
2z W 0. 0. 0.
Iz sW 0.0 0.0 o.
24 SW o a.a a.
25 SW 0.t 0.0 0.
26 SW 0.0 0.0 a.
27 W 0. Q.0 0.
2g sW a. -0.0000072 0.0000003 W
£ >

2.6.85. Report Builder

Report
You can generate your reports by calling Report Builder from the icon Builder (Ribbon GTS

Display) or by typing GTSReportBuilder at the command prompt. GT STRUDL Report
Builder is self-contained software, which allows you to generate reports graphically from DBX GT
STRUDL database files on the top of GT STRUDL software. CAD Modeler automatically generates
the necessary DBX files and launches Report Builder. You can find more information on how
creating your report in the GT STRUDL® Report Builder Getting Started Guide.

2.6.86. Clear Results Layer

You can clear the displayed output (Display Model, Display Loads, Display Results), hide the

Legend form of the contours and return to model from the icon <& Clear (Ribbon GTS Display)
or from the menu “GTS Display>Clear  Results Layer” or by typing
GTSDisplayResultsClear atthe command prompt. This command should be given after
any of the previous “display” commands.

2.6.87. Version

The current version of CAD Modeler can be displayed by selecting from the menu “GTS
Display>Version” or by typing GTSVersion atthe command prompt. The current version will

be displayed at the command line: The current version of CAD Modeler 1is
XXXX
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3. Tutorial Example #1

3.1. Introduction
The modeling of a three story building using CAD Modeler shown below is demonstrated in a
step-by-step process.

3.2.  Open CAD Modeler and start working

Step #1. Launch GT STRUDL by selecting the icon “CAD Modeler” in the Welcome to GT STRUDL
dialog shown below. The version of AutoCAD/BricsCAD selected during the installation will be
automatically launched, together with CAD Modeler’s menus and ribbons.
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Welcome to GT STRUDL

B Open Learn more about GT STRUDL (@) Hide Detsils € - 8 L] a
© b GT Menu CAD Modeler Command Mode Model Wizard Base Plate Wizard ( el
Perform structural anai Create complex structural Leam the STRUDL design Quickly madel simple al sign camplex e CADWorx®
= e o e i Lo N AT O i e et e el e o | base plates « ‘ H EXAGON Analysis Sc
32 Options imerface. BriesCAD. modess for structural 2nzlysis itz element znafys PPM
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Step #2. Make sure that CAD Modeler’s ribbons and menus are visible.

View Manage Output Collaborate = GTSModeling ~ GTSDisplay G~

~ A evel B Generate I / l / / Merge . Find J 1] Quad / ﬁ t . B EditinputFile A Fr 3D [ Annotate

_ T el o Atlevel Y Fiter = Cha Triangle. = 3 Read Results. 5 SetView @& Select

8 Materials  Levels Grid vy Sections Generate Vertical Split v A Tiarg D D D Creste  Execute © =3

- @ AllevelsON | B Support - Design % Cu urves” Extrud ile GTSTRUDL [ Import GT ) Colors <3 Clear
Model Levels Joints Members Find/Change/Check  Shells Meshing GTSTRUDL. Display Inqire

If AutoCAD’s/BricsCAD’s menu is not visible, type MENUBAR at AutoCAD’s/BricsCAD’s
command prompt, then 1 and press <ENTER>.

If AutoCAD’s/BricsCAD’s ribbon area is not visible, type RIBBON and press <ENTER>.

Ribbon commands will be used in this tutorial example. However, since all ribbon commands
appear in the menu area, you can use the menu bar as well.

3.3. Define the basic geometry of the model

Step #3. Define the correct Units by pressing the icon X Units and select Meters (m) and
KiloNewtons in the Units Form.
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Units >
Length Force Angles
() Inches {in) () Pounds (Ibs) (®) Degrees
(JFeet (ft) () Kips (_)Radians
@ Meters (m) O Tons O Cydes
() Centimeters {cm) () Kilograms
() Millimeters {mm) () Metric Tons Time
Temperature () Mewtons (®) Seconds
() Fahrenheit (®) KiloMewtons (I Minutes
@ Centigrade l:::l Megahewtons l:::l Hours
Scale non-structural CAD entities
(grids, structural lines, curves etc) Cancel

Step #4. Enter the cross-section profiles that will be used at the model by pressing the icon

L

Sections  click on the European list and then on the HEB table of profiles. Select the profile

HE320B that will be used for the columns, by double clicking on it.
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-7 AIsc 13th Edition 2005
}-f] AISC 13th Edition 2005 Metric
o[ AISC 9th Edition 1989
] AISC LRFD 3rd Edition
1] AISC 9th Edition Metric
7-f] AISC 8th Edition 1978
-] AISC 7th Edition 1969
7] AISC 6th Edition 1963
-] ANSI Pipe
@[] Brazilan Standard, NBR 5884:2000
@[] British Standard 5950
= [] European
I Hea
=~ HeB
°
T HeEM
I re
T EUROPEAN
Cu
[ rexoLLOW
QO sqHoLLOW
QO cHoLLow
v/ BSEQANGL
\, BSUNANGL
I BSEQDBAN
~r BSSLDBAN
== RSI I DRAN

&8-B-8-8-8

&5-8-8

&

HEB

HE100B
HE1208
HE 1408
HE1608
HE1808
HE2008
HE2208
HE240B
HE2608
HE280B
HE3008
HE3408
HE3608
HE400B
HE4508
HES00B
HES508
HE600B
HE6508
HE700B
HES00B
HES00B
HE10008

., European
T HE&
T HEE
® HE320B
T HEM
T IFE
® |PE330
® |PE120
T EUROPE&N
Cu
[ REHOLLOW
O SOHOLLOW
O CIHOLLOW
v BSEQANGL
® G0:60:5
o BSUNANGL
r BSEQDBAN
-~ BSSLDBAN
-~ BSLLDBAN

e

The profile is added to the project and it appears in the left list-
box having a black dot in front of it.

Using the same procedure, add 3 additional profiles: IPE330, for
beams, IPE120 for the girders from table IPE and 60x60x5 for
the bracing from the table BSEQANGL. Press OK to close the

form.

Note: You can add additional profiles at any time by following
this procedure and also view the full list of profiles used in your

model and add more profiles if needed.
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Step #5. Define the 3 levels of the model by pressing the icon L&vels  press the Add Level button
3 times to add 3 levels to your model. Modify the height of the 1! level by selecting the Height
cell of the 1% Level and entering 4.

Note: Some Edit Boxes appear in yellow background and green fonts, like the one at the Level
Heights. You can use mixed units in the yellow edit boxes. For more information about Mixed
Units and the valid syntax please read GT STRUDL GT Menu Guide

Make sure that Z Vertical Axis option is checked and press OK to close the form.

Level Properties X
Level Heights Options
Levels ] Elevation | Visible | Add Level |
| Delete Level |
| DetectLevels Automaticaly |
| Merge Levels |

Base Elevation 0.0000

[+]z vertical Axis (else 1)

[Jupdate Levels for All Entities

ok | cancel

Step #6. Enter a Grid that will help you enter the columns quickly by clicking on the icon 67id
The grid is going to have 3 spaces (6m, 5m, 6m) in the horizontal direction (X) and 1 space (5m)
in the sidelong direction (Y). Enter 6 in the Distance text box and press the Add button. Repeat
by entering 5 and Add, and 6 and Add.
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Placement Then, click on Sidelong in the Placement area
to enter the spacing in the Y direction, and

(®) Horizontal () sidel
. 4 SRS enter 5 and Add.
Spacing By pressing OK you are prompted (command
— prompt) to enter the Insert Point for the grid.
, Distance: | ©.UUUU
6.0000 Type 0, 0, 0 and press <ENTER>.
5.0000
6.0000 Add

The grid is created, having its upper left corner A-1 at the point 0,0,0.

You will be able to view the grid by pressing the Top Icon in
AutoCAD’s View Cube or BricsCAD’s Chair lcon, or preferably by
typing Z (for Zoom), E (for Extents) and press <ENTER>.

Note: In order to be able to snap at the intersection of the grid lines, while placing columns,
make sure that the AutoCAD’s/BricsCAD’s Object Snap is ON, and the Intersection mode is
enabled. Type OSNAP in both AutoCAD and BricsCAD to set the various snap settings. Shown
below is the ObjectSnap tab in AutoCAD’s Drafting settings dialog.
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Object Snap On (F3) [ Object Snap Tracking On (F11) Endpoint

Object Snap modes S
Center
O [¥]Endpoint 0y []insertion Select All Node
4[] Midpoint b [ ] Pemendicular Clear Al 7| Quadrant
Intersection
O [ Center T[] Tangent Insertion
Perpendicular
&3 [INode X [[] Nearest Tangent
> [[]Quadrant B []Apparent intersection A
eometric center
¢ .
X Intersection % []Parallel Apparent intersection
) Extension
- D Bxtension Parallel
‘ i) To track from an Osnap point, pause over the point while in a 5
% command. Atracking vector appears when you move the cursor. Off
To stop tracking, pause over the point again. @, |settings...
ESN, )
AutoCAD’s Snap Setting BricsCAD’s Snap Settings

3.4. Create the 1% floor

Step #7. Start entering the columns by clicking on the icon Vertical | The dialog Place Member
appears that helps you to quickly select properties for the members that are going to be
entered.

Cross Section Select HEB3208B as the cross section for the
Table Section: columns. Make sure that Material is set to
HE3208 HEB European Dl == Steel, Releases to Fix-Fix and the Beta angle is
or Member Dimensions: 0. There is no need to close this dialog
<Select Shape> v manually.

Si Member:
or Same as Member Press the “Place Member(s) >>" button.

<Select Existing Member > v

Click at the intersection point between line A
Material and line 1 (point A-1) and the column will be
Stedl v placed at this position.
Releases Beta (o) Repeat the same procedure by clicking at the
Fix-Fix N 0 v points B-1, C-1, D-1, A-2, B-2, C-2 and D-2.

When you are done, press ESC to exit the
Vertical column command. The Place

Ploce Member(z) >> Member form is automatically hidden.
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2 Note: Each time you create a member the
orientation of the cross section will appear in
the middle of the element, unless you clear it
with command “Clear” (see 2.6.86).

Step #8. You can easily change to an isometric view of the structure by pressing the small house
icon in AutoCAD’s View Cube or the small arrow “Top Front Left” of the following image in
BricsCAD’s View Chair. As you can see in the isometric view below, column members 1 to 8 were
created together with joints 1 to 16 at their ends. Each column is 4.00m long, as defined in Level
Properties (height of the first floor).

@ ;
w e e

Top Front Left

wire

AutoCAD’s View Cube for Isometric View BricsCAD’s View Cube for Isometric View
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Step #9. Start entering the beams, along X axis, by clicking on the icon Generate  The Place

Member form appears.

Cross Section

Table Section:
IPE330 IPE European

or Member Dimensions:

<Select Shape>

or Same as Member:

<Select Existing Member >

Material
Steel

Releases

Fix-Fix v

Split Intersecting Members

[ split Ending Members

Place Member(s) >>

Beta (o)
S0

[]Physical Member

Select IPE330 as the cross section and
make sure that Material is set to Steel,
Releases to Fix-Fix and the Beta angle is
90. You have to set the Beta angle equal
to 90 degrees in order to orientate the
local Y axis of the IPE cross section along
the Z global axis. Moreover, make sure
that the option Split Intersecting
Members is checked and then uncheck
Split Ending Members.

Press “Place Member(s) >>” button.

Starting Point (x,y,z) message appears,
asking you to enter the coordinates or
click on a specific point on screen. Click
on Joint 2 at the top joint of column 1 at
position A-1.

Then you have to define the Ending Point (x,y,z) so click on joint 8, as shown in the picture

below.
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Endpoint

(2]

e

o)

@

(7]

?)
4

Members 9, 10 and 11 will be created.

All three beams along X axis were generated with only two clicks of the mouse: at joints 2 and 8.
The beam from joint 2 to joint 8, was split into three parts, between joints 2, 4, 6 and 8, since
joints 4 and 6 (columns at positions B-1 and C-1) intersect this member.

Since the command is still active, you are prompted to enter the Starting Point (x,y,z), repeat the
same procedure by clicking on joint 10 (top of column at position A-2), and then click at joint 16
(top of column at position D-2). Members 12, 13 and 14 will be created.
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(o)

()

(7]

(3)

~5

Step #10. Enter the beams, along Y axis. The command Generate Beams should be still active,

y,

else you can call it again by clicking again on the icon Generate  Keep the same settings at the
Place Member Form, as in the previous step, regarding the cross section and Beta angle, but do
NOT click on Split Intersecting Members. Press the “Place Member(s) >>" button.

The prompt message Starting Point (x,y,z) appears, asking you to enter the coordinates or click
on a specific point on screen. Click on the Joint 2, that is the top of column at position A-1. In
order to define the Ending Point (x,y,z) click at joint 10 (top of column at position A-2). Member
15 is generated.

Repeat the same procedure by clicking on the joints 4 and 12 to generate member 16, joints 6
and 14 to generate member 17 and joints 8 and 16 to generate member 18. Then, press ESC to
terminate the command.
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(o)

(¢)

(7]

Y,
(1)

Step #11. Create an arc on the right side of the structure:
Type ARC and

- in order to Specify start point of arc or
_ [Center]: click on joint 8,
- to Specify second point of arc or
! [Center/End]: type @2,-2 and press
<ENTER> and
- to define the end point of arc: click on joint
16.

P

1D
Step #12. Generate Members along the Arc: Click on the icon Curve 3nd when the prompt
message Select Curve (Line or Arc) appears, click on the Arc that you have created in the
previous step.
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Select Mesh Properties

Generate
(®) Members Elements

Material | Steel

Element Attributes

Type FBEPHQ Thickness e

Member Attributes

Type FRAME ¥ Beta 20

v

Section | IPE330 IPE European

Spacing U Direction
(®) Uniform
() variable

Defined by Line/Curve

Step #13. Hide Grid: Since the Grid

AutoCAD/BricsCAD commands to freeze

The Select Mesh Properties form appears
where you enter:

Material : Steel
Beta Angle: 90
Section: IPE330
Spacing U Direction: Uniform 8

This command is going to generate 8 linear
members equally spaced along the arc.

You can press the Preview button to see the
members as they will be generated.

Press the Create button and 8 members,
named 19 to 26, were created and 9 joints,
named 17 to 25 were created along the arc.

Note that joints 17 and 25 are created on
the top of joints 16 and 8 correspondingly.
Later on, they are going to be merged
together by deleting duplicate joints.

is no longer needed it can be hidden using
the layer GRID_LAYER. This can be done by clicking on

the Home Tab and then selecting the GRID_LAYER from the drop down list of layers and clicking

on its freeze icon.

View

Parametric

Insert  Annotate

/D @ B b
&~ | G co

Line Polyline Circle Arc WS,

v v lj- E.A Stretch

Draw «

[=] [Custom View] [2D Wireframe] II Q @ of . GRID_LAYER

Manage Output Plug-ins Online Express Tools  GTS CAD Mog

GO Rotate 4 Trim - ¢ £5 & & ' £ & K T

A|h Mirror ﬂ Fillet ~ @59 | Unsaved Layer State v 4

0 Scale BB Armay - & ||} LT [0 '|
Modify ~ | Q -‘Q—.ﬁi GRID_CIRCLES
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Step #14. Turn OFF labeling:

Visible Label i
S0 Labes Click on the icon €} Options in the ribbon bar and
[ Joints then uncheck the Visible Labels option for Joints,
Members and 2D Elements.
[ | Members
Now labeling is turned off and it is easier and faster to
[ ]2D Elements view and control the model.
3D Elements

Note: You can also delete or hide the Arc line as it is no longer needed. It can be deleted by
selecting it with the mouse, and then presssing the keyboard button <Delete>. Be carefull not to
select any members or joints, but only the Arc line.

Step #15. Mirror the structure: Switch to a floor pan view, by pressing the TOP of AutoCAD’s
View Cube or BricsCAD’s View Chair.

Then, type MIRROR and when you get the notification Maintain incidence order (Yes/No). Press
Yes to maintain the local coordinate system when mirroring.

NOTE: This option is very useful when mirroring structures having shell finite elements and the
mirror line lies along the element’s XY plane. If you choose to maintain the incidence order, then
after the mirroring the local Z axis of the source and copied finite elements have the same
orientation.

You are then immediately prompted to Select objects: (AutoCAD) or Select entities to mirror:
(BricsCAD) select the right part of the structure, but not the members and joints that are on the
mirror line. In order to make this selection, make the 1% and the 2" click of the mouse at the
points 1 and 2 as shown in the picture below and press <ENTER>. You will get a confirmation
that 44 objects were found (or 45 if you still have the arc).

4
\

— 1

When you get the message Specify first point of mirror line (AutoCAD) or Start of mirror line
(BricsCAD): click on the joint at points 3 and then Specify second point of mirror line (AutoCAD)
or End of mirror line (BricsCAD): click on the joint at point 4 as shown in the picture above.
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Then, press <ENTER> and reply to the question Erase source objects? [Yes/No] <N> (AutoCAD)
or Delete the original entities? [Yes-Delete entities(Yes)/No-Keep entities(No)] <No-Keep entities>
(BricsCAD) so as not to delete the right part of the structure. The structure after the mirror
command will look like the following picture:

Step #16. Switch to 3D View: Press the house (AutoCAD) or chair (BricsCAD) icon to change the

C Colors

view to Isometric, and type Z and E (Zoom, Extents). Click on the icon to set different

colors for each profile.

Sections | Groups

Categories
Sections Color Visible
HE3208 161 v
IPE330 191 v
IPE120 v
BO0XB0X5 50 v

Press OK to close the Color Options Dialog. Each cross section will now have a different color.

Press the icon “7 to display the 3D solid view of the model, replacing the wireframe view:
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. F . . .
Press the icon A Frame to switch back to wireframe view to be able to process CAD Modeler’s
and AutoCAD’s/BricsCAD’s commands faster.

Step #17. Save your Model: In order to save your model just use AutoCAD’s or BricsCAD’s save
command and store the DWG using any filename that you want.

3.5. Create the 2" floor

Step #18. Copy the members and joints of the 1% floor to the 2": Type the command COPY and
when asked to Select objects: type ALL, so that everything is selected. You will get a verification
with the number of objects/entities selected and then press <ENTER>.
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In order to Enter base point or [Displacement/mOde] <Displacement>, click at the base of any
column such as point 1 in the picture above.

In order to Enter second point : click at the top of the same column such as point 2 of the picture
and then press ESC in order to terminate the copy function.

All entities of floor 1 are now copied to floor 2.

Step #19. Correct the Z coordinates of the 2™ floor: The copied columns are 4.00m long, since
they were copied from the 1 floor. In addition, the Z coordinate of the beams is equal to 8.00m
instead of 7.00m. Therefore, all copied joints that have Z coordinate equal to 8.00m should be
moved 1.00m lower.

Switch to FRONT View, by clicking on AutoCAD’s view cube or BricsCAD’s view chair and make
sure that you are in the World UCS by typing UCS and W.

Type MOVE in order to initiate AutoCAD’s/BricsCAD’s move command and when asked to Select
objects (or entities), click on points 1 and 2, as shown in the picture below, selecting all the
entities that belong to the top of the 2™ floor. You will get a notification about the selected
entities and press <ENTER>.
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In order to Enter base point or [Displacement] <Displacement>: click ANYWHERE on the screen.
It makes no difference where you click since relative coordinates will be use to define the
displacement.

In order to Enter second point: type @0, 0, —1 and press <ENTER>.

Now the height of the 2" floor is correct and equal to 3.00 meters.

Note that you can reach the same result by switching to the 2" Level using the icon

High vel . -
A Hoghexleve and start entering the columns one-by-one, as you did in the 1°* Level. Columns

will then have the correct height (3.00m), since the height of the second Level is defined equal
to 3.00m when the levels were defined in a previous step. Then, copy only the beams from the
1%t Level to the correct position. However, it is somewhat faster to copy everything and then fix
the Z coordinate with a simple MOVE command as you did in the previous steps.

3.6. Create the 3" floor

Step #20. Copy the members and joints of the 2™ floor to the 3™ : Type the command COPY and
when asked to Select objects/entites: click on the similar two points that were used in the
previous MOVE command as shown in the following figure.
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Since this is a crossing window, the columns are automaticallly selected. You will get a
notification about the selected entities and press <ENTER>.

In order to Enter base point: click ANYWHERE on the screen. It makes no difference where you
click since relative coordinates will be used to define the displacement.

In order to Enter second point: type @0, 0, 3 and press ESC.

Now the 2™ floor is copied to the 3™ one. There is no need to correct the Z coordinates as was
done when the 2" floor was moved since the second and third levels have the same height.
Press the ESC button to exit the Copy command.
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Step #21. Assign Level Properties:

Options Since all members were created from Level 1 using COPY
commands, all of them belong to level 1 and their correct
Level property should be assigned.

Delete Level g

Detect Levels Automaticaly Click at icon Levels check the option Update Levels for
All Entities and press OK.

Add Level

Merge Levels
Now every Member or Joint has the correct Level

Base Elevation 0.0000 property depending on its Z coordinate.

You can switch between the levels of the model using the

Z Vertical Axis (else Y) '
A Higher Level and WV Lower Level

icons. The current
Update Levels for All Entities level appears in the top caption of AutoCAD’s screen.

You can make whole structure visible by clicking at the
icon EP All Levels ON

Step #22. View and Save your model: Press the house icon to change the view to Isometric, and
type Z and E (Zoom, Extents).

Press the icon OE to display the 3D solid view of the model, replacing the wireframe view as
shown in the following figure:
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Save your model, using a different file name (Save As...). By saving your model with a different
name each time, it is easier to back up to a previous state of the model.

3.7.

Create bracing

Step #23. Place bracing members at the front:

Press the icon

and AutoCAD’s/BricsCAD’s commands faster.
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Levels Height Elevation | Visible
1 4000000 4000000 |[v
2 3.000000 7.000000 |
3 3.000000  10.000000 ||

© to switch back to wireframe view to be able to process CAD Modeler’s

=

Click at icon Levels —check the
visible property for level 1 and
uncheck it for all other levels and
press OK.



Make sure that “Level :1” appears at the top of CAD window, else use the

V LowerLevel ;.4 t6 move to Level 1.

A Higher Level and

Y,

Now only Level 1 is visible and it is easier to add the bracing members. Click on the icon Generate

and the Place Member form appears.

Select 60x60x5 as the cross section and
make sure that Material is set to Steel,
Releases to Fix-Fix and Beta angle is O.

Press the “Place Member(s)>>" button.

Click on the joint located at Point 1 of the
following image.

Click on joint located at Point 2 and the
first bracing member is created.

Click again on joint located at Point 2 and
then on the joint located at Point 3 and
the second bracing member is created

Cross Section

Table Section:
60x60x5 BSEQANGL European v

or Member Dimensions:
<Select Shape > v

or Same as Member:

<Select Existing Member > v
Material

Steel v
Releases Beta (o)

Fix-Fix v 0 v

Split Intersecting Members [ ]Physical Member

Split Ending Members

Place Member(s) >>

Click on the joint located at Point 4, click on the joint located at Point 5 and the third bracing

member is created.

Click again on the joint located at Point 5, click on the joint located at Point 6 and the fourth

bracing member is created.
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/1

Press ESC to terminate the Generate Beam command.

T Ch Memb
Step #24. Change the properties of the Bracing Members: Click on the icon ange Vlember

in the Find/Change/Check panel and when asked to Select objects: click on the 4 bracing
members created in a previous Step and press <ENTER>.

The Member Properties [Multiple Selection] form is displayed. Now, change the type to SPACE
TRUSS and press OK.
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Member Properties [Multiple Selection] X

Model  Section Properties  Member Loads Member Temperature Loads  Member Distrortions

M ks

My My

<Select Type = Szt Ez:
Start SPACE FRAME
¥d | | Yo
End :

d: | | o
Beta Angle :
Shape Code : I:I
End Sizes OR Member Eccentricities {Offsets)

Groups Start End
Material Properties

General Section Properties Releases & Elastic Connection spring values
Mame : I:I Section : | Select Section= Quick Selection : FixFix
Level : I:l Ax : | | Ix: | | Start End
Ay | | Iy: | | Fx Fx
Type - Incidences Az | | Iz: | | Fy Fy
Type:  |SPACETRUSS  ~ Sy I I By: I I Fe
| |
| |

I
U

Mz Mz

Physical Member

Inactive o Remove

Material : | <Select Material> e Sizes : I:I I:I
Groups that Member belongs

E: | |Density| | X I:I X I:I

o | | cre: | e [ T [ ]

assn | 2

4

Cancel Apply Help

This modification applies to all selected members.

Step #25. Copy bracing member to the back: Type COPY and when asked to Select
objects/entities: click on the 4 bracing members created in a previous Step and press <ENTER>.

In order to Enter base point: click on the Joint at Point 1 of the following image.
In order to Enter second point: click on the Joint at Point 2 inf the image on the next page.

Press ESC to terminate the COPY command.
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TEndoint |

Step #26. View and Save your model: Press the icon W to display the 3D solid view and then

C Colors

the icon and OK. The model looks like as shown in the following image:
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Save your model, using a different file name (Save As...).

Make the entire structure visible by clicking at the icon (P All Levels ON

A Fram

Click on the icon € to switch back to the wireframe view.

3.8. Create girders
A Higher Level

icon move to

Step #27. Split the beam members at the top level: Clicking on the
level 3. The current level is displayed at the top caption of AutoCAD/BricsCAD:

GTS CAD Modeler | M KN DEG CEN SEC | Level: 3

P 4

Click on the icon °P'it

then press <ENTER>.

and click on the members A and B as shown at the following image, and

In order to define the Distance for spliting the member or the number of parts (negative
number), enter -8, so that the beams A and B will be split into 8 equal parts.

Ve

Click again on the icon 5Pt and click on the members C and D as shown at the following
image, and then press <ENTER>.
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In order to define the Distance for spliting the member or the number of parts (negative
number), enter -4 , so that the beams C and D will be split into 4 equal parts.

Y

Step #28. Place girder members at the top level: Click on the icon Generate and Place Member
form appears.

Select IPE120 as the cross section and make

Cross Section sure that Material is set to Steel, Releases to
Table Section: Fix-Fix and Beta angle is 90.
IPE120 IPE European v

Press the “Place Member >>” button.
or Member Dimensions:

<Select Shape> v Click on the joint located at the point 1 of the
following image. Click on the joint at point 2
and the girder member is generated.

or Same as Member:

<Select Existing Member > v
_ Having the command still active, click on the
o— joints at points 3 and 4 and another girder
Steel v .
member is generated.

Mt e Continue by clicking on joints at points 5 and

Fix-Fix Y %0 v 6 and another girder member is generated.
[v] split Intersecting Members [ ]Physical Member Continue by clicking on joints at points 7 and
[ spit Ending Members 8 and another girder member is generated.

Place Member(s) >>
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Continue by clicking on joints at points 9 and 10 and another girder member is generated.
Continue by clicking on joints at points 11 and 12 and another girder member is generated.
Continue by clicking on joints at points 13 and 14 and another girder member is generated.

Make sure that the option “Split Intersecting Members” is ON, so that common joints will be
created along the previously created X-direction girders. Click on the joint located at point 15
and then click on joint at point 16 and the girder member is generated. Existing girders are split.

Repeat the procedure:

Click on the joint located at point 17 and then click on the joint at point 18 and the girder
member is generated. Existing girders are split.

Click on the joint located at point 19 and then click on the joint at point 20 and the girder
member is generated. Existing girders are split.

19 245

8
14

Press ESC to terminate the Generate Beam Command.
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P13
Step #29. Add eccentricities to the Girders: Press the icon 4 to display the 3D solid view and

then the icon Q s and OK. The model looks like:

Click on the Top Icon on AutoCAD’s View Cube or BricsCAD’s View Chair to switch to the top
view in order to be able to select girder members easily.

"T Change Member

Click on the icon and when asked to Select objects: click on the 2 Points of

the following image, to select all girder members, and press <ENTER>.
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The Member Properties [Multiple Selection] form is displayed so you may now specify member
eccentricities.

End Sizes OR Member Eccentricities (Offsets) Note: Some Edit Boxes appear in yellow
End background and green fonts, like
Eccentricities. You can use mixed units in the
yellow edit boxes. To understand this feature

enter 0.25 for the Z Starting Eccentricity and
] 25cm as the Z Ending Eccentricity.
1 £ Press OK.

Sizes :

i

~
~N

Now the deformable axis of the girder
members has been moved 0.25m up in the Z
direction.

Switch back to the isometric view by clicking on the House icon on AutoCAD’s Cube or
BricsCAD’s Top Front Left at view Chair to see the result. The girder members now sit on the
upper flange of the beam members.
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3.9. Create an opening
Step #30. Delete a joint to create an opening: Select the Joint Located in Point A of the image
above and press the DEL key.

Warning: All structural entities (members, elements, etc) connected to this Joint will also be
deleted? (Yes/No) appears and continue by pressing Y and <ENTER>.

The Joint is deleted together with all members connected to the joint.
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3.10. Create Supports
Step #31. Support the joints at the base of the model:

Make the entire structure visible by clicking at the icon P Al Levels ONand press Z and E (Zoom
Extents).

Switch to the FRONT View, by clicking on Front on AutoCAD’s cube or BricsCAD’s chair.

Click on the icon & Support and select the window by clicking at points 1 and 2 in the following

image. All the bottom joints are selected and press OK to finish the selection.
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1

Restraints & Spring values The Joint Properties [Multiple Selection] form
: appears.

Quick Selection : ’ Pin o

Restraint  Spring Restraint  Spring
' ' Select Pin using Quick Selection, and Fx, F

VIFx | | Owx | | 8 A Y

, . and Fz are automatically checked.
(VIFy | | [Cmy ’
[VIFz [CImz ’

Press OK.

All the bottom joints are now pinned and
have an orange color instead of green to
indicate that they are supported.

3.11. Check the model

Step #32. Check for duplicate joints: In order to check for joints having the same coordinates,

.. Joints Duplicates

click on the icon , under the “Check” Drop Button, located in Find/Change/Check

at Ribbon Area.
For the Merge Tolerance <0.001000>, just press <ENTER> to accept the default value.

The Merge Joints form appears where you can see the list of joints having the same coordinates.
Make sure that Merge option is checked for all pairs and press OK.
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Merge Joints

E Select Al
Joint Duplicate Merge
- - v
16 17 v

By entering the same command again, for the 2" time, you should get the notification that 0
duplicate joints found .

Step #33. Check for floating joints: In order to check for joints not connected to the model, click

.

on the icon «.- Joints Flostings , under the “Check” Drop Button, located in Find/Change/Check at
Ribbon Area. If your model was created as described so far, you should get a notification 0
floating joints found.

Note: You can also run all other checks of the same drop list, to check for Interference Joints,
Duplicate Members, Zero Length Members, Duplicate Names and Database Integrity. You should
not get any errors or warnings.

3.12. Define Groups

Step #34. Create Group Names: It is optional to define Groups in your model but it is strongly
recomended to do so since it will be easier to control the display and selection for parts of your
structure.

Click on the icon "t in the Groups panel and the Group dialog appears.

Groups
Group ropertes
D Name | Physical
1 c°|umns
2 Beams l_
3 Girders r [ o ]
4 [ o]

Press the Add Group button and enter Columns as Name of the group.
Press the Add Group button and enter Beams as Name of the group.

Press the Add Group button and enter Girders as Name of the group.
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Press the Add Group button and enter Bracing as Name of the group.
Press OK to close the form.
Step #35. Add Columns to their Group.

. . % Colors Categories
Click on the icon C

and make only profiles Sections Color Visible
HE320B  visible by |HE3208 161 v
unckecking all others. IPE330 191 [

IPE120 [

60x60x5 50 [
Press OK. —

f=i +Members
Select Group Click on the icon == in the Groups

panel and make sure that the Group Columns

G . .
e is selected as the active group.

Columns v

Select everything on the screen in a full
window and press the Enter key.

To verify that the group is applied correctly, Groups

you can double click on a column and in the Inactive | e Remove
Member Properties form, you will be able to Groups that Member belongs
see its Group definition.
Columns
Step #36. Add Beams to their Group:
% Col Categories
Click on the icon O Colors
and make only profiles Sections Color Visible
IPE330 visible by unckecking HE320B 161 [
all others. IPE330 191 _
IPE120 [
60x60x5 50 [

Press OK.

126




Select Group

Group

Beams

Step #37. Add Girders to their Group:

Click on the icon © Colors
and make only profiles
IPE120 visible by
unckecking all others.

Press OK.

Select Group

Group

Girders

=i +Members
Click on the icon *- and make

sure that the Group Beams is selected as the
active group.

Select everything on the screen in a full
window and press the Enter key.

Categories
Sections Color Visible
HE3208B 161 [
IPE330 191 []
IPE120 4
B0XE0X5 50 [
re=: s
Click on the icon *=— e and make
sure that the Group Girders is selected as
the active group.
v

Step #38. Add Bracing to their Group:

Click on the icon © Colors
and make only profiles
60x60x5 to be visible by
unckecking all others.

Press OK.

Select everything on the screen in a full
window and press the Enter key.

Categories
Sections Color Visible
HE320B 161 [
IPE330 191 [
IPE120 '
B0x60x5 50 v
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r .
Select Group Click on the icon - hlembers and make

sure that the Group Bracing is selected as the

Group .
active group.

Bracing v

Select everything on the screen in a full
window and press the Enter key.

3.13. Define Loads

Step #39. Define Self Weight: Click on the icon == SelfWeight 5n4 the Self Weight dialog
appears. Enter:

- SWas Name

- Self Weight as the Load Description

- Negative Z as the Global Axis for the direction of the load
- 1.0 as Factor

- Check Include finite elements

and press Create New to create the new loading and then OK to close the dialog.

Self Weight or Dead Loads ﬂ

Load Information

Name : sw v
e
T Self Weight
Create New Save [ Modify Delete

Loads applied parallel to this Global Axis

() Negative Y () Positive Y
(®) Negative Z () Positive Z
(C) Negative X () Positive X
Enth : 1 Indude Finite Elements
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—#] Load Cases

Step #40. Define Load Cases: Click on the icon and the Load dialog appears.

Enter:

- LLas Name
- Live Load as the Load Description
- Las Design variable

and press Create New.

Load Case

Load Case Information

Load ID (up to 8 chars) : E=gimiizs ]

| Live Load | Save [ Modify

Description :

Enter:

- PLas Name
- Point Load as the Load Description

and press Create New.

Load Case

Load Case Information

Load ID (up to 8 chars) : Design variable : e i Create New

Description : | Paint Load Save [ Modify
Load ID List: Deete

Press Exit to close the dialog.
Step #41. Apply Live Loads: Live Loads will be applied only to Beam Members, therefore click on

. » Col . . .
the icon C Colors . Select the 2" Tab in order to colorize members by their group and make
only the Group Beams visible and press OK.
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Sections | Groups

Categories
Groups Color Visible
Columns 161 [
Beams 191 v
Girders [
Bracing 50 I[.
UnGrouped data 7 v

Click on the icon

~te Member Using a full window, select all entities that appear on screen and

press <ENTER> to finish with the selection.

The Member Properties [Multiple Selection] form appears having the tab “Member Loads”
active.

Click on LL at the “Empty Load Cases” list box and then enter

Uniform as the Load Distribution
Force as Load Type

Z Global as Direction

-5asVl

Fractional as Location

0.0as L1

1.0asL2

Press Create New and the number 125 appears next to the $ symbol the Empty Load Cases list
box. This is a notification that 125 members are loaded in Load Case LL.
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Member Properties [Multiple Selection] X

Model Section Properties Member Loads  Member Temperature Loads Member Distrortions

Applied Load Cases Loading
Description | Live Load | Save [ Modify
Loads in this Load Case : a7 Delete
Load Distribution
() Concentrated Member Start
W
(® Uniform .
O Linear — L1
h L2
Empty Load Cases (O Triangular
LL & Live Load $[0
PL £ Point Load &[0
(o] Load Type and Direction Loading Magnitude Loading Location from Start
f
OMoment @2 @ Global va: Oabsolute 12
oK Cancel Apply Help

Press OK to close the dialog. Member Loads appear in red arrows. To clear the arrows select

& Clear 0 the GTS Display Ribbon Tab.

By double clicking on one beam and then selecting the Member Loads tab and clicking on LL at
the Applied Load Cases List Box, you will be able to view and edit the existing loading values of
the specific beam.

. . » Col . . . .
Click on the icon C = , select the 1 Tab in order to colorize members by their section and
then select everything to be visible and press OK.

Sections Groups

Categories
Sections Color Visible
HE3208 161 v
IPE330 191 v
IPE120 [v
60x60x5 50 v

F
Step #42. View Live Loads: Click at the icon A Frame to switch to the wireframe view.
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On the Menu Bar, click on GTS Display>Display>Member Loads and the Display Loads form
appears:

Display Loads n Select LL as the Load case and leave the other

display options at their default values.

Load Case
| LL $Live Load v|

Press Show and the loading arrows are
Display Loads Applied To displayed.

[ ] Joints Members [ ]Elements

Display Options Click on Clear when you are done and Close

to exit from the dialog.
Scale Factor Concentrated (pts)

Scale Factor Distributed (pts) :

Arrowhead Size (pts) : L

1

(5] ()
] L] =] =]

Font Size (pts) :

Clear Close
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o] to display the 3D solid view.

Click at the icon

Step #43. Apply Joint Load: A Joint load will be applied to the Joint located at Point A of the

following image.
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Zoom closer to the specific point using AutoCAD’s/BricsCAD’s zooming functions.

Click on the icon § Joint , click on the joint at A and press <ENTER> to finish with the selection.

The Joint Properties form appears having the tab “Joint Generalized Loads” active.

Click on PL in the “Empty Load Cases” list box and then enter -3 for Force Z as shown in the Joint
Properties form on the next page.

Press Create New, and the number 1 appears next to the $ symbol in the Load Cases list box.
This is a notification that 1 joint is loaded under the Load Case PL.
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Joint Properties

Maodel  Joint Generalized Loads

Applied Load Cases Loading
Load Case : Create New
Description : | Point Load Save [ Modify

Loads in this Load Case : b Delete

Applied Load Values
Force X : I:I Force ¥ : I:I Force 2
vomentx: || wementr: || wemezi| ]
Applied Displacement Values

Empty Load Cases
wanx: || menvs | ] meez: [ ]
potx: | | orevs | ] etz [ ]

LL ELive Load iﬁ

Cancel Apply Help

F
Step #44. View Joint Load: Click at the icon A Frame to switch to wireframe view.

On the Menu Bar, click on GTS Display>Jont Loads and the Display Loads form appears:
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Display Loads Select PL as the Load case and leave the
other display options at their default values.

Load Case
PL v

Press Show and the loading arrows are
Display Loads Applied To displayed.

Joints [ |Members [ |Elements

Display Options Click on Clear when you are done and Close
20 to exit from the dialog.
Scale Factor Concentrated (pts) ~
Scale Factor Distributed (pts) : - S __/_,--"/
Arrowhead Size (pts) : 10 ~ e
Font Size (pts) : 0 ) _ -~
Show Clear Close al

Click at the icon GE to display the 3D solid view.

Step #45. Define Area Load for Level 1: An area load equal to 1.0kN/m? along the vertical
direction will be applied to whole level. Switch to Level 1 by clicking on the icon W Lower Level

untill “Level 1” is displayed.

3 Area Load |

Click on the icon in the Loads panel of the ribbon.
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Area Load B Type:

Generate ‘ - AlLlasName
Name : e hdl - Area Load Level 1 as Description
e —— - 1.0as Lload Value
CreateNew || Save /Modfy | | Delete - Zas Global Direction
- 4.0 as Elevation (the elevation of
Load - Direction level 1)
Load Value : L0 - Two way as Distribution

Global Direction Perpendicular to the Loading Plane :
Ox Oy @z
" o.0508 | Press Display >> and the loaded areas that
: were automaticaly detected are displayed in
Elevation yellow solid hatch, as shown below.
Plane Perpendicular at :

Plane Tolerance :

(®) Value (coordinate) 40
() Joint

Distribution
(® Two way X

O One way Y

Custom X 0.0000 y 0.0000

Press Clear to remove the solid hatch pattern and then OK to store the area load AL1.
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Step #46. Define Area Load for Level 3: An area load equal to 1.0kN/m? along the vertical
direction will be applied only to the two middle openings. Switch to Level 3 by clicking on the

A Higher Level

Load Value :

Global Direction Perpendicular to the Loading Plane :

Ox Oy @z

Plane Tolerance : i

Elevation
Plane Perpendicular at :

(®) value (coordinate) 10.0000

() Joint

Distribution
(® Two way

() One way Y

Advanced Features

Define Outline Region >>

Exdude Area >> Reset

Ignore Members >> Reset

Display >> Clear oK

Cancel

icon untill “Level 3" is displayed.
. . Areaload . .
Click on the icon A in the Loads panel of the ribbon.
Area Load = Type:
Generate - AlL3as Name
Name : AL3 ¥ - Area Load Level 3 as Description
Description : o - 1.0 as Load Value
Create New Save [ Modify Delete - Z as Global Direction
- 10.0 as Elevation (the elevation of
Load - Direction level 3)
1.0000

Two way as Distribution

Press “Define Outline Region >>"” and you are
prompted to select the members that define
the outline region of the area load. Click on

the 6 members at the perimeter of the two
middle openings, as shown at the image

below.
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Press Display >> and the loaded area will be displayed in yellow solid hatch, as shown below.

Press Clear to remove the solid hatch pattern and then OK to store the area load AL3.
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8 Combinations

Step #47. Define Load Combinations: Click on the icon and the Load

Combination dialog appears. Enter:

- CB1asName

- Load Combination 1 for the Description of the Load Combination
- Click on SW, Enter 1.35 as the factor and press ADD>>

- Click on LL, Enter 1.5 as the factor and press ADD>>

- Click on PL, Enter 1.5 as the factor and press ADD>>

- Press Store

- Press Done to close the dialog.

MNew Form Load or Load Combination *
Load Information Type

Mame I:l Design variable : > (®) Load Combination

Description : | | (") Form Load

Combine

SW (Self Weight)

LL (Live Load)

PL (Point Load)

AL1 (Area Load Level 1)
AL3 (Area Load Level 3) ADD ==

CB1 {Load Combination 1) 'SW" 1.35000 'LL' 1.50000 'PL" 1.50000 Delets

Factor : Item

All Formed Loads or Combinations

CB1 (Load Combination 1) "5W" 1,35000 'LL' 1.50000 'PL' 1. 50000

Edit Delete

Daone
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3.14. GT STRUDL Input File
Step #48. Create GTI: Save your model as “Tutorial_Example_1.dwg” and click on the icon @

and the Create GT STRUDL Input file dialog appears. Keep the default GTI filename, check all
options except “Read Finite Element Results” as shown in the following image and press OK.

Create GT.STRUDL Input File

Export to GTI

Create GTI File : locumentation\Version20 19\Example0 1\ = =10 1y o e Hsl ]

(®) Export Whole Model (") Export Portion of the Model
(will be prompted for Selection)
Perform Stiffness Analysis
Append Other GTI Files/Macros
+
Up
Down
[ ] copy Commands from GTI Files/Macros (not CINPUT)
Create Commands to Read Results
Read Joint Displacements
Read Member Forces
Read Section Forces Kb of S e 10
Read Section Displacements R T — 10
[ |Read Finite Element Results
Read Code Check Results

Carce

Step #49. View/Edit GTI: Click on the icon ) E9it 6T

step will be opened by the system’s default text editor.

and the GTI file created in the previous
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Step #50. Execute GT STRUDL: Click on the icon . and the GTI file created in the previous
step will be sent to GT STRUDL main program that is waiting in the background.

Stiffness analysis is automaticaly performed and DBX result files are automaticaly created.

In order to demonstrate the use of the command that reads back design results, add the
following commands into GT STRUDL main window (note that the steel design Parameters are
incomplete)

PARAMETERS

CODE EC3 ALL MEMBERS

CHECK ALL MEMBERS AS BEAM

DBX BINARY 'Tutorial Example 1.25' REPLACE

WRITE REPLACE CODE 'Tutorial Example 1.25' MEMBERS EXISTING

The result of the CHECK ALL MEMBERS command shown above is that members 148 149
150 151 152 153 154 155 FAILED CODE CHECKS

In addition, you can enter GTMenu to view the model and the results as described in the
GTMenu User Guide. After selecting the View button and checking Z-Up, and then selecting
View 1, the structure is displayed in GTMenu as shown below.
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GTView ~  GTView X |

%
Step #51. Read Results from GT STRUDL: In CAD Modeler, click on the icon e and

the Read GT.STRUDL Results dialog appears. Check all options except “Read Finite Element
Results” as shown below and press OK.
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Read GT.5TRUDL Results *

Read DEX Results

GTI Directory : D:\Examples\GTSTRUDL \Exampled 1

Read Joint Displacements

Read Member Forces

Read Section Forces Mumber of Sections:
F.ead Section Displacements Mumber of Sections:

[ ]Read Finite Element Results

Type of element result ; <AlLL=

Surface <AlLL=
Read Code Check Results

GTI Commands

Correspanding GT STRUDL commands:

DBX BIMARY

WRITE REPLACE JOINT RESULTS JOIMTS EXISTIMG

WRITE REPLACE MEMEBER. RESULTS MEMBERS EXISTIMNG

WRITE REPLACE SECTION FORCES NS 10 AUTOMATIC MEMBERS EXISTING
WRITE REPLACE SECTION DISPLACEMENTS GLOBAL NS 10 MEMBERS EXISTIMG
WRITE REPLACE CODE MEMBERS EXISTING

Cancel

Note: You should get an information message “Results Loaded Successfully”

3.15. Display Results

7 Def
Step #52. Display Deformed Model: on the Menu Bar, click on |/ Deformed (ribbon tab “GTS

Display”) and then select SW as load Case and press ENTER twice. The deformed structure will
be drawn as shown below.
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Repeat and select PL as the Load Case and the deformed structure appears as shown in the

following image:
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N Annotate Di splacements |

Note: You can Annotate the Joint displacements by clicking on the © icon,
|/ Deformed

that is located under the in the ribbon and the selecting a joint and annotation

possition.

|} Undeformed

Click on (ribbon tab “GTS Display”) to return to the original undeformed position

of the model.

F
Step #53. Display Section Displacements: Click on the icon A Frame to switch back to the
wireframe view. Click on 7 7 Displacements (10 tab “GTS Display”).

Select:
- SWas Load Case
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Displacements - 0.1 as Scale Factor
- 10.00 as Font Size (default)

Load Case / Load Combination - Annotation Format: Exponential
SW § Self Weight v - Check Hide Model
Press “Display >>" and zoom at the upper left
Display Options end of the structure as shown in the image
below.

Scale Factor (Values) : -

Font Size (pt) : 10.00 Press “Annotate >” and click on any part of
the deformed shape curve and then at the
position that you want the annotation to be
displayed.

Annotation Format:  Exponential v

Decimal Places : 2 v

(V] Hide Model Press on “Legend >” and click at any part of
the screen to place the legend of the

diagram.
Display =>>

Annotate > Legend >

Animation Options
Frames :

Animation Speed % : 1 v
Generate Animation e
Frames s

Clear Close
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X:—2.92e—-07
Y:—5.66e—07
Z:=1.11e—-04
@:2.67e+00

X:2.46e—-00
Y:5.73e—06
Z:—2.08e—-03
@:1.67e-01

In order to display the animation press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

In order to exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.

w Diagrams

Step #54. Display Member Diagrams: Click on (ribbon tab “GTS Display”).
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Member Diagrams Select:
- SWasLoad Case

Load Case /Load Combination - MZ Moment as Value to be displayed
SW § Self Weight o - 0.1 asScale Factor
- 10.00 as Font Size (default)
[ ]Envelope
Press “Display >>" and zoom at the upper left
Values end of the structure as shown in the image
MZ Moment v below.
Press “Annotate >” and click on any part of
Display Options the yellow MZ Moment curve and then at the
Scale Factor (Values) 0.100 position that you want the annotation to be
displayed.
Font Size (pt) 000
Annotation Format: | Decmal v Press on “Legend >” and click at any part of
the screen to place the legend of the
Decimal Places : K s diagram.

[ |Label Max &Min [ _]Positive Sign

Display >>
Annotate > Legend >

Clear Close
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|/ |
! |
L H
/V\" »l“
& | MZ:2.44
, @:0.00
! L
N} ’ il k.a;
e Mz:—0.68
o @:72.92
MZ:0.81
MZ:—0.58 . - Moment M
@:0.77 L 18:9.00 T Load : SW
self Weight

MZ:—1.24 (
@:0.00
In order to exit the command, press the “Clear” Button and then the “Close” button.
& Code Check (ribbon tab “GTS Display”) and

Step #55. Display Code Check Results: Click on
select all mebers by typing ALL and pressing <Enter> twice.
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Code Check Results Select:
- Display Text: Actual/Allowable Stress

Display Text Ratios

- All Values

(_)None )
) - 4 as Font Size

(®) Actual/Allowable Stress Ratios

(_) Controlling Stress Code Provision Press “Display >>” and the following image is

drawn with the bracing members that failed

- Aenalonse T ates the check (149 to 155) appearing in red and
(_) Controling KL/r Code Provision members that passed the check appearing in
blue.
Vales In order to exit the command, click the
@al “Clear” Button and “Close”.
(") Greater Than 0.00
() Less Than 0.00
Display Options
Font Size (pt) 4
Display >>
Legend >
Clear Close
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3.16. Results Datasheets
Step #56. Except from the graphical display of results there is an option to view them in
datasheets from the item “Results Datasheets” of the menu/ribbon tab “GTS Display”.

Click on the icon B Displacements and the “GTSTRUDL — Joint Displacement Datasheet” dialog

appears where you can filter, sort, write results to text file or change results units as shown in
figure below.
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B ' GTSTRUDL - Joint Displacement Datasheet, display Units: Meters Degrees O x
File Edit Columns FEilter 5ort Units Help

Joint Load I Trans X | Trans ¥ ITrans 2 I Rotation X I Rotation ¥ | L]
1 SW 0.0aaa 0.0aaa 0.0000 —-0.000215% 0.0000245
2 SW O.0aa0a 0.0aaoa —0.0000 0.0004223 0.0000347
3 SW 0.0000 0.0000 0.0000 -0.0002020 0.0001%08
4 SW 0.0aaa 0.0aaa —0.00a0 0.0004311 —-0.0003151
5 SW O.0aa0a 0.0aaoa 00000 —-0.0001381 —-0.000150%
€ SW 0.0000 0.0000 —0.0000 0.0004323 0.0003413
7 SW 0.0aaa 0.0aaa 0.0000 —-0.0003753 —0.0003€70
=) SW O.0aa0a —0.a0aa —0.0000 0.0009405 0.0007478
] SW 0.0000 0.0000 0.0000 0.0001757 -0.0000570

1a SW —0.00a0 0.0aaa —0.00a0 —0.000444¢ —0.00004€€
11 SW O.0aa0a 0.0aaoa 00000 0.0001593¢ 0.0001102
1z SW =-0.0000 -0.0000 —0.0000 -0.0004358 -0.000400€
13 SW 0.0aaa 0.0aaa 0.0000 0.0001575 —-0.0002277
14 SW —0.00aa —0.a0aa —0.0000 —0.000433% 0.000z€08
15 SW 0.0000 0.0000 0.0000 0.0004€ls -0.0004304
1€ SW —0.00a0 —0.aaao —0.00a0 —-0.00085937 0.000&8344
13 SW —0.00aa —0.a0aa —0.0005 —-0.5755841 —-0.181€357
13 SW =-0.0000 -0.0000 -0.004€ -0.3254073 0.08358498
za SW —0.00a0 —0.aaao —-0.00585 —-0.05€5121 0.551&€254
z1 SW —0.00aa —0.a0aa —-0.0117 —0.0000572 0.78200€5
22 SW =-0.0000 -0.0000 -0.00385 0.0567753 0.5517€z20
z3 SW —0.00a0 —0.aaao —-0.004€ 0.3252377 0.084048¢€
z4 SW —0.00aa —0.a0aa —0.0005 0.5758475 —0.1t1458¢
g SW 0.0000 0.0000 0.0000 -0.0004527 -0.0005444
z7 SW 0.0aaa 0.0aaa —0.00a0 0.000z2704 0.0004355
za SW O.0aa0a 0.0aaoa 00000 —-0.0007150 0.0001€80
3 SW 0.0000 0.0000 —0.0000 0.0001e30 -0.000z2131
30 SW 0.0aaa 0.0aaa 0.0000 0.0003€13 0.0003782 L¥]
< >
B Reactions

Click on the icon and the “GTSTRUDL — Reactions Datasheet” dialog appears
where you can filter, sort, write results to text file or change results units as shown in figure
below.

B GTSTRUDL - Joint Reactions Datasheet, display Units: Meters KiloMewtons O X
File Edit Columns Filter Sert Units Help
Joint | Load | Force % | Force ¥ | Force z | Moment x | Home &
1 W 0. 24.790 -0.000
3 W a. 24.15% -0.000
5 SW a. 2z.738 -0.000
7 W -0 25.863 0000
k] SW a. 24.777 0.000
11 W 0. 24.261 0.000
13 W a. 23717 -0.000
15 SW -0. 25.7a8 0.000
26 W -0 24.309 0000
28 SW -0 26.112 0000
20 W 0. 27.442 -0.000
3z W -0.2 24.146 -0.000
34 SW -0. 25.245 —-0.000
26 W 0. 27.381 -0.000
1 LL a. 128.774 -0.000
k] LL 1 lz20.588 —-0.000
5 LL 0. 11€.237 -0.000
7 LL -0. 137.305 -0.000
] LL 0. 122.774 0.000
11 LL 1 120.58% -0.000
13 LL a 11&.237 0.000
15 LL -0. 137.303 0.000 &
< >
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Code Check nd the GT STRUDL Code Check Results”

Click on the icon Results Datasheets >
dialog appears

0 GT STRUDL Code Check Results - o IEH
File Edit Columns Filter Sort NotChecked Help
Member I B/F | Load I Section Loc I Crit Ratio I Crit Prov I Stress Ratio I Stress Prov | KL/r Ratio KL/xr Prov I Properti A
148 FAIL CBl1 7.211 3.33%5 KL/x 0.766 5.5.1 3.3%5 KL/x €0x60xS
149 FAIL CBl1 6.403 3.01s KL/x 0.981 5.5.1 3.01s KL/x €0x60x5
150 FAIL CBl1 6.403 3.01s KL/x 0.977 5.5.1 3.01s KL/x €0x60x5
151 FAIL CBl1 7.211 3.395 KL/x 0.751 5§.5.1 3.395 KL/x €0x60x5
152 FAIL CB1 7.211 3.395 KL/x 0.7¢€8 5.5.1 3.3%5 KL/x €0x60x5S
153 FAIL CBl1 €.403 3.01s5 KL/x 0.992 5.5.1 3.015 KL/x 60x60x5
154 FAIL CBl1 €.403 3.01s8 RL/x 0.973 5.5.1 3.015 KL/ €0x€0x5
155 FAIL CBl1 7.211 3.335 KL/x 0.755 5.5.1 3.395 KL/x €0x60x5
1 Pass CBl1 4.000 0.293 KL/x 0.102 5.7.7 0.293 KL/ HE320B
2 Pass CBl1 4.000 0.293 KL/x 0.102 5.7.7 0.293 KL/x HE320B
3 Pass CBl1 4.000 0.293 KL/x 0.102 5.%F.7 0.293 KL/x HE320B
4 Pass CB1 4.000 0.293 KL/x 0.134 5.5.4(2) 0.293 KL/x HE320B
5 Pass CB1 4.000 0.293 KL/x 0.102 5.7.7 0.293 KL/x HE320B
€ Pass CBl1 4.000 0.293 KL/x 0.102 5.7.7 0.293 RL/x HE320B
7 Pass CB1 4.000 0.2393 KL/ 0.102 5.7.7 0.293 KL/ HE320B
8 Pass CBl1 4.000 0.293 KL/x 0.134 5.5.4(2) 0.293 KL/x HE320B
9 Pass CBl1 0.000 0.93%9 KL/x 0.391 5.5.4(2) 0.939 KL/x IPE330
10 Pass CB1 0.000 0.782 KL/x 0.243 5.5.4(2) 0.782 KL/x IPE330
11 Pass CB1 €.000 0.939 KL/x 0.433 5.5.4(2) 0.939 KL/x IPE330
12 Pass CB1 0.000 0.939 KL/x 0.391 5.5.4(2) 0.939 KL/x IPE330
13 Pass CB1 0.000 0.782 KL/ 0.243 5.5.4(2) 0.782 KL/ IPE330
14 Pass CB1 €.000 0.333 KL/x 0.439% 5.5.4(2) 0.933% RL/x IPE330
15 Pass CBl1 0.000 0.782 KL/x 0.205 5.5.2 0.782 KL/x IPE330
1é Pass CBl1 0.000 0.782 KL/x 0.205 5.5.2 0.782 KL/x IPE330
17 Pass CBl1 5.000 0.208 5.5.2 0.208 §.5.2 0.000 bodtag ot d o) IPE330
18 Pass CBl1 5.000 0.188 §.5.2 0.188 5.5.2 0.000 WA b IPE330
13 Pass CB1 0.000 0.249 5.5.3 0.249 §.5.3 0.000 b IPE330
20 Pass CB1 0.871 0.127 5.0, 0.127 5.7.7 0.000 bodedodedotedodod IPE330
21 Pass CBl1 0.871 0.127 5.7.% 0.127 §5.7.7 0.000 SDNRAN RN IPE330
22 Pass CBl1 0.871 0.127 5.7.7 0.127 5.7.7 0.000 SessensS IPE330
23 Pass CBl1 0.871 0.127 5.7.7 0.127 5.7.7 0.000 chakaludabudaty] IPE330
24 Pass CBl1 0.871 0.127 5.7.% 0.127 5.7.7 0.000 bt dob,] IPE330
25 Pass CBl1 0.871 0.127 5.7.7 0.127 5.7.7 0.000 hibdeddedd IPE330
26é Pass CBl1 0.871 0.249 5.5.3 0.249 §.5.3 0.000 RS ESERbN IPE330
27 Pass CBl1 4.000 0.293 KL/x 0.102 5.7.7 0.293 KL/x HE32Z0B
28 Pass CB1 4.000 0.293 KL/ 0.102 5.7.7 0.293 KL/ HE320B
29 Pass CB1 4.000 0.2393 KL/x 0.135 5.5.4(2) 0.293 KL/x HE320B
30 Pass CBl1 4.000 0.293 KL/x 0.102 5.7.7 0.293 KL/ HE320B
31 Pass CBl1 4.000 0.293 KL/x 0.102 5.7.7 0.293 KL/x HE320B L
< >

3.17. Report Builder

Report
Step #57. Click on the icon Builder to generate the report of this structure by calling Report

Builder. Report Builder is launched in a separate window. You can find more information on how
creating your report in the GT STRUDL® Report Builder Getting Started Guide (Help Icon on the
right top corner on Report Builders’ window).
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Style - @

» B RE=

Image Text RTF
File Overall Report File

File Insert

=[] GTSTRUDL Reports
[ Contents

[l Member/Element Constants
[] Element Incidences

L] Element Properties

[] Element Loads

£ [] Analysis Results

[]Joint Displacements

[ Support Joint Reactions
] Member Forces

[] Section Forces

] Average Element Resuits
] Member Results Graphs
[] Design of Steel Members

L {4 | JointName: AL Loading: ALL 0
U o
~" || Member Name: ALL Levek AL |
| Insert Remove || Print  Print - r Apply Filtersto | Format || Help
| Preview Element Name | ALL Surface: |ALL + | Checked Items | Options |
|Header and Footer | Print Filters _Format || Help
Load Data
Summary of Loadings
Length: M, Force: KN, Angle: DEG, Temperature: DEGC , Time: SEC
Name Description
SW Self Weight
I Live Load
PL oint Load
ALl AreaLoad Level |
ALS AreaLoad Level 3
CB1 Load Combi 1
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4.  Tutorial Example #2

4.1. Introduction
The modeling and analysis of the tank shown below is demonstrated in a step-by-step process
using CAD Modeler and GT STRUDL finite element analysis.
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4.2. Open CAD Modeler and start working
Step #1. Launch GT STRUDL by selecting the icon “CAD Modeler” in the Welcome to GT STRUDL
dialog shown below. The version of AutoCAD/BricsCAD selected during the installation will be
automatically launched, together with CAD Modeler’s menus and ribbon bar.

Welcome to GT STRUDL

B  Open Learn more about GT STRUDL

(&) Hide Details

7]

Help

= Options

Command Mode

Leam the STRUDL design
:

and design.

modes for stuctural 2nalys

Base Plate Wizard
Analyze & o

complex
tes

< - 8 [7] =

CADWorx®
Analysis Sc

>
«dl HEXAGON
What is GT STRUDL?

Introduction to GT STRUDL 8¢

Start a New Project

7

A

i

<> —

GT Menu

CAD Modeler

Command Mode

o= | L

Model Wizard

Base Plate Wizard

Working Directory

Recent

D:\GTQA\Testing\2020-04-27_UTC-03-22-51\GTS 2020 Shel\MO069_gti

G

View an informative webinar on the new licensing
system presented on January 28, 2020 by clicking

here.

Now Available: GT STRUDL 2018 Demo
A limited version of the product that can be used as an
introduction to the mast frequently used features

Webinars

CAD-Based Modeling for Structural Engineers
February 20, 2020

Modern Lean Project Execution: Beyond
Connecting Design to — Uniting
Structural and Piping Recorded Date: August 13.
2019

On-Demand Webinar: GT STRUDL Webinar:

Model Your Way_ with GT STRUDL Recorded
Date: December 13, 2018

On-Demand Webinar: GT STRUDL Webinar: Lean
Structural Workflow with Intergraph Smart 30
Recorded Date- October 182018

~

4.3.

Define the basic geometry of the model

X Units

Step #2. Define the correct Units by pressing the icon
KiloNewtons in the Units Form.

and select Meters (m) an

Units
Length

() Inches (in)
() Feet (ft)

(m)
() Centimeters (cm)

(i Millimeters (mm)

Temperature
() Fahrenheit

(®) Centigrade

Farce

() Poundz (Ibs)
l:::l Kips

l:::l Tons

() ¥ilograms
() Metric Tons
l:::l Mewtons

(®) KiloMewtons

() MegaMewtons

Scale non-structural CAD entities
(grids, structural lines, curves etc)

Angles
(®) Degrees
() Radians

() Cydes

Time
(®) Seconds
Cl Minutes

{_JHours

Cancel
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Step #3. Create an AutoCAD/BricsCAD Polyline that will describe the outline of the tank. Type
the following commands at the command prompt (each command is followed by an <ENTER>):

PLINE
0,0,0
@10,0
ARC
Q4,4
@-4,4
LINE
@-10,0
CLOSE

The polyline shown in the picture below is created after entering Zoom and Extents at the
command prompt.

Step #4. Create a Line along the height of the tank: Switch to the isometric view of the structure
by pressing the small house icon in AutoCAD’s Cube or BricsCAD’s Chair.
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@ _ Type the following commands at the command prompt
N (each command is followed by an <ENTER>):

TP | < E

LINE
0,0,0
@0,0,4
wCs <ENTER>
v
a N The line shown at the picture below is created.
v ‘ R
vl | | |
@ - Click on the TOP icon of the AutoCAD’s Cube / BricsCAD’s
- Chair in order to switch back to floor plan view.
Top Front Left

4.4. Create the bottom of the tank
Step #5. Generate the Finite Elements inside the polyline, at the bottom of the Tank: Click on

2D Area
the icon % , under the “2D” Drop Button, located in Meshing at Ribbon Area, and
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when the prompt message Poly Select Boundary Polyline or Circle appears, click on the Polyline
that you have created in the previous step.

The Select Mesh Properties form appears
where you have to enter:

Generate
- Material : Concrete
Material | Concrete s - Type: SBHT6, meaning triangular
F— elements having 6 degrees of
freedom per node
Type (SBHT6 v Thickness | 0-20 - Thickness: 0.20
E— - Boundary Maximum Element Edge

Size: 0.50

Bdsma Borncary - Mesh Quality: High

External Boundary Edge Size | ©-000000

Maximum Element Edge Size You can press the Preview button to see the
finite elements as they will be generated.

Minimum Element Edge Size 0.000000

Mesh Quality | High v
Press the Create button to create the finite

Internal Boundaries Internal Joints elements and joints on the bottom of the
tank.

Add + Remove -

Multi+ | Multi - Add @ Remove

Spacing Extrude Direction
Uniform 4
Variable [:]
Defined by Curve, Size: 3.242418
[] sweep Function

Labeling
More >>

Preview Clear Create Close
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Step #6. Turn OFF labeling and view mesh:

SStic Latecte Click on the icon @ Options in the ribbon bar and
[ Joints | then uncheck the Visible Labels option for Joints,
Members and 2D Elements.
[ IMembers |
Now labeling is turned off and it is easier and faster to
[]2D Elements | control the model.
3D Elements |

The finite element mesh, without labeling, is shown in the image below.

N /

/
[L‘X . /

4.5. Create the walls of the tank
Step #7. Generate the finite elements that will model the Wall of the Tank by extruding the

. . L . . ..—T 3D Extrude
polyline: Switch to Isometric view and click on the icon e , under the “2D” Drop

Button, located in Meshing at Ribbon Area (Note: the display of joints and elements previously
created is automatically turned off to make selection of the polyline and extrude line easier).
When the prompt message Select Line, Arc, Circle or PolyLine to be Extruded appears, click on
the Polyline that you have created in a previous step, as shown in the following picture (Click
#1).
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When the prompt message Select Extrude Direction Curve (Line or Arc)appears, click on the line

that you have created in a previous step, as shown in the picture below (Click #2).
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Generate

Material Concrete N

Element Attributes

Type SBHQ6  “ Thickness | ©-20

Mesh Geometry

External Boundary

External Boundary Edge Size
Maximum Element Edge Size
Minimum Element Edge Size

Mesh Quality Very Low

Internal Boundaries Internal Joints

Add + Remove -

Multi+ | Multi - Add Remove
Spacing Extrude Direction
®uriorm

(O variable I:]

Defined by Curve, Size:
[] sweep Function

Labeling

More >>

Preview Clear Create Close

The Select Mesh Properties form appears
where you have to enter:

Material : Concrete

Type: SBHQ6, meaning quad
elements having 6 degrees of
freedom per node

Thickness: 0.2

Maximum Element Edge Size: 0.5
(Note: This must be the same as
when the mesh in the bottom of the
tank was created so the mesh will be
the same along the polyline)

Spacing Extrude Direction: Uniform
and select 8 spaces in the pulldown

You can press the Preview button to see the
finite elements as they will be generated.

Press the Create button to generate the
finite elements and joints on the wall of the

tank

The finite element mesh is presented in the
following image.
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Step #8. Check for duplicate joints: Since both meshing functions described above generated
joints along the polyline, pairs of joints having the same coordinates exist in the model and they
have to be merged together. In order to check for joints having the same coordinates, click on

Dn Joints Duplicates

the icon , under the “Check” Drop Button, located in Find/Change/Check at

Ribbon Area.
For the Merge Tolerance <0.001000>, just press <ENTER> to accept the default value.

The Duplicate Joints form appears where you can see the list of joints having the same
coordinates. Make sure that Merge option is checked for all joint pairs and press OK.
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Merge Joints

List Select Al ‘
Joint Duplicate Merge £
1 281 v Uneclect M _ |
1 363 v
2 2% v Loox ]
3 283 v
4 284 2 Cancel |
5 285 v
6 286 v
7 287 v
8 288 v
9 289 v
10 290 v
1 291 v
12 292 2
13 203 v
14 294 v
15 295 2
16 29 v
17 207 v
18 298 v
19 299 v
20 300 v
21 301 v
2 302 v
23 303 v
24 304 v
25 305 v
26 306 [v y
=l

By entering the same command again for the 2™ time, you should get the notification that 0
duplicate joints found .

Step #9. Switch to 3D View: Press the house icon (AutoCAD cube) or Top Front Left (BricsCAD
chair) to change the view to Isometric, and type Z and E (Zoom, Extents). Click on the icon

@} Options to set a different color for 2D finite elements. When the Display Options form
appears, click on the white button next to “2D Element”, to define a different color. Using this
form you can also define Object Sizes in the current length units.
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e Select Color Select Color » IEEN

Index Color Index Color

N EOEEEET [ oo | b
....D 1 . - . 254 D ByBlock
. ByLayer
o EEE
Cance bep Index 254

RGB: (214,214,214)
OK Cancel

Select Color (AutoCAD) Select Color (BricsCAD)

Press OK to close the Color Options Dialog. The elements will now have the color that you

selected.

Press the icon o (and then type Shade) to display the 3D solid view of the model, replacing
the wireframe view:
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Display Options

Visible Objects Visible Labels

Joints - [ J0ints _|
[viMeshers | Divembers ]
2D Elements - [ 2D Elements _I

30 Elements ] 3D Elements ]
Label Settings - Font Sizes Object Sizes

Joleaks = Joint :

Members : Load Arrowhead (pts):

Denes: 05000

3D Elements : ﬂ] Display Members / Elements

Annotation (pts) : ShrinkFactor: |10 v

Annotation Format: (1o Not Display Thickness in 30

Decimal Places : 2 V| Membersas: | Analytical v
Scale Factors

Concentrated Load (pts) :

Distributed Load (pts) : ———
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A Fram

and AutoCAD’s/BricsCAD’s commands faster.

Press the icon © to switch back to wireframe view to be able to process CAD Modeler’s

Step #10. Save your Model: In order to save your model, use AutoCAD’s/BricsCAD’s save
command and store the DWG using any filename that you want.

4.6. Create Supports
Step #11. Support the joints at the base of the model:

Switch to the FRONT View, by clicking on Front on AutoCAD’s cube or BricsCAD’s chair.

Click on the icon ® Support and select the window by clicking at points 1 and 2 in the following

image. All the bottom joints are selected and press ENTER to finish the selection.
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Restraints & Spring values

Quick Selection : Pin

Restraint Spring Restraint  Spring
Fx [ IMx

Fy [Imy

Fz [ Imz

The Joint Properties [Multiple Selection] form
appears.

Using the Quick Selection, select Pin and note
that Fx, Fy and Fz are automatically checked.

Press OK.

Press the Isometric (Top Front Left) icon to
change the view to Isometric, and type Z and
E (Zoom, Extents).

All the bottom joints are now pinned and have an orange color instead of green to indicate that

they are supported.
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4.7. Check the model
Step #12. Check for duplicate joints: In order to check for joints having the same coordinates,

Dn Joints Duplicates

click on the icon , under the “Check” Drop Button, located in Find/Change/Check

at Ribbon Area.

For the Merge Tolerance <0.001000>, just press <ENTER> to accept the default value.

You should get the notification that 0 duplicate joints found .

Step #13. Check for floating joints: In order to check for joints not connected to the model, click

on the icon 'E» Joints Flosting: , under the “Check” Drop Button, located in Find/Change/Check at
Ribbon Area. If your model was created as described so far, you should get a notification that 0
floating joints found.

Note: You can also run all other checks of the same drop list, to check for Interference Joints,
Duplicate Shells, Duplicate Names and Database Integrity. You should not get any errors or
warnings.

Step #14. View Planar Axes for Finite Elements: In order to check the direction of the planar axes

[t7 Shell Planar Axes
of the Finite elements, click on the icon = in the “GTS Display” Ribbon area
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and then Enter Legend Coordinates(x,y,z): or click at the point where you want the legend to be
displayed.

In the legend, the X axis is displayed in cyan, Y axis in red and Z axis in yellow (AutoCAD) or
orange (BricsCAD). The size of the arrow and its arrowhead is controlled by the value given in
Display Options > Object Sizes > Load Arrowhead and the size of the legend font is controlled by
the value given in Display Options > Label Settings — Font Sizes > Annotation (pts) (shown in
2.6.66).

IBUTETUBUDE Y

i
el 11T
BN N e I e

4
T NI NI NI WNTWTNT

AXAXAAA

/

XIS

To clear the arrows select <& Clear from the GTS Display Ribbon Tab.

4.8. Define Groups
Step #15. Create Group Names: It is optional to define Groups in your model but it is strongly
recomended to do so since it will be easier to control the display and selection for parts of your
structure.

| —

.—
”*—

In the Groups panel of GTS CAD Modeler ribbon, click on the icon List and the Group dialog
appears.
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Groups

Group Properties Add Group

D Name | Physical
1 Bottom I_

wa |

Press the Add Group button and enter Bot tom as Name of the group.
Press the Add Group button and enter Wal1l as Name of the group.

Press OK to close the form.

Step #16. Add the elements in the bottom of the tank to the Group Bottom:

Switch to the FRONT View, by clicking on Front on AutoCAD’s cube or BricsCAD’s chair.

Select Group H Click on the icon iCJ; +Shells in the Group
- panel and make sure that the Group Bottom
is selected as the active group.
Bottom vl EI

Make a selection by clicking at the points 1
and 2 of the following image and press the
Enter key.

2

All the shell elements located in the bottom of the tank are now selected and added to group
“Bottom”.

Step #17. Add the elements in the tank wall to the Group Wall.
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P AT
Select Group Click on the icon :J;_i,- +Shells and make sure
that the Group Wall is selected as the active
Group
group.
wall v

Make a selection by clicking at the points 1
and 2 of the following image and press the
Enter key.

All shell elements located in the wall of the  Groups
tank are now selected and added to group
“Wall”.

Inactive Remove

Groups that Element belongs
[wall

To verify that the group is applied correctly,

you can double click on a element in the wall

and in the Shell Properties form, you will be

able to see its Group definition in the Shell
Properties form.

Press the house icon to change the view to Isometric, and type Z and E (Zoom, Extents).

Click at the icon to display the 3D solid view as shown in the following image and save your
model.
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49. Define Loads

Step #18. Define Self Weight: Click on the icon == Seff Weight 5nq the Self Weight dialog
appears. Enter:

- SWas Name

- Self Weight as the Load Description

- Negative Z as the Global Axis for the direction of the load
- 1.0 as Factor

- Check Include finite elements

and press OK to create the new loading and close the dialog.
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Self Weight or Dead Loads “

Load Information

Name : sw v
—
Dencriplion : Self Weight
Create New Save [ Modify Delete

Loads applied parallel to this Global Axis

() Negative Y () Positive Y
(®) Negative Z () Positive Z
() Negative X () Positive X
Factor: |- Include Finite Elements

Step #19. Define Load Cases: Click on the icon 3] Load Cases

and the Load dialog appears.
Enter:

- LLas Name
- Live Load as the Load Description
- L as Design Variable

and press Create New.

Load Case >

Load Case Information

Load ID (up to 8 chars) : E=omneia8 ]

[Live Load | | save /Modify

Description @

Enter:

- PLas Name
- Pressure Load as the Load Description

and press Create New.
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Load Case X

Load Case Information

Load ID (up to 8 chars) : Design variable : v

Desaiption : l Pressure Load Save [ Modify
Load ID List — Delete

Press Exit to close the dialog.

Step #20. Apply Live Loads: Live Loads will be applied only to the bottom of the tank, therefore
» Col . . .

click on the icon © Colors . Select the 2" Tab in order to colorize elements by their group and

make only the Group Bottom visible and press OK.

Sections | Groups

Categories
Groups Color Visible
Bottom 161 a4 |
Wall 191 [
UnGrouped data l_

Click on the icon B Shell in the Loads Panel. Using a full window, select all entities that appear
on screen and press <ENTER> to finish with the selection.

The Element Properties [Multiple Selection] form appears having the tab “Element Loads”
active.

Click on LL at the “Empty Load Cases” list box and then enter:

- Surface as the Force Type

- Zas Direction

- Global as System

- Uniform as Load Distribution
- -40asvl

Press Create New and the number 476 appears next to the $ symbol the Empty Load Cases list
box. This is a notification that 476 elements are loaded in Load Case LL.
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Element Properties [Multiple Selection]

Model | Element Loads

Applied Load Cases Loading
Load Case : e Create New
Description : Live Load Save [ Modify
v Delete

Loads in this Load Case :

Force Type Direction System Load Distribution Values (B or S)
(") Body Ox O Local (® Uniform vi: -40
) (O Planar v2:
(®) Surface Oy B
) ®) Global (O variable v3:
@) Edge @z O Projected v
Empty Load Cases
PL $[0]

Press OK to close the dialog.

By double clicking on one element and then selecting the Element Loads tab and clicking on LL
at the Applied Load Cases List Box, you will be able to view and edit the existing loading values
of the specific shell.

<X Clear . .
To clear the arrows select from the GTS Display Ribbon Tab.

Step #21. Apply Pressure Load: Pressure Load will be applied only to elements in the Group

. . » Col . .
Wall, therefore click on the icon C olors . Select the 2" Tab in order to colorize elements by
their group and make only the Group Wall visible and press OK.

Sections | Groups

Categories
Groups Color Visible
Bottom 161 [
Wall 191 I
UnGrouped data l_

Click on the icon B Shel in the Loads Panel. Using a full window, select all entities that appear
on screen and press <ENTER> to finish with the selection.
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The Shell Properties [Multiple Selection] form appears having the tab “Element Loads” active.
Click on PL at the “Empty Load Cases” list box and then enter:

- Surface as the Force Type

- Zas Direction

- Local as System

- Uniform as Load Distribution
- 5asvl

Press Create New and the number 656 appears next to the $ symbol the Empty Load Cases list
box. This is a notification that 656 elements are loaded in Load Case PL.

Element Properties [Multiple Selection] =]
Model = Element Loads
Applied Load Cases Loading

Load Case : i Create New
Description : Pressure Load

Loads in this Load Case : N

Force Type Direction System Load Distribution Values (B or 5)

() Body Ox (® Local (®) Uniform vi: B

7 (O Planar v2:
(®) Surface Oy )

i (O Global () Variable v3:

(O Edge ®z () Projected 4

Empty Load Cases

LL §[476

OK Cancel App Help
Press OK to close the dialog.

To clear the arrows select @ Clear from the GTS Display Ribbon Tab.

C Colors

Click on the icon . Select the 2" Tab and make everything visible.

#8 Combinations

Step #22. Define a Load Combination: Click on the icon and the Load

Combination dialog appears. Enter:

- (CB1asName

- Load Combination 1 for the Description of the Load Combination
- Click on SW, Enter 1.3 as the factor and press ADD>>

- Click on LL, Enter 1.5 as the factor and press ADD>>
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- Click on PL, Enter 1.1 as the factor and press ADD>>
- Press Store
- Press Done to close the dialog.

Mew Form Load or Load Combination *
Load Information Type
CE1 ’ ) LY L
Mame : Design variable : (®) Load Combination
T | Load Combination 1 | (") Form Load
Combine
SW (Self Weight) Sy 1,30000

LL (Live Load LL 1.50000
PL 1.10000

Delete
Factor : Item

STORE |

All Formed Loads or Combinations

Edit Delete

Done

4.10. Create GT STRUDL Input File

Step #23. Create GTI: Click on the icon Mand the Create GT STRUDL Input file dialog appears.
Keep the default GTI filename, check the options “Perform Stiffness Analysis”, “Read Joint

Displacements” and “Read Finite Element Results” as shown in the following image and press
OK.
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Create GT.STRUDL Input File El

Export to GTI
Create GTI File Jocumentation\Version20 19\Example02\Example025tep22.GTI
(®) Export Whole Model () Export Portion of the Model
(will be prompted for Selection)
Perform Stiffness Analysis

Append Other GTI Files/Macros

T
Up
Down
[ ] copy Commands from GTI Files/Macros (not CINPUT)
Create Commands to Read Results
Read Joint Displacements
[ ]rRead Member Forces
[_]Read Section Forces Number of Sections: 10
[_|Read Section Displacements Mt o Se e 10
Read Finite Element Results
[ ]rRead Code Check Results

B Edit GTI

Step #24. View/Edit GTI: Click on the icon and the GTI file created in the previous

step will be opened by the system’s default text editor.

Step #25. Execute GT STRUDL: Click on the icon .and the GTI file created in the previous
step will be sent to GT STRUDL main program that is waiting in the background.

Stiffness analysis is automaticaly performed and DBX result files are automaticaly created.

In addition, you can enter GTMENU to view the solid model and the results as described in the
GTMENU User Guide. You can also click on Results > Finite Element Results > Contour Sresses,
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Strains, Displacement and display MXX Bending Resultants for load case PL as shown in the
figures on the next page:

e
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Step #26. Read Results from GT STRUDL: Click on the icon % Read Resuits and the Read

GT.STRUDL Results dialog appears. Check the options “Read Joint Displacements” and “Read
Finite Element Results” as shown below and press OK.
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Read GT.STRUDL Results E3
Read DBX Results

GTI Directory : F:\00.STRUDL Europe

Read Joint Displacements

[ Jread Member Forces

[ |Read Section Forces Number of Sections: -

["]Read Section Displacements Number of Sections: 10

Read Finite Element Results

Type of element result : <ALL> v

Surface : <ALL> o

[ ]rRead Code Check Results

GTI Commands

Corresponding GT STRUDL commands:

DBX BINARY A
WRITE REPLACE JOINT RESULTS JOINTS EXISTING

WRITE REPLACE AVERAGE ELEMENT STRESSES TOP MIDDLE BOTOM ELEMENTS EXIS
WRITE REPLACE AVERAGE ELEMENT STRAINS TOP MIDDLE BOTOM ELEMENTS EXIST
WRITE REPLACE AVERAGE RESULTANTS TOP MIDDLE BOTOM ELEMENTS EXISTING
WRITE REPLACE AVERAGE ELEMENT PRINCIPAL STRESSES TOP MIDDLE BOTOM ELE!
WRITE REPLACE AVERAGE ELEMENT PRINCIPAL STRAINS TOP MIDDLE BOTOM ELEM
WRITE REPLACE AVERAGE PRINCIPAL MEMBRANE RESULTANTS TOP MIDDLE BOTOWM ,

ok || concd

If you get the following error message at the command prompt:

ERROR Loading Results: The following DBX files cannot be found:
STDBX34 - Strains

STDBX37 - Principal Strains

This message informs you that no Strain results are available to be loaded. You can ignore this
message, since the elements used (SBHQ6) do not give strains as output results.

4.11. Display Results

.‘.; f
Step #27. Show Displacements: On the Menu Bar, click on |/ Deformed (ribbon tab “GTS

Display”) and then select PL as the load Case and press ENTER twice. The deformed structure
will be drawn as shown below.
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“I| Annotate Di splacements |

icon,

Note: You can Annotate the Joint displacements by clicking on the

. / Def d . . . - .
that is located under the l 9% i the ribbon and the selecting a joint and annotation
possition.

i Undef d . . - -
Click on |i Undeforme (ribbon tab “GTS Display”) to return to the original undeformed position
of the model.

Another alternative is to click on 77 Displacements (ribbon tab “GTS Display”).
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Displacements

Load Case [ Load Combination

PL § Pressure load v

Display Options

Scale Factor (Values) : 0.100

Font Size (pt) : .

Annotation Format: | Exponential v

Decimal Places : 2

Hide Model

Display >>

Annotate > Legend >

Animation Options

Frames :

Animation Speed % : 10 v

Generate Animation
Frames

nimate
A ae

Clear Close

v

Select:
- PLas Load Case
- 0.1 as Scale Factor
- 10.00 as Font Size (default)
- Annotation Format: Exponential
- Check Hide Model

Press “Display >>" to view the deformed
shape.

Press “Annotate >” and click on any part of
the deformed shape curve and then at the
position that you want the annotation to be
displayed.

Press on “Legend >” and click at any part of

the screen to place the legend of the
diagram.
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Displacements M
Load : PL
Pressure Load

In order to display the animation press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

In order to exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.

Step #28. Show Finite Element Results: Click on i Elements

Element Results Form appears.

(ribbon tab “GTS Display”) and the
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Select:

Element Results - PLasload Case
- Resultants as the Type of element
Load Case result
T — > - Mxx as the Moment Resultant to
display
Type - Middle as position (Resultants are
only available for the middle surface
Resultants ¥ of a 2D finite element)
Mxx v and press “Display >>"
Middie ¥ You can also press the “Annotate >” button
. . and select joints to display the corresponding
Display Options values.
Scale Factor (Values) 0.100
Font Size (pt) 10.00
Annotation Format: | Decdmal N
Decimal Places : 2 v
Display >>
Annotate > Legend >
Animation Options
Frames : 7
Animation Speed % : 10 ™
Generate Animation .
Frames -
Clear Close

The multi-colored contour image of the structure is displayed and each color corresponds to a
range of Mxx values as shown in the Legend Form. Type Shade to view the contours in shaded
mode as shown on the next page.

NOTE: Hardware graphics accelaration may cause AutoCAD to incorrectly display the colors of
the contour. In such a case it is recomemded that you turn OFF Hardware Accelartion, during
displaying the stress contours, by typing the command GRAPHICSCONFIG. You can turn it
back ON afterwards.
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A Graphics Performance

Hardware Setup
Video Card: NVIDIA GeForce GTX 660M

Driver Version: 9.18.13.697 Virtual Device: gdi13.hdi(Software)

Effects Settings

Hardware Acceleration Cm

Disable hardware acceleration only if you are experiencing
graphics issues or have an incompatible video card.

-26.30... 2365
-2365...-21.00
21.00... 1834
18.34... 1589
1569 13.04
13.04...10.39
10.39...7.73
7.73..5.08
508...-243
243..023
0.23..288
288..553

I 553019

IIIII :

In order to display the animation press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

’

To exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.
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4.12. Results Datasheets
Step #29. In addition to the graphical display of results there is an option to view them in
datasheets from the item “Results Datasheets” of the menu/ribbon tab “GTS Display”.

Click on the icon Bl Displacements and the “GTSTRUDL — Joint Displacement Datasheet” dialog

appears where you can filter, sort, write results to text file or change results units as shown in

figure below;

B GTSTRUDL - Jeint Displacement Datasheet, display Units: Meters Degrees [m| *
File Edit Columns Filter Sort  Units Help
Joint Load Trans X | Trans ¥ Trans 2 Rotation X Rotation ¥ | ~
1 5W 0_0oo0a a_ooaa a_oaaa —-0_0000138
2 SW 0.0000 0.0000 Q.0000 Qoals
3 sW 0.o000 00000 0.0000 000E3
4 SW 0.0000 0.0000 Q.0000 Q00ED
5 sW 0.o000 00000 0.0000 00074
€ SW 0.0000 0.0000 Q.0000 aolos
7 sW 0.o000 00000 0.0000 ao0o7s
a2 SW 0.0000 0.0000 Q.0000 00541 Qo082
sW 0.o000 0.0000 0.0000 00203 00440
1a SW 0.0000 0.0000 Q.0000 oo47e ooLsz
11 SW 0.0000 0.0000 0.0000 004zg anzss
1z 5W 0_0oo0a a_ooaa a_oaaa 0103393 ao310
13 SW 0.0000 0.0000 Q.0000 00511
14 sW 0.o000 00000 0.0000 00470
15 SW 0.0000 0.0000 Q.0000 00420
1€ sW 0.o000 00000 0.0000 00207
17 SW 0.0000 0.0000 Q.0000 00394 aoole
13 sW 0.o000 00000 0.0000 00175 aoL73
13 SW 0.0000 0.0000 Q.0000 oolzs Q00Es
20 SW 0.0000 0.0000 0.0000 003z1 aooso0
21 SW 0.0000 0.0000 Q.0000 00101 ] 4
2z SW 0.0000 0.0000 0.0000 00Z€8 000E5
23 W 0.0000 0.0000 0.0000 00194 00088
24 SW 0.0000 0.0000 0.0000 00LlE4 00071
25 SW 0.0000 0.0000 0.0000 00193 00075
2¢ SW 0.0000 0.0000 0.0000 0013z 00058
27 SW 0.0000 0.0000 0.0000 EE] 000Ez
23 SW 0.0000 0.0000 0.0000 000072 v
€ >

Click on the icon B Stresses

and the “GTSTRUDL — Average Stresses Datasheet” dialog appears
where you can filter, sort, write results to text file or change results units as shown in figure

below.
B GT STRUDL - Average Stresses Datasheet, display Units: KiloMewtons Meters Degrees O X
File Edit Columns Filter 5ot Units  Help
Sorted on: Mok sorted  Filter: None
Joint Load Surface | 5300 SYY SHY VonMises £
1 SW Top -75.30 1.757 43
1 SW Middle -€8_864 -0.187 37.
1 SW Bottom -58_427 -2.131 31
1 LL Top 1€.373 13
1 LL Middle 0.225 a
1 LL Bottom 9.€53 -15.528 13
1 PL Top -32_817 -13.717 23
1 PL Middle -35_€€0 3.729 22
1 PL Bottom -46_403 21.175 33
2 SW Top -41_13% -3.870 22
2 SW Middle -3€.815 -3.170 13
2 SW Bottom -32.431 -2.470 17.
2 LL Top -40.508 -8.212 24,
2 LL Middle —-0.434 1.038 1.
2 LL Bottom 40.03% l0.z88 z4.
2 FL Top - -11.837 -30.1%58 35
2 PL Middle -Z2.172 -8.818 0.775 4
2 PL Bottom -30.731 -5.338 31.748 35
3 SW Top -41.443 -2.248 23,
3 SW Middle -26_€09 -2.432 15.733 v
£ >
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4.13. Report Builder

Report

Step #57. Click on the icon Builder to generate the report of this structure by calling Report
Builder. Report Builder is launched in a separate window. You can find more information on how
creating your report in the GT STRUDL® Report Builder Getting Started Guide (Help Icon on the
right top corner on Report Builders’ window).

() oEa - oEER
Home style ~ @
.’\- @ B . @ D D 9 £, JointName: ALL Loading: ALL v &% @
= "= Member Name: AL Levek AL =
Open  Generate Image Text RIF Insert Remove Print Print Apply Filtersto | Format | Help
File Overall Report File review Element Name |ALL Surface: ALL Checked ltems || Options
File Insert Header and Footer Print Filters Format Help
- [7] GTSTRUDL Reports ~
[[] Contents Load Data
= [¥] Model Data
[] Groups
[]Joint Coordinates Element Loads
[] Joint Support Restraints
[ Member Incidences § . -
[ Member Properti Length: M, Force: KN, Angle: DEG, Temperature: DEGC , Time: SEC
[[]Member/Element Constants
Element Incidences
[V] Element Properties Element Loads (Body Force)
£ [ Load Data
Summary of Loadings Element | Load Case | Coordinate System | Distribution | Joint BX BY BZ |
[ Loading Combinations W OBAL UNIFORM * | 0.000et 000e+ 56e-01 |
: W OBAL UNIFORM * | 0.000e 000e+ e
[] ot Losds W OBAl UNIFORM | 0000 et et
[ Member Loads v OBAI UNIFORM * | 0.000e+0 e~ e
[T Element Loads | W OBA UNIFORM * | 0.000et e el
- [¥] Analysis Results W OBA UNIFORM * | 0.000ex 000e+ 35601 |
[] Joint Displacements 7 W OBAI UNIFORM * | 0.000e 000e e
[] Support Joint Reactions s W OBA UNIEORM * | 0.000e e el
0] Member Forces 9 3 OBA UNIFORM * | 0.000ex e e
) W OBAI UNIEORM * | 0.000e e e
[J Section Forces : ~
:- .
[Stresses W OBAI UNIFORM * | 0.000e .000e0 e+l
[[] Stresses Envelope v OBAI UNIFORM * | 0.000e+0 .000e+0 e
[] Stresses Summary W OBA UNIEORM * | 0.000e 000e+{ e
[ Resultants W OBA UNIFORM * | 0.000ex 000+ e
] Resultants Envelope W OBA UNIFORM * | 0.000et 000e+ e
] Resultants Summary W OBA UNIFORM * | 0.000e 000e~ el
Princial St 3 OBA UNIFORM * | 0.000e 000e+ e
[ Principal Stresses W OBAl ONIFORM | 0.000e-00 | 0,000 e
[ FiRcl Shemas Kamioe SW OBA UNIFORM | 0.000+00 | 0.000e=C et
[] Principal Stresses Summary W OBAL UNIFORM * | 0.000e+0 .000e+ e
[] Principal Membrane Resultants W OBA UNIFORM * | 0.000ex 000e~ e
[] Principal Membrane Resultants Er v OBA UNIFORM * | 0.000e 00060 e
[] Principal Membrane Resultants St W OBA UNIEORM * | 0.000e 000e e
] Principal Bending Resultants SW OBA UNIFORM * | 0.000ex 000+ e
8 By Kertens Fos ; i e B W) e S
[JPrincipal Bending Resistants Sum W OBAI UNIFORM * | 0.000e 00060 et
Von Miss W OBA UNIFORM * | 0.000e+¢ 000e=0 e
[] Von Mises Envelope SW OBAI UNIFORM * | 0.000ex .000e+0 e+
[[] Von Mises Summary W OBAI UNIFORM * | 0.000e .000e+0 e
[ Member Resuits Graphs W OBA UNIFORM * | 0.000e 00060 e
L] Design of Steel Members W OBAI UNIFORM * | 0.000e 000+ et
W OBA UNIEORM * | 0.000e 000e={ e
SW OBA UNIFORM * | 0.000ex 000+ e
7 W OBA UNIFORM * | 0.000e= 00060 e
W OBA UNIFORM * | 0.000e 000e~ e
W OBAL UNIFORM * | 0.000e 000+ e
‘ 5 W OBAI UNIEORM * | 0.000e 000e+{ el v
Ready AP NUM| SCRL| ;
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5.

5.1.

5.2.

Welcome to GT STRUDL

-]
(7}

Tutorial Example #3

Introduction

The modeling of a frame structure using CAD Modeler shown below is demonstrated in a step-
by-step process.

Open CAD Modeler and start working
Step #1. Launch GT STRUDL by selecting the icon “CAD Modeler” in the Welcome to GT STRUDL
dialog shown below. The version of AutoCAD/BricsCAD selected during the installation will be
automatically launched, together with CAD Modeler’s menus and ribbons.

Open

Help

Options

Learn more about GT STRUDL

() Hide Details

GT Menu CAD Modeler

Perform structural analysis &  Create complex structural Leam the STRUDL design

design using 2 graphical user  geometnies Using AUoCAD & language to creste computer

i BACSCAD. modes for stuctural analysic
and design.

Command Mode

Model Wizard

Quickly model simple
suctures using tempiates.

Base Plate Wizard
Anzlyze & design complex
suuctural stee! base plates
using = finite element anatysi
approach.

Start a New Project

<f> —

M e

GT Menu CAD Modeler Command Mode

FA|P
[\ fiva

Model Wizard

Base Plate Wizard

Working Directory

D:\GTQA\Testing\2020-04-27_UTC-03-22-51\GTS 2020 Shel\MOO069_gti

Recent

G

< ? a8 (2] a

~

CADWorx®
Analysis S¢

_{d FI;IPEXAGON

What is GT STRUDL?

Introduction to GT STRUDL %8
View an informative webinar on the new licensing
system presented on January 28, 2020 by clicking

here

Now Available: GT STRUDL 2018 Demo

A limited version of the product that can be used as an
introduction to the most frequently used features.

Webinars

CAD-Based Modeling for Structural Engineers
February 20, 2020

Modern Lean Project Execution Beyond
Connecting Design ta — Uniting
Structural and Piping Recorded Date- August 13
2019

On-Demand Webinar GT STRUDL Webinar:

Model Your Way with GT STRUDL Recorded
Date: December 13 2018

On-Demand Webinar: GT STRUDL Webinar: Lean

Structural Workflow with Intergraph Smart 30
Recorded Date: October 18. 2018 it
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Step #2. Make sure that CAD Modeler’s ribbons and menus are visible.

o B A 2o [T /| L (B W

Mesbers pels | oundaton |Frnd/Change/Check

ekl N
otors  Nfshel L e S nowten

@1l >
]
»

If AutoCAD’s/BricsCAD’s menu is not visible, type MENUBAR at AutoCAD’s/BricsCAD’s
command prompt, then 1 and press <ENTER>.

If AutoCAD’s/BricsCAD’s ribbon area is not visible, type RIBBON and press <ENTER>.

Ribbon commands will be used in this tutorial example. However, since all ribbon commands
appear in the menu area, you can use the menu bar as well.

5.3. Define the basic geometry of the model

Step #3. Define the correct Units by pressing the icon X Units and select Feet (m) and Kips in
the Units Form.

Units >
Length Force Angles
(i Inches {in) () Pounds (lbs) (®) Degrees
(®) Feet (ft) (®) Kips () Radians
() Meters {m) ) Tons () Cydes
() Centimeters (cm) () Kilograms
(i Millimeters {mm) () Metric Tons Time
Temperature O Mewtons @ Seconds
() Fahrenheit () KiloMewtons () Minutes
(®) Centigrade () MegaMewtons {_JHours
Scale non-structural CAD entities i .
(grids, structural lines, curves etc) Cancel

=

Step #4. Define the one level of the model by pressing the icon L€vels  press the Add Level
button one time to add a level to your model. Modify the height of the 1% level by selecting the
Height cell of the 1°* Level and entering 15.

Note: Some Edit Boxes appear in yellow background and green fonts, like the one at the Level
Heights. You can use mixed units in the yellow edit boxes. For more information about Mixed
Units and the valid syntax please read GT STRUDL GT Menu Guide

Make sure that Z Vertical Axis option is checked and press OK to close the form.
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Level Properties >
Level Heights Options
Levels Height Elevation | Visible | Addlevel |
1 15.000000 | 15.000000 |[v*
| Delete Level |
| Detect Levels Automaticaly |
| Merge Levels |

Base Elevation 0.0000

[] 2 vertical Axiz (elze ¥)

[Jupdate Levels for All Entities

ok | | cancel

Step #5. Enter a Grid that will help you enter the columns quickly by clicking on the icon 6rid
The grid is going to have 2 (20.4167 ft) spaces in the horizontal direction (X) and 1 space (18 ft)
in the sidelong direction (Y). Enter 20£t-51in in the Distance text box and press the Add button
2 times. The program will automatically convert the distance of 20ft -5in to 20.4167 ft.

Grid

Flacement

(®) Horizontal

3pacing

() sidelong

20,4167
20,4187

Distance: | 204167

Then, click on Sidelong in the Placement
area to enter the spacing in the Y direction,
and enter 18 and Add.

By pressing OK you are prompted (command
prompt) to enter the Insert Point for the
grid. Type 0, 0, 0 and press <ENTER>.

The grid is created, having its upper left corner A-1 at the point 0,0,0.
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D (] [3

You will be able to view the grid by pressing the Top Icon -

in AutoCAD’s Cube or BricsCAD’s Chair, or preferably by : ’

typing Z (for Zoom), E (for Extents) and press TOP - " N

<ENTER>. By o v
Top

Note: In order to be able to snap at the intersection of the grid lines, while placing columns,
make sure that the AutoCAD’s/BricsCAD’s Object Snap is ON, and the Intersection mode is
enabled. Type OSNAP for AutoCAD or right click on “ESNAP” setting for BricsCAD to set the
various snap settings. Shown below is the ObjectSnap tab in AutoCAD’s and BricsCAD’s Drafting
settings dialog.

Object Snap On (F3) [ ] Object Snap Tracking On (F11) Endpoint
Object Snap modes S
Center
O Endpoint 0y []insertion Select Al Node
A [ Midpoint b [ ]Pemendicular Clear All T [ R—
Intersection
O [ Center T [ Tangent Insertion
Perpendicular
5 []Node X []Nearest Tangent
> [[]Quadrant & [ ]Apparent intersection Resoest
Geometric center
X Intersection 27 [ ] Parallel Apparent intersection
) Extension
- D Exension Parallel
‘ |‘) To track from an Osnap point, pause over the point while in a On
% command. Atracking vector appears when you move the cursor. off
To stop tracking, pause over the point again. & Settings...
ESNA " |
AutoCAD’s Snap Setting BricsCAD’s Snap Settings
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Step #6. Click at Top Front Right of the View Cube (AutoCAD) or Chair (BricsCAD) to change the
view of the model.

Top Front Right
AutoCAD’s View Cube for Isometric View BricsCAD’s View Cube for Isometric View
Sections )

Enter the cross-section profiles that will be used at the model by pressing the icon
Click on the AISC 14th Edition 2011 list and then on the W-AISC14 table of profiles. Select the
profile W12x50 that will be used for the columns, by double clicking on it.

B " Profile Browser *
MW A15C 15th Edition 2015 A W-AISC15
S ATSC 15$ Ej!h.'m 2018 'TEtr":l o o |[wisxs7 W14x132 W12x106 W10x33 W5x19
-EJ AISC 15th Edition Spedal Tables for A1085 2 |y 16, e W14x120 W12x96 W 10x30 Wi5x16
: -E] AISC 15th Edition Special Metric Tables for A W15x45 Widk109 W12%ET W10x26 W13
=--E] AISC 14th Edition 2011 W1Bx40 W14x99 W12x79 W10x22
----- T w-a1sc14 W1sx36 W14x90 W12x72 W1Dx19
..... T m/sHP14 W1Ex31 W14x82 W12x65 W10x17
..... [ rReCHSS 14 W1x26 W1dx74 W12x53 W10x15
..... C c-aiscis W14x873 W14x63 \W12x53 W1i0x12
..... T wrascie W14x308 W1dx51 W12x50 Wax67
W14x730 W14x53 W12x45 WEx58
""" WLEQ-14 W14x665 W14x4a W12x40 WEx4s
----- o L-UN-14 W14x605 W1dx43 W12x35 Wax40
----- v~ L-ALL-14 YW 14x550 W1dx33 W12x30 WEx35
..... ar 2-£Q-14 W14x500 W14x34 W12x26 Wax31
..... e 2 40-14 W14x455 W14x30 W12x22 WEx28
_____ —— Widx426 W14x26 W12x19 Wax24
..... e oAl 1e W1dx398 Widx22 W12x16 Wax21
W14x370 W12x335 W1x14 Wax18
""" O RDHS514 W1dx342 W12x305 W10x112 Wax15
----- I weEAM-14 Widx311 W12x273 W10x100 W8x13
----- T wcoL-14 W14x283 W12x252 W10x88 Wax10
-] AISC 14th Edition Metric W14x257 W12%230 W10x77 WEx25
-] AISC 13th Edition 2005 W14x233 W12x210 W10xEs WEx20
L . W14x211 W12x190 W10x50 WEx15
gg iizg ;3_25;‘;22”1:225 Metric W14x193 W12170 W10x54 W16
- W14x176 W12x152 W10x49 Wex12
#-E] AISC LRFD 3rd Edition W14x159 W12x135 W10x45 WEXS
EJ'"Q AISC 9th Edition Metric v || W1dx145 W12%120 W10x39 WEXE.5
£ > € >
Cancel
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Member Sections The profile is added to the project and it appears in the left list-

— AISC 16th Ediion 2016 box having a black dot in front of it.
= AISC 15th Editian 2016 Me
= AISC 15th Edition Special Using the same procedure, add 2 additional profiles: W10x45,
= AISC 15th Edition Special | .

=& AISC 14th Edition 2011 for beams and WT6x15 for the bracing from the table

I whaiscid WTAISC14. Press OK to close the form.
® W12450

* /10k45
T WS;HP; Note: You can add additional profiles at any time by following

L RECHSS 14 this procedure and also view the full list of profiles used in your
C CaIsCl4 o _
T wialscis model and add more profiles if needed (left image).
® WTEKIS
~ LEQ-14
~ LUN-14
~ LaLL14
- 2LEQ-14
e 214
- 2L5L14
e 2LALL14
O RDHSS13
I WEEAM-14
T wooL14
< AISC 14th Edition Metric

5.4. Create Columns

[

Step #7. Start entering the columns by clicking on the icon Vertical  The dialog Place Member
appears that helps you to quickly select properties for the members that are going to be
entered.

Cross Section Select W12x50 as the cross section for the
Table Section: columns. Make sure that Material is set to
MNP WASCIIAEC 1SN 011 Steel, Releases to Fix-Fix and the Beta angle is
or Member Dimensions: 90. There is no need to close this dialog
<Select Shape > o manua”y.

or Same as Member:
Press the “Place Member(s) >>” button.

<Select Existing Member > v
—_ Click at the intersection point between line A
aterial
- . and line 1 (point A-1) and the column will be
placed at this position.
Releases Beta (o)
Repeat the same procedure by clicking at the
Fix-Fix v S0 v X
points B-1, C-1, A-2, B-2 and C-2.
When you are done, press ESC to exit the
Vertical column command. The Place
Place Member(s) >> Member form is automatically hidden.
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Note: Each time you create a member, the orientation of the cross section will appear in the
middle of the element, unless you clear it with command “Clear” (see 2.6.86).

Step #8. As you can see in the isometric view below, column members 1 to 6 were created
together with joints 1 to 12 at their ends. Each column is 15 ft long, as defined in Level

Properties (height of the first floor).

7
8 1 .
=1
A
4 i
10 5 g

Q\
" >

¥
A

n
M

[53]
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5.5. Create beams and girders

Y,

Step #9. Start entering the beams, along X axis, by clicking on the icon Generate  The Place

Member form appears.

Cross Section

Table Section:

W12x50 W-AISC14 AISC 14th Edition 2011

or Member Dimensions:

<Select Shape >

or Same as Member:

<Select Existing Member >

Material

Steel

Releases Beta (o)
Fix-Fix v S0

Split Intersecting Members
Split Ending Members

Place Member(s) >>

Physical Member

Select W12x50 as the cross section and
make sure that Material is set to Steel,
Releases to Fix-Fix and the Beta angle is
90. You have to set the Beta angle equal
to 90 degrees in order to orientate the
local Y axis of the W12x50 cross section
along the Z global axis. Make sure that
the option Split Intersecting Members is
checked and then uncheck Split Ending
Members. Moreover, check the
“Physical Member” option, so that you
also define the physical member and not
only the analytical members.

Press “Place Member(s) >>” button.

Starting Point (x,y,z) message appears,
asking you to enter the coordinates or
click on a specific point on screen. Click
on Joint 2 at the top joint of column 1 at
position A-1.

Then you have to define the Ending Point (x,y,z) so click on Joint 6, as shown in the picture

below.
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Members 7 and 8 will be created.

The two beams along X axis were generated with only two clicks of the mouse: at Joints 2 and 6.
The beam from Joint 2 to Joint 6, was split into two parts, between Joints 2, 4 and 6, since Joints
4 (column at positions B-1) intersect this member.

Since the command is still active, you are prompted to enter the Starting Point (x,y,z), repeat the
same procedure by clicking on Joint 8 (top of column at position A-2), and then click at Joint 12
(top of column at position C-2). Members 9 and 10 will be created.
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Step #10. Enter the beams, along Y axis. The command Generate Beams should be still active,

.

else you can call it again by clicking again on the icon Generate | Keep the same settings at the
Place Member Form, as in the previous step, regarding the cross section and Beta angle, but do
NOT click on Split Intersecting Members. Press the “Place Member(s) >>" button.

The prompt message Starting Point (x,y,z) appears, asking you to enter the coordinates or click
on a specific point on screen. Click on the Joint 8, that is the top of column at position A-2. In
order to define the Ending Point (x,y,z), click at Joint 2 (top of column at position A-1). Member
11 is generated.

Repeat the same procedure by clicking on the Joints 10 and 4 to generate Member 12, Joints 12
and 6 to generate Member 13. Then, press ESC to terminate the command.
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Step #11. Hide Grid: Since the Grid is no longer needed it can be hidden using
AutoCAD/BricsCAD commands to freeze the layer GRID_LAYER. This can be done by clicking on
the Home Tab and then selecting the GRID_LAYER from the drop down list of layers and clicking

on its freeze icon.

GTS CAD Modeler
. File Edit View Insert Settings Tools Draw Dimension Modify Parametric Window Help GTSModeling GTS Display

I CRERP2I @D a4 hmomallo £ /4 % of % BY |prattng
"_“ Home Insert Annotate % %l@ . 0 Collaborate GTS Modeling GTSL
R Units g A Higher Level O Gener, U %& . Defpoints _IQuad gg . Find =

<]

GRID_CIRCLES
H W Lower Level i Atle L . - Triangle B Change ~
‘| B Materials levels  Grid u Soil

7 all Levels ON B Suppofis I Reverse Springs % Check -

oSy [ cro_LeTrERs

m Jr

Mode! ) Levels Shels Foundation | Find/Change /Check

201



/

Step #12. Split horizontal members: Click on the icon Pt and click on the members 7,8,9

and 10, and then press <ENTER>.

11

In order to define the Distance for spliting the member or the number of parts (negative
number), enter -5, so that the beams will be split into 5 equal parts.

287
’ %2%8 3 .
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Step #13. Turn OFF labeling:

Visible Labels Click on the icon (€ Options in the ribbon
bar and then uncheck the Visible Labels
[ 30ints | . .
option for Joints and Members.
[ IMembers 4| Now labeling is turned off and it is easier
2D Elements | and faster to view and control the model.
3D Elements |

&) Clear

Press the icon
member:

to remove the informative cross section shapes in the middle of each
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5.6. Create girders

Y

Step #14. Place girder members along Y axis: Click on the icon Generate and Place Member form
appears.

Cross Section Select W10x45 W-AISC14 14th
Table Section: Edition 2011 as the cross section
W10x45 W-AISC14 AISC 14th Edition 2011 v | ... and make sure that Material is set

to Steel, Releases to Pin-Pin and
Beta angle is 90. Uncheck Split
Intersecting Members, Uncheck
ar Same as Member- Split Ending Members and Check
Physical Member

or Member Dimensions:

<Select Shape > v

<Select Existing Member > v

Press the “Place Member >>"
Material button.
Steel v

Click on the Joint located at the
Beta (o) point 1 of the following image.

Releases
Click on the joint at point 2 and
Pin-Pin v % v the girder member is generated.
[ split Intersecting Members [] Physical Member Having the command still active,

click on the Joints at points 3 and 4
and another girder member is
Place Member(s) >> generated.

[ | split Ending Members
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Continue by clicking on Joints at points 5 and 6 and another girder member is generated.

Continue by clicking on Joints at points 7 and 8 and another girder member is generated.

Press ESC to terminate the Generate Beam Command.
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Press the icon & Clear to remove the informative cross section shapes in the middle of each
member.

Step #15. Switch between analytical and physical view.

Turn ON labeling:

e Click on the icon @ Options in the ribbon
[ Joints bar and then check the Visible Labels
option for Members and press OK
[v] Members
—J The labels of all members are visible now.
2D Elements
3D Elements |

Press the icon = Anebtical/Physical |5 ated in Display at Ribbon Area to switch from Analytical to
Physical View as displayed in the picture bellow.

7

Analytical View Physical View

Physical Members, with the prefix PM, were generated while placing the analytical member,
since the “Physical Member” option was checked. By double clicking on a Physical Member, in
example PM1, you are able to see its properties, including the set of analytical members that
define it. In example for PM1 the set is: 7,14,15,16,17,8,18,19,20,21 as created by placing the
beam, and splitting it afterwards.
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Model  Section Properties

Physical Member Properties

Member Loads

General
Mame :
Level
Type - Incidences
Type : SPACE FRAME
Start 2
End : s
peta e
Physical Member | FM1
Groups
Inactive Remove
Analytical Members
7 ~
14
15
16
17 w

Section Properties

Section :  W12x50 W-AISC14 AISC 14tk

i | 0.101389 | - |8.24653e-005 |
ay | 0.03134?2| Iy | D.DDZ?ISDB|
. | 0.0478815 | - | 0.018856 |
Sy | D.DDBD439?| - | D|
- | 0.0371528 | s | 0 |
vd s | 1.0166?| ves | 0.508333|
74 | 0.6?3333| - | D.33666?|
Shape Cod :

Material Properties
Material : | Steel

LY

c. | 4,176e+006 | Density|

0.489543 |

G | 1.58399e+006| j— |

1,17-005 |

Poisson

Releases & Elastic Connection spring values

Quick Selection : ~
Start  Spring End  Spring

Oex | o] Oex | 0]
Oy | o Oy | o]
O | o O | o]
Clmx | o] Owx | |
Oy | =" o]
Oz | o] Owe | 0]

End Sizes OR Member Eccentricities (Offsets)

Start End
Sizes : | g | | . |
K | © | K | & |
A | 0 | ¥ | 0 |
2z | o] ;. | |

concel | [ il

Step #16. Copy Physical Members

Having the physical member view ON the last 4 physical members created will be copied. If the
COPY command is performed on physical members then the physical member is copied with its
set of analytical members. If the COPY command is performed on analytical members, then only

the analytical members are copied, without the physical member definition.

Type AutoCAD/BricsCAD COPY command and when asked to Select objects/entites: click on the
members PM6, PM7, PM8 and PM9. You will get a notification about the selected entities and

press <ENTER>.

In order to Enter base point: click on Point A of the following image.

In order to Enter second point: click on Point B of the following image.
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Press ESC to exit from copy command. Another four girders, as physical members PM10, PM11,
PM12 and PM13, are generated.

R
g
7 1o T
™. f
.y
o 5
5
3

Switch back to analytical view by pressing the icon = “nebticalPhysical g tyrn OFF member
labeling (as explained in Step #13).

Press the icon & Clear to remove the informative cross section shapes in the middle of each

member.
Step #17. Place bracing members.
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Set ESNAP to Midpoint and not Intersection: Right-click at ESNAP at the bottom of the screen

and deselect “Intersection” and select “Midpoint” option.

w

Endpoint
Midpoint

Center

Mode

CQuadrant
Intersection
Insertion
Perpendicular
Tangent

Mearest
Geometric center
Apparent intersection
Extension

Parallel

On
Off

Settings...

7

~  Endpoint

~ Midpoint

"  Center
Mode
CQuadrant

Intersection

Insertion
Perpendicular
Tangent

Mearest

Geometric center
Apparent intersection
Extension

Parallel

On
Off

Settings...

Click on the icon Generate and Place Member form appears.
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Cross Section Select W16x15 WTAISC14 14th
Table Section: Edition 2011 as the cross section

WT6x15 WTAISC14 AISC 14th Editon 2011 v | | ... and make sure that Material is set
to Steel, Releases to Pin-Pin and

or Member Dimensions: Beta angle is 0.

<Select Shape > v
Make sure that the option “Split

or Same as Member: Intersecting Members” is ON, so

<Select Existing Member > v that common joints will be created
along the previously created Y-
Material direction girders. Uncheck Physical
Steel W[ oo Member option.
Releases Beta (o) Press the “Place Member >>
button.
Pin-Pin v 0 v
Click on the Joint located at the
[¢] Split Intersecting Members [ ]Physical Member point 1 of the following image.

Click on point 3, that will snap to

split Ending Members
Vs - the middle of the member, and the

Place Member(s) >> bracing member is generated.

Having the command still active, click on the Joints at points 2 and 3 and another member is
generated.

Continue by clicking on Joint at point 4 and midpoint 6 and another member is generated.
Continue by clicking on Joints at points 5 and 6 and another member is generated.
Continue by clicking on Joint at point 7 and midpoint 8 and another member is generated.
Continue by clicking on Joints at points 4 and 8 and another member is generated.
Continue by clicking on Joint at point 9 and midpoint 10 and another member is generated.

Continue by clicking on Joints at points 5 and 10 and another member is generated.
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Press ESC to terminate the Generate Beam Command and click on the icon

10

the informative cross section shapes in the middle of each member.

Step #18. Split Girders

7

211
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&) Clear
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Click on the icon SPIit  3nd click on the members marked as A, B and C, and then press

<ENTER>. In order to define the Distance for spliting the member or the number of parts
(negative number), enter 5, so that the beams will be split at location 5 ft (current length units)
from the start of the members.

Note: Spit command can be used in two different ways. If you enter a negative value (eg. -5), the
member is spit into equal parts (eg. 5 equal parts). The value (absolute part) that you entered is
used to set the number of equal parts. If you enter a positive value (eg 5), then the member is
always spit at two parts, at the point that is 5ft (current length uints) from the start of the
member. The value that you entered is used to set the distance from start.
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Select member marked in D and delete it, by pressing DEL key and then and click on the icon

&) Clear

to remove the informative cross section shapes in the middle of each member.

Step #19. Add additional members along X

Y

Click on the icon Generate and Place Member form appears.
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Cross Section
Table Section:
W 10x45 W-AISC14 AISC 14th Edition 2011

or Member Dimensions:

<Select Shape >

or Same as Member:

<Select Existing Member >

Material

Steel

Releases Beta (o)
Pin-Pin v S0

Split Intersecting Members
Split Ending Members

Place Member(s) >>

Physical Member

214

Select W10x45 W-AISC14 14th Edition
2011 as the cross section and make sure
that Material is set to Steel, Releases to
Pin-Pin and Beta angle is 90.

Make sure that the option “Split
Intersecting Members” is ON, so that
common joints will be created along the
previously created Y-direction girders.
Check Physical Member option.

Press the “Place Member >>" button.

Click on the Joint located at the point 1
of the following image. Click on the Joint
at point 2 and two members are
generated along X axis.

Press ESC to terminate the Generate
Beam Command.




Ve

Step #20. Split Girders: Click on the icon SPlit  and click on the member marked in A (of the
following image) and then press <ENTER>.

&
S

In order to define the Distance for spliting the member or the number of parts (negative
number), enter 4.5, so that the beam will be split at the location 4.5ft from the start of the
member (see Notes of Step #18 for more information about the split command).
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Again, click on the icon Pt and click on the member B (of the previous image) and then
press <ENTER>. In order to define the Distance for spliting the member or the number of parts
(negative number), enter 9, so that the beam will be split at the location 9ft from the start of the
member (see Notes of Step #18 for more information about the split command).

Click on the icon @ Clear to remove the informative cross section shapes in the middle of each

member.

Step #21. Create additional braces: Click on the icon Generate gand Place Member form appears.
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Cross Section Select WT16x15 WTAISC14 14th
Table Section: Edition 2011 as the cross section
WT6x15 WTAISC14 AISC 14th Edition 2011 V| |+« and make sure that Material is set

to Steel, Releases to Pin-Pin and

or Member Dimensions: .
! Beta angle is 0.

<Select Shape > v
Make sure that the option “Split

e Intersecting Members” is ON and

<Select Existing Member > - “Split Ending Members is also ON.
Uncheck Physical Member option.
Material
Press the “Place Member >>"
Steel v
button.
Releases Beta (0) Click on the Joint located at the
Pin-Pin v 0 v point 1 of the previous image. Click
on the Joint at point 2 and the
Split Intersecting Members [ ]Physical Member brace member is generated.
V] split Ending Members Having the command still active,

click on the Joint at point 2 and
midpoint 3 and another brace
member is generated.

Place Member(s) >>

Repeat the same procedure to generate two more members from points 3 to 4 and 4 to 5.

B>
>

Press ESC to terminate the Generate Beam Command and click on the icon & Clear to remove
the informative cross section shapes in the middle of each member. The created model is
displayed in the following image.
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Step #22. Switch to 3D View

y Col
Click on the icon © Colors to set different colors for each profile.

Colar Options et

Sections Groups

Cateqories
Sections Color Visible
W12x50 161 2
W10d5 191 2
WT6x15 [v

Press OK to close the Color Options Dialog. Each cross section will now have a different color.
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Press the icon 27 to display the 3D solid view of the model, replacing the wireframe view:

. F . . .
Press the icon A Frame to switch back to wireframe view to be able to process CAD Modeler’s
and AutoCAD’s/BricsCAD’s commands faster.

Step #23. Save your Model: In order to save your model just use AutoCAD’s or BricsCAD’s save
command and store the DWG using any filename that you want.
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/ Releases

Step #24. Change member releases: Press the icon (in GTS Display Tab of the

ribbon) to show releases for each member.

<& Clear to clear the annotations and zoom at the area of the following image.

/ Releases &) Clear

Click on the icon

Again, press the icon to show releases for each member. Click on the icon

to clear annotations.

1

/1//)? A
Y
g
iy
2 B

A
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Select member marked in A by double clicking on it and uncheck the My and Mz Releases of the
member at its End. Note that this member belongs to Physical Member PM14.

Member Properties

General

Mame :

Level :

Beta Angle :

(Groups

Inactive

Type - Incidences

Type:  |SPACEFRAME -
Start 3
End : 4

Physical Member |FM14

Remove

Groups that Member belongs

PM14

Model  Section Properties  Member Loads  Member Temperature Loads  Member Distrortions

Section Properties

Section ; W 10x45 W-AISC14 AISC 14tk

. | 0.0923611 | - | 7.28202-005 |
Ay | D.DZ45486| Iy | 0.0025?524|
. | 0,0460408 | - | 0,0119598 |
Sy: | 0,00769676 | By | 0 |
- | 0.0234144| s | D|
vd s | 0.84166?| ves | 0.420833|
7 | 0.668333| - | 0.33416:-'|
Shape Code :
Material Properties
Material : |Steel ~
c. | 4,176e+006 | Density| 0.489543 |
| 1.58399e+uus| J— | l.l?e-DDS|

G:

Poissan

x

Releases & Elastic Connection spring values

Quick Selection : ~
Start End  Spring

COFx 0 | COFx | 0 |
Ory o O | 0]
[JFz o] O | o]
DMX 0 | DMX I 0 |
[my ° | Oy | o |
Mz 0 | Omz | 0 |
End Sizes OR Member Eccentridties (Offsets)

End
Sizes : | g | | b |
L © | K | v |
¥ g | ¥ | . |
Z: v | Z: | & |
Cancel Apply

By pressing OK, you get an error message, saying that the Physical Member PM14, has its
analytical member 54 (is the member marked in B in the image above) with internal releases at
its start. Physical members are now allowed to have internal releases at their internal joints but
only at their starting and ending joints.

Note: This error can also be located using the Check Physical Member command as well, as
explained in 2.6.26 and this command will be used in a following step.

Errorill

start

Physical Member PM14: Ending Member 54 has internal RELEASES at its

In order to fix the physical member PM14, select member marked in B by double clicking on it
and uncheck the My and Mz Releases of the member at its Start and press OK.
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Member Properties x
Model  Section Properties  Member Loads  Member Temperature Loads  Member Distrortions
General Section Properties Releases & Elastic Connection spring values
Mame : Section :  W10x45 W-AISC14 AISC 14tk Quick Selection V
Level: ax: | 00923LL| . [7.282020005|  start spring End  Spring
ay | 00245486 | Iy | 0.00257524 | [Jex | 0 | [Jrx | 0 |
Type - Incidences Az | 0.0460408 | Iz: | 0.0113538 | DFY | a | DFY | o |
0.00709676 . a 0 a
Type: SR TTE o Sy: | | Ey: | | [JFz | | [JFz | |
Start 34 sz | 0'0284144| Ez: | . | [Imx | 0 | Cmx | a |
. 0.841667 . 0.420833 !
End 35/ | ¥ I I e I I Oy | o] &my 0]
0.668333 0.334167
2d: Zc:
Beta Angle : t Oz | 0 | bAm: | 0 |
Shape Code :
Physical Member | FM1% ape Lode
End Sizes OR Member Eccentricities (Offsets)
Groups Start End
Material Properties
Inactive Remove ) | 0 | | 0 |
Material : |Steel il Sizes :
Groups that Member belongs
Mg c. | 4,176e+006 | Density| 0.489543 | . | 0 | . | 0 |
G | 1.58399e+006| j— | 1.17e-005 | v | 0 | v | 0 |
Poisson Z: | L | Z: | 2 |
| [

No errors are reported now.

Select member marked in C by double clicking on it and check the My and Mz Releases of the
member at its Start. Note that this member does not belong to any Physical Member. It was
belonging to PM7, but when a part of it was deleted (Step #18) the PM7 definition was deleted
as well. Press OK to close the properties form.
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Member Properties

Model  Section Properties Member Loads Member Temperature Loads Member Distrortions

General Section Properties Releases & Elastic Connection spring values
Name : \j‘ Secton: [WADKSWoAISCIAASCHAY |  Quickselecton: |
Level : \:‘ Ax: | 0.0923611| - |7.zszozeoo5] Start  Spring End  Spring

ay: | o02s%es| [ 000257524]  [ex | o] Oex |
Type -Incdences Az: | 00%0408| . [ 0011958 [ | o Oy |
Type: | SPACEFRAME v sy: | 00076%76 | g, | o] OF: | o O |
- S I P e R =
. - vd: | 0.841667| ver | 0.420833| vy I °| Dy I
et o 2d: | 0.668333| 7 | o.334157| iz I OI D I
| P

End Sizes OR Member Eccentricities (Offsets)

Groups Meterial Properses Start End
i ==

E: | H176e4006 | oo | 0.489543 | x: | o] y. |

G: 1583994006 . |  1.17e-005 | v | o . |

Poisson Z: l ol Z: l

/ Releases .

Press the icon to show releases for each member.

A

&) Clear

Click on the icon to clear annotations.
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5.7. Define supports

Step #25. Create supports: Use AutoCAD’s Cube or BricsCAD’s’ Chair to change the view to

B Support

Front. Press the icon (in GTS Modeling Tab of the ribbon), select all Joints at the

bottom, by clicking at points A and B of the following image, and press ENTER.

At the Joint Properties [Multiple Selection] dialog box select Fx, Fy, Fz and Mz as supports for the
selected joints and press OK.

Joint Properties [Multiple Selection] X

Model  Jgint Generalized Loads

General Joint Coordinates and Offsets

Name : |:| Coordinates
Level: 1 «

¥

Z:

1]

Rotation
theta X : Restraints & Spring values
theta ¥ :
Quick Selection : ~
bewz: [ ]
Resfraint Spring Restraint  Spring
Groups Fx | | [m]mx |
Inactive Remave Fy (] ray
Groups that joint belongs Fz vz
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& Joint Supports

Switch the view to Top Front Right (as in Step #6), and press the icon (in GTS

Display Tab of the ribbon) to view Joints supports.

P
>

-

-

-

&) Clear

Click on the icon to clear annotations and symbols.

5.8. Define Loads

Step #26. Change UCS: At the command Z
window, type UCS and then give w, to
change to World UCS. \4‘}

N
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Step #27. Define self-weight: Click on the Self Weight or Dead Loads x
1Y) Wei . .
icon == Self Weight 4 define self-weight Load Information
load case. G|Ye a Name and a Description. N
Select Negative Z. bescripton ;| 5% Vieght
. .. Create Mew 5 Modi Delete
Make sure that the option “Include Finite == el =
Elements" is ON. Loads applied parallel to this Global Axis
(O Megative ¥ () Positive ¥
@Negaﬁve z OPosih’\re Z
ONegaﬁve X OPosih’\re X
e [ Indude Finite Elements
cance

5.9. Perform analysis

Step #28. Overview the model and run checks.

I:|n Joints Duplicates

Check for duplicate joints: Click on the icon , under the “Check” Drop Button,
located in Find/Change/Check at Ribbon Area. For the Merge Tolerance <0.001000>, just press
<ENTER> to accept the default value. You should get the verification that:

0 duplicate joints found
Check for floating joints: In order to check for joints not connected to the model, click on the

icon -H-JomtEFloatingE , under the “Check” Drop Button, located in Find/Change/Check at Ribbon
Area. If your model was created as described so far, you should get a notification:

0 floating joints found

e Physical Members

Check Physical Members: Click on the icon , under the “Check” Drop
Button, located in Find/Change/Check at Ribbon Area. ). This check applies to Physical Members
having two or more analytical members. The output should be (press F2 to extend the command
line height and see all of it.

Physical Member PMl: OK
Physical Member PM2: OK
Physical Member PM3: OK
Physical Member PM5: OK
Physical Member PM6: OK
Physical Member PM8: OK
Physical Member PM10: OK

226



Physical Member PM14: OK
0 Errors Found

Note: You can also run all other checks of the same drop list, to check for Interference Joints,
Duplicate Members, Zero Length Members, Duplicate Names and Database Integrity. You should
not get any errors or warnings.

View physical members: Click on the icon €} Options in the ribbon bar and in the Display
Options Form check Visible Labels for Members, set Font Size for Members equal to 0.5, Set
Shrink Factor to 0.9 and display members as “Physical”.

Display Options >
Visible Objects Visible Labels
Joints - [ Jgints |
Members - Members | |
2D Elements 2D Elements
3D Elements 3D Elements |
Label Settings - Font Sizes Ohject Sizes
Toints : 0.820210 Jaint : 0.164042
Members ; 0.500000 Load Arrowhead (pts): 10.00000
2D Elements ; 0.820210
— 0.820210 Display Members [ Elements
Annotation (pts) 10,000000 Shrink Factor 0.9 o
Amotalion Eamat » [ Do Mot Display Thickness in 30
Decdmal Places : 2 = Members As: Physical — ~

Press OK to close the form and to see the physical members in wireframe view.
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Click on the icon Q Colors and select the 2" Tab in order to colorize members by their group.
Member do not belonging to any Physical Member are in the “Ungrouped data”. Their default
color is BYLAYER (256), meaning use the color from Display Options Form, but you can set any
other color. Press OK to close the Color Options Form.

Color Options ps Display Options *
Sectiors  Groups visible Objects visible Labels
Categories
Joints - [ 3cints |
Groups Color | Visible =
PM4 50 I7 Members - I Members |
PMS [
M6 |7 2D Elements | 2D Elements |
PM7 ¥ 3D Elements | 30 Elements |
PM8 130 v
PMO v
PM1D v
PMT1 3
PM12 v
PM13 v
PM14 2 v
UnGrouped data 256 |7 o

Mote: f you set a colorto 256 (BYLAYER) then the color is defined by the color set
at View > Optiong Dialog

If @ member/shelljoint belongs to more than one groups, the one that appears last
in thig ligt is the one that defines its” calor and visibility

Uncheck ALL Check ALL Reset Colors

Now each physical member has a different color and you can also press icon W o display the
3D solid view, as in the image bellow.
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By clicking on the icon = #nabvtical/Physical 'y can switch between physical view (image above)
and analytical view (image below). Note the difference between the physical view, where each
physical member is a single object, and the analytical view, where you can control each
analytical member individually.
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Click on the icon € Options and turn off labels for members, set shrink factor back to 1.0,
display members as “Analytical” and press OK.

C Colors

Also cick on the icon and select the 1% Tab in order to colorize members by their

section and press OK.

A Fram

Press the icon SN to switch back to wireframe view.

Step #29. Create input file: Click on the icon to create GTl input file. At the dialog box
“Create GT.STRUDL Input File” check the following and click OK.

e Perform Stiffness Analysis

e Read Joint Displacements

e Read Member Forces

e Read Section Forces

e Read Section Displacements
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Create GT.STRUDL Input File X

Export to GTI

Create GTI File : | D*\GTSTRUDL\CAD_Modeler \Examples\Example 3\Example3.gt

(® Export Whole Model (O Export Portion of the Model
(will be prompted for Selection)
[ perform Stiffness Analysis
Append Other GTI Files/Macros
+
o
:Down

[[J copy Commands from GTI Files/Macros (not CINPUT)
Create Commands to Read Results
[“1Rread Joint Displacements
[1read Member Forces
[Read Section Forces Number of Sections:
[FIRead Section Displacements U

[[Jread Finite Element Results

[[Jread Code Check Results

2 Edit GTI

Step #30. View/edit input file: Click on the icon to view/edit GTl input file.
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Nj Example3_13.gti - Notepad - m} X
File Edit Format View Help
ETRUDL * A
5 This GTSTRUDL file created from GTS CAD Modeler on Wednesday, 1@ April, 2819
33
LARGE PROBLEM SIZE 5
SET ELEMENT HASH
UNITS FEET KIPS DEGREES CENTIGRADE SECONDS
JOINT COORDINATES GLOBAL
1 a. +202 @ +8ee  @. +0ee
2 a. +2ea a. +aea 1. +881
3 2.841678BE+EE1 ©.00000DEE+EEE ©.00RBREGE+ERE
4 2.941670BE+2E1 ©.00000REE+EEE 1.500008BE+E0L
5 4.8833399E+001 ©.000CERRELBE2 0.0220000C+E00
6 4.8333399E+001 ©.000000BC+E02 1.5000080E+001
7 a. +2ea -1. +8@81 . +oae
8 a. +868 -1. +8el 1. +8e1
a 2.9416780E+201 -1.3000000E+061 ©.00B0OBBE+E0E
18 2.841678BE+2E1 -1.50800BBE+E8L 1.5000088E+E01
11 4.8333399E+001 -1.300000BE+001 ©.00R0BBBE+E0R
12 4.8833399E+0681 -1.B8@e0808E+E01 1.500808@E+001
13 4.8333399E+080 ©.000000BC+E02 1.5000080E+001
14 8.16668@1E+26@ @©.00000BBE+EEE 1.500008@E+001
15 1.2259@208E+281 ©.000000BE+E8E 1.5000088E+081
16 1.6333360E+001 ©.00000REE+EEE 1.5080080E+001
17 4.8833399E+000 -1.5000000E+001 1.5000088E+001
13 8.1666801E+200 -1.8000000E+061 1.5000080E+001
19 1.2250@208E+281 -1.B080808E+201 1.500808@E+801
28 1.6333368E+201 -1.50800BBE+E8L 1.5000088E+E81
21 2.4500040E+001 ©.00000REE+EEE 1.500008BE+E0L
22 2.8583380E+001 0.000CBROE+BEE 1.5008080E+01
23 3.2666720E+201 ©.00000DEC+082 1.500008CE+E0L
24 3.6758@59E+281 @.8000808E+008 1.5008080E+801
25 2.4508048E+281 -1.8080000E+081 1.5000088E+E01
26 2.3583380E+001 -1.3000000E+061 1.5000080E+001
27 3.2666720E+281 -1.5080000E+E8L 1.5008088E+E81 w

Step #31. Execute GT.STRUDL: Click on the icon to perform the stiffness analysis.
GT.STRUDL window will appear with information about analysis.

"’Ts GT STRUDL 2019 Beta (Not for commercial use) - - _ o w
File Edit Modeling Analysis Results SteelDesign RC Design Tools View Help
DEE~ 8 Ba[mEOW % -[d| 2K

=  0.00 seconds. ~

>
> UNITS M KN

>

> DBEX BINARY *D:\GTSTRUDL\CAD Modeler\Examples\Example3\Example3.12' REELACE

¢
{
t
¢
{ >
{ > WRITE REPLACE SECTION FORCES N5 10 AUTOMATIC 'D:\GTSTRUDL\CAD Modeler\Examples\Example3\Example3.12' MEMBERS EXISTING
*#%* INFO_WRSASF -- SECTION FORCE records have been written to file

D: \MG\ 3DR\GTSTRUDL\CAD Modeler\Examples\Example3\Example3_13.12

for €0 members and 1 loads.
##x* INFO WRSASF -- Time Lo wWrite €28 SECTION FORCE records

= 0.00 seconds.

>
> UNITS M KN

>
> DBX BINARY 'D:\GTSTRUDL\CAD Modeler\Examples\Example3\Example3.08' REPLACE

P>
} > WRITE REPLACE SECTION DISPLACEMENTS GLOBAL NS 10 'D:\GTSTRUDL\CAD Modeler\Examples\Example3\Example3.09' MEMBERS EXISTING

****INFO_WRSASD —- SECTION DISPLACEMENT records have been written to file
D:\ GTSTRUDL\CAD Modeler\Examples\Example3\Example3.0%
for €0 members and 1 loads.

#**+INFO_WRSASD —- Time to write 601 SECTION DISPLACEMENT records
=  0.00 secs.

UNITS FEET KIPS DEGREES CENTIGRADE SECONDS

Vvovvvy

+ Command:

Ready Feet | Kips | Degrees | Centigrade | Seconds |[April 10,2019 [1:29 PM

NIK
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5.10. Read analysis results

%9 Read Results

Step #32. Read GT.STRUDL results: Click on the icon to read GT.STRUDL results.

Read GT.STRUDL Results *

Read DBX Results

GTI Directory : D: \GTSTRUDLVCAD _Maodeler\Examples\Example3

Read Joint Displacements

Read Member Forces

Read Section Forces Mumber of Sections:

Read Section Displacements Mumber of Sections: !

[JRead Finite Element Results

Type of element result : <ALL=
Surface : <ALL=>
[ read Code Chedk Resuilts
GTI Commands

Corresponding GT STRUDL commands:

DEX BINARY

WRITE REPLACE JOINT RESULTS JOINTS EXISTING

WRITE REPLACE MEMBER. RESULTS MEMBERS EXISTING

WRITE REPLACE SECTIOM FORCES NS 10 AUTOMATIC MEMBERS EXISTING
WRITE REPLACE SECTIOM DISPLACEMENTS GLOBAL NS 10 MEMBERS EXISTING

Cancel

: _GTSResultsarI
Results Loaded Successfully

5.11. Display analysis results

7 Def d
Step #33. Graphical display of analysis results: Click on the icon |/ Deforme , under the

“Deformation” Drop Button, located in “Display Results” at Ribbon Area, to display deformed
shape of the model for Self Weight load case and press ENTER two times.
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Select Load Case n

Load Case

5 seif weight v

A Annotate Displacements

Step #34. Annotate displacements: Click on the icon - , under the
“Deformation” Drop Button, located in “Display Results” at Ribbon Area, to annotate
displacements of the deformed model at specific Joints of interest.
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JAN - Joint:34
/ N\ " dX:1.981e—05
/ dYi—8.18e—08
/ > dZ:-0.003054
/ T
</ | W Joint:35
/ dX:1.981e—05
/ ; N - dY:—2.28e—07
” " X dz:-0.003215
| A
/ ) P \
/ ‘ 7 \\
/ Joint:22 . 7 \
/ dX:2.077e—0 . \
* dY:—8.112e—08 x
dZ:-0.001773 VAN ¢ /1*». \
\ / N\ \
’,/' \\ _ /’
/
\ /
/i N\
\ / \
v / N\
\ / b S
\\ r/
\{/

Click on the icon <& Clear to clear additional generated symbols. Click on the icon

i Undef d
|| Undeforme to display undeformed model again.

Step #35. Display Section Displacements: Click on F'? Displacements (ribbon tab “GTS Display”).
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Select:

Displacements
- 1asload Case

Load Case / Load Combination - 0.1as Scale Factor
1§ Self Weight o - 10.00 as Font Size (default)
- Annotation Format: Exponential
- Check Hide Model
Display Options
Press “Display >>" and zoom at the upper left
Scale Factor (Values) : 5.1 end of the structure as shown in the image
below.
Font Size (pt) : -
Annotation Format:  Exponential v Press “Annotate >” and click on any part of
Decimal Places : 2 v the deformed shape curve and then at the
' position that you want the annotation to be
[¢] Hide Model displayed.
Press on “Legend >” and click at any part of
Display >> the screen to place the legend of the
diagram.
Annotate > Legend >
Animation Options
Frames : J
Animation Speed % : 1 b
Generate Animation .
e Animate >>
Clear Close
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In order to display the animation, press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

In order to exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.

Di
Step #36. View member diagrams: Click on the icon A to view member diagrams. In

the dialog box “Member Diagrams”, select MZ Moment as Values, 2 as Decimal Places and click
on “Display”.
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Member Diagrams n

Load Case [ Load Combination

| 1§ Self weight v|

[Envelope

< :
Values -‘ \ 1

Digplay Options / ’ | A

/
Scale Factor (Values) 0.100 / b ’
Font Size (pt) 1000 ¥ by, ’

~ r \"\
& * \
- /N '~ \
Annotation Format: | Decmal v y 4‘\ / \
/ 7
Dedmal Places : 2 hl / /
bé ‘\
[JLabel Max &Min ] Positive Sian / g \ \
/ \ /
- X //l ‘&&
\ /
Display = \ /
r‘lf
Annotate > Legend = \ i
Clear Close

You can also annotate moments at specific Joints by clicking “Annotate” in the dialog box
“Member Diagrams” and select the desired precision (decimal places) as well as the annotation
format (decimal, exponential, generic).
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w MZ:—2.96
@:15.00
|'I/ \""\

c‘l \ \
/ N\
4“‘“"" . \ ..\\
/i N \
.“/I \,
."“v“ \\n
/ N\
J / fk‘l;
.'/
\"‘/I’
.-'JJ’J
.f/
/o Mz:3.64
b/ @:0.91
|J/
/ MZ:—5.13
@:4.08
J‘l"’lllv
_/' u]
"v“/{"‘

Select “Clear” and “Close” to clear the diagram/annotations and terminate the command.

Bl Displacements

Step #37. Display results in datasheets: Click on the icon , on Results

Datasheets area, to view analysis results in datasheets.
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GTSTRUDL - Joint Displacement Datasheet, display Units: Feet Degrees

- oM

i
File Edit Columns Filter Sort Units Help
Joint | Load | Trans x | Trans ¥ | Trans z | Rotation X | Rotation ¥ | Rotation z |

1 1 0.0000 0.0000 0.0000 -0.0003399 -0.0048971 0.0000000

2 1 0.0000 -0.0000 -0.0001 0.0006845 0.0107201 0.0000026

3 1 0.0000 0.0000 0.0000 -0.0039857 0.0024911 0.0000000

4 1 0.0000 -0.0000 -0.0001 0.0080282 -0.0051456 0.0000033

s 1 0.0000 0.0000 0.0000 -0.0004337 0.0012434 0.0000000

6 1 0.0000 -0.0000 -0.0000 0.0008740 -0.0025264 0.0000008

7 1 0.0000 0.0000 0.0000 0.0003399 -0.0050672 0.0000000

8 1 0.0000 0.0000 -0.0001 -0.0006842 0.0111001 0.0000014

s 1 0.0000 0.0000 0.0000 0.0039877 0.0025457 0.0000000
10 1 0.0000 0.0000 -0.0001 -0.0080274 -0.0052484 0.0000022
11 1 0.0000 0.0000 0.0000 0.0004335 0.0012498 0.0000000
12 1 0.0000 0.0000 -0.0000 -0.0008738 -0.0025280 0.0000019
13 1 0.0000 0.0000 -0.0011 0.0021532 0.0120130 -0.0000007
14 1 0.0000 -0.0000 -0.0017 0.0036220 0.0044458 -0.0000022
15 1 0.0000 -0.0000 -0.0017 0.0050307 -0.0056013 -0.0000005
16 1 0.0000 -0.0000 -0.0009 0.0065595 -0.0117479 -0.0000043
17 1 0.0000 0.0000 -0.0001 0.0065356 0.0006018 0.0000072
18 1 0.0000 0.0000 -0.0001 0.0050429 0.0007610 -0.0000009
19 1 0.0000 0.0000 -0.0002 0.0036121 0.0013782 -0.0000009
20 1 0.0000 0.0000 -0.0003 0.0022431 -0.0015496 -0.0000012
21 1 0.0000 0.0000 -0.0011 -0.0021523 0.0126868 -0.0000010
22 1 0.0000 -0.0000 -0.0018 -0.0036215 0.0045080 -0.0000018
23 1 0.0000 -0.0000 -0.0017 -0.0050902 -0.0061676 -0.0000028
24 1 0.0000 -0.0000 -0.0009 -0.0065588 -0.0120713 0.0000048
28 1 0.0000 0.0000 -0.0001 -0.0065349 0.0005932 -0.0000016
26 1 0.0000 0.0000 -0.0001 -0.0050424 0.0007877 0.0000009
27 1 0.0000 0.0000 -0.0002 -0.0036117 0.0013302 -0.0000014
28 1 0.0000 0.0000 -0.0003 -0.0022428 -0.0015499 -0.0000004
29 1 0.0000 -0.0000 -0.0001 0.0000001 0.0106267 0.0000053
30 1 0.0000 0.0000 -0.0001 0.0000001 -0.0024599 0.0000042
31 1 0.0000 0.0000 -0.0002 0.0042966 0.0012625 -0.0000008
32 1 0.0000 0.0000 -0.0002 -0.0042961 0.0012849 -0.0000007
33 1 0.0000 0.0000 -0.0026 0.0116327 0.0122002 -0.0000086
34 1 0.0000 -0.0000 -0.0031 0.0116465 0.0042854 -0.0000017
35 1 0.0000 -0.0000 -0.0032 0.0116604 -0.0057586 0.0000170
36 1 0.0000 0.0000 -0.0012 0.0107657 -0.0003520 0.0000168
37 1 0.0000 0.0000 -0.0012 -0.0107855 -0.0003530 -0.0000098
a8 1 0.0000 -0.0000 -0.0010 0.0000003 -0.0037684 0.0000039

Click on the icon

File Edit Columns

51 Member Forces

to view member forces results in datasheets.

GTSTRUDL - Member End Force Datasheet, display Units: Feet Kips
Filter Sort Units Help

Member l Load l Joint I Force X I Force ¥ I Force Z | Moment X IHnmm'. ¥ IHcmem: Z I A
I 1 1 2.1786 -0.1308 0.0018 -0.0000 -0.0001
1 1 2 -1.4341 0.1%08 -0.0018 0.0000 -2.8618
2 1 3 3.6514 0.0933 0.0211 -0.0000 0.0000
2 1 L) -2.9068 -0.0933 -0.0211 0.0000 1.3994
3 3 5 1.4975 0.0461 0.0023 -0.0000 0.0000
3 1 € -0.7530 -0.0461 -0.0023 0.0000 0.6908
4 1 7 2.1796 -0.1975 -0.0018 -0.0000 -0.0001
4 1 8 -1.4351 0.1975 0.0018 0.0000 -2.962¢6
5 1 9 3.6544 0.09s52 -0.0211 -0.0000 -0.0000
5 1 10 -2.9099 -0.0952 0.0211 0.0000 1.4282
€ 1 11 1.4984 0.0462 -0.0023 -0.0000 0.0000
€ 2! 1z -0.7533 -0.0462 0.0023 0.0000 0.6€923
7 1 2 0.1908 1.2561 -0.0000 -0.0008 2.8618
7 1 13 -0.1908 -1.0535 0.0000 0.0008 1.8536
14 1 13 0.1906 0.4071 -0.0000 -0.0008 -1.8537
14 1 14 -0.1906 -0.2044 0.0000 0.0008 3.1021
1s 1 14 0.1906 0.2044 -0.0000 -0.0008 -3.1021
1s 1 1s -0.190& -0.0017 0.0000 0.0008 3.5230
16 2 1s 0.1s08 -0.6447 0.0002 -0.0008 -3.5223%
16 1 16 -0.1908 0.8474 -0.0002 0.0008 0.4767
17 1 16 0.1%08 -1.2543 -0.0005 -0.0008 0.0006 -0.4766
17 1 4 -0.1908 1.4570 0.0005 0.0008 0.0014 -5.0588
8 1 4 0.0975 0.9123 0.0005 0.0008 -0.0011 3.65%0
8 p 3 17 -0.0975 -0.7096 -0.0005 -0.0008 -0.0008 -0.347¢6
18 25 17 0.0976 0.2118 -0.0002 0.0008 0.0008 0.3481
18 1 18 -0.0976 -0.0091 0.0002 -0.0008 0.0000 0.1030
20 1 19 0.0460 0.2453 -0.0000 0.0008 0.0000 -0.8225
(] 1 20 -0.0460 -0.0427 0.0000 -0.0008 0.0000 1.2104
21 1 20 0.0460 -0.3643 -0.0000 0.0008 -0.0000 -1.2104
21 b 3 € —-0.0460 0.5663 0.0000 -0.0008 0.0001 -0.6908
S 1 8 0.1975 1.2571 -0.0000 0.0008 0.0002 2.9827
9 1 21 -0.1975 -1.0545 0.0000 -0.0008 -0.0000 1.7568 v

Click on the icon

B Section Forces

to view section forces results in datasheets.
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L GTSTRUDL - Section Force Datasheet, display Units: Feet Kips

File Edit Columns Filter Sort Units Help

Member | Load | section [ axial | ¥ shear |z shear | ¥ pending 2 bending | A
3 1 0.000 0.1908 -0.0018 0.0000 0.0000 0.0001
1 1 o.an 0.1308 -0.0018 0.0000 -0.0030 -0.3179
z 1 o0.222 0.1308 -0.0018 0.0000 -0.0060 -0.6359
1 1 0.333 0.1908 -0.0018 0.0000 -0.0090 -0.9539
1 1 0.444 0.1308 -0.0018 0.0000 -0.0120 -1.2719
1 1 0.556 0.1908 -0.0018 0.0000 -0.0150 -1.5899
2 1 0.667 0.1908 -0.0018 0.0000 -0.0180 -1.9079
1 1 0.778 0.1308 -0.0018 0.0000 -0.0210 -2.2258
1 1 0.889 0.1908 -0.0018 0.0000 -0.0240 -2.5438
1 1 1.000 0.1308 -0.0018 0.0000 -0.0270 -2.8618
2 1 0.000 -0.0333 -0.0211 0.0000 0.0000 -0.0000
2 1 o.a1 -0.0933 -0.0211 0.0000 -0.0352 0.1555
2 1 o0.222 -0.0333 -0.0211 0.0000 -0.0704 0.3110
2 1 0.333 -0.0933 -0.0211 0.0000 -0.1056 0.4665
2 1 0.444 -0.0933 -0.0211 0.0000 -0.140% 0.6218
2 1 0.556 -0.03933 -0.0211 0.0000 -0.1761 0.7774
2 1 0.667 -0.0933 -0.0211 0.0000 -0.2113 0.9329
2 1 0.778 -0.0933 -0.0211 0.0000 -0.2466 1.0884
2 1 0.88% -0.0933 -0.0211 0.0000 -0.2818 1.2433
2 1 1.000 -0.0933 -0.0211 0.0000 -0.3170 1.3994
3 1 0.000 -0.0461 -0.0023 0.0000 0.0000 -0.0000
3 1 0.1 -0.0461 -0.0023 0.0000 -0.0038 0.0767
3 1 o0.222 -0.0461 -0.0023 0.0000 -0.0077 0.1535
3 1 0.333 -0.0461 -0.0023 0.0000 -0.0115 0.2303
3 1 0.444 -0.0461 -0.0023 0.0000 -0.0153 0.3070
3 1 0.556 -0.0461 -0.0023 0.0000 -0.0192 0.3838
3 1 0.667 -0.0461 -0.0023 0.0000 -0.0230 0.4605
3 1 0.778 -0.0461 -0.0023 0.0000 -0.0269 0.5373
3 1 0.889 -0.0461 -0.0023 0.0000 -0.0307 0.6141
3 1 1.000 -0.0461 -0.0023 0.0000 -0.0345 0.6908
4 1 0.000 0.1975 0.0018 0.0000 0.0000 0.0001
4 1 0.1 0.1375 0.0018 0.0000 0.0030 -0.3281
4 1 o0.222 -2.0141 0.1975 0.0018 0.0000 0.0060 -0.6583 v

B FReactions

Click on the icon

GTSTRUDL - Joint Reactions Datasheet, display Units: Feet Kips

to view reaction results in datasheets.

- oM

File Edit Columns Filter Sort Units Help
Joint I Load I Force X I Force Y I Force Z I Moment X X I Moment I
1 1 0.191 -0.242 2.709 -0.000 0.000 0.000
3 b 0.400 -0.021 4.511 -0.000 -0.000 -0.000
E] z -0.590 -0.237 2.955 -0.000 -0.000 0.000
7 1 0.198 0.242 2.710 0.000 -0.000 -0.000
9 1 0.393 0.021 4.508 0.000 -0.000 0.000
11 1 -0.591 0.237 2.957 0.000 -0.000 -0.000

Step #37. Display results in Report Builder: Click on the icon

Builder.
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- oM

Style ~ @

Ready

242

. E n D S (. JointName: AL | Loading: ALL v &® @
= SF | Member Name: ALL Level: AL we
Open  Generate Image Text RTF Insert Remove  Print Print - Apply Filtersto | Format | Help
File Overall Report ile Preview Element Name | ALL Surface: |ALL w | Checked ltems | Options
File Insert Header and Footer. Print Filters Format Help |
GTSTRUDL Reports A
[ Contents Analysis Results
& []Model Data
[[] Groups o
[]Joint Coordinates Joint Displacements
[ Joint Rt
L] Membier licidences Length: FEET, Force: KIP, Angle: DEG, Temperature: DEGC , Time: SEC
[ Member Properties
[ Member/Element Constants
[J Element Incidences Joint Load Trans X Ro [ Rotation Z
[[] Element Properties 0000000 E | 0.0000000
&[] Load Data 0000231 0006845 | 0.0107201 | 0.0000026
[ Summary of Loadings 0000000 E 0.0024911 0000000
U pieh 0000139 ~0.0051456 0000039
] Loading Combinations 0000000 T 0.0012434 | 0.0000000
[} Joic Loads 3 0000105 0025264 | 0.0000005
[JMember Loads 7 0000000 .0050672 0000000
[[] Element Loads s 0000246 04 0111001 |
£ [7] Analysis Results 9 0000000
001 o
L] Support Joint Reactions 0000000 | o
] Member Forces 0000115 | o
v 0000213 | o
[ Section Forces 0000194 0.
- [] Average Element Resuits 0000176 | o
[ Member Results Graphs 0000158 | T
[] Design of Steel Members 0006018 : X
0007610 | -0
.0013782 |04
o
Y
=
E
o
3 o &
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6. Appendix — List of Commands

Command Icon

Units -
X Units

Materials

- .
= Materials

Sections I

Sections

Prismatic Sections

Levels a

Levels
Higher Level A Higher Level
Lower Level VW Lower Level
All Levels ON &) All Levels ON
Grid

Grid
Change Grid ## Change Grid

Generate Joint
B Generate

At Level (Joint)

& AtLevel
Find (Joint) % Find Joint
Support B Support

Change (Joint)

Generate
(Member) /

Generate

®. Change Joint

Menu

GTS Modeling>Units

GTS Modeling>Materials

GTS Modeling>Cross
Sections>Table

GTS Modeling>Cross
Sections>Prismatic

GTS Modeling>Levels

GTS Display>All Levels ON

GTS Modeling>Grid>Create

GTS Modeling>Grid>Change

GTS
Modeling>Joint>Generate
Joint

GTS
Modeling>Joint>Generate
Joint at Level

GTS Modeling>Joint>Find

GTS Modeling>Joint>Support

GTS Modeling>Joint>Change

GTS Modeling>
Members>Generate Beam
Members
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Command Prompt

GTSUnits

GTSMaterials

GTSParams

GTSPrismatic

GTSLevels

GTSLevelUp
GTSLevelDown

GTSSetAllVisible

GTSGrid

GTSGridChange

GTSJoint

GTSJointLevel

GTSFJID

GTSJointSupport

GTSJointChange

GTSBeam

Link

N
(o)}
[y

N
N

N
[o)}
[(=}

N
o

N
(o2}
w

N
D
w

g
o
w

N
e
w

N
>

N
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Vertical (Member)

Find (Member)

Split (Member)

Split to Crossing

Members

Merge (Member)

Change (Member)

Filter (Members)

Generate Quad

Generate Triangle

Reverse Incidence
Order
Find (Shell)

Change (Shell)

Locate Duplicates

Locate Floating

Joints
Interference

Members
Duplicates

Members Zero
Length

[

Vertical

. Find Member

"7 Change Member
Y Filter

"1 Quad

L] .
4% Triangle

5] Reverse

1] Find Shell

D Change Shell

I:|n Joints Duplicates

E Joints Floatings

/ Joints Interference
@ Mermnbers Duplicates

’ Members Zero Length

GTS Modeling>
Member>Generate Vertical
Member

GTS
Modeling>Member>Find

GTS
Modeling>Member>Split
Member

GTS
Modeling>Member>Split to
Crossing Members

GTS Modeling>
Member>Merge Members

GTS Modeling>
Member>Change

GTS Modeling>
Member>Filter

GTS
Modeling>Shell>Generate
quad at joints

GTS
Modeling>Shell>Generate
triangle at joints

GTS Modeling>Shell>
Reverse Incidence Order

GTS Modeling>Shell>Find

GTS
Modeling>Shell>Generate
triangle at joints

GTS Modeling>Checks>Joints
Duplicates

GTS Modeling>Checks>Joints
Floatings

GTS Modeling>Checks>Joints
Interference

GTS
Modeling>Checks>Members
Duplicates

GTS
Modeling>Checks>Members
Zero Length
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GTSColumn

GTSFMID

GTSSplitMember

GTSSplitToMembers

GTSMergeMembers

GTSBeamChange

GTSFilterMembers

GTSShell

GTSShellT

GTSShellReverse

GTSFeid

GTSShellChange

GTSCheckDuplicateJoints

GTSCheckFloatingJoints

GTSCheckInteferenceJoints

GTSCheckDuplicateMembers

GTSCheckMembersZeroLength



Physical Members

Shells Duplicates

Names Duplicates

Renumber Names

Database Integrity

1D Curve
(Meshing)

2D 2Curves

(Meshing)

2D 4Curves
(Meshing)

2D Area (Meshing)

3D Extrude
(Meshing)

2D 3Curves
(Meshing)

Array 3D
Advanced

Soil Springs

Export STR

Convert
Lines/Polylines to
Members/Shells

o Physical Members

@ Shells Duplicates
Mames Duplicates

'i_ Renumber Mames

‘_%, Database Integrity

(o]

C -
EO‘\
m

2D
2Curves
:
4Curves
2D
Area
¢ 3D
N Ctrude

l g 3D
< 3Curves

o

Array 3D
Advanced

i1

Soil
Springs

DXF|Convert Lines to Members

GTS
Modeling>Checks>Physical
Members

GTS Modeling>Checks>Shells
Duplicates

GTS
Modeling>Checks>Names
Duplicates

GTS
Modeling>Checks>Renumber
Names

GTS
Modeling>Checks>Database
Integrity

GTS Modeling>Mesh
Generation>1D Along Line or
Curve or Circle

GTS Modeling>Mesh
Generation>2D Between 2
Lines or Curves

GTS Modeling>Mesh
Generation>2D Between 4
Lines or Curves

GTS Modeling>Mesh
Generation>2D Between 4
Lines or Curves

GTS Modeling>Mesh
Generation>3D Extrude
PolyLine

GTS Modeling>Mesh
Generation>3D Between 3
Lines or Curves

GTS Modeling>Soil Springs

GTS Modeling> CAESAR
lI>Export STR

GTS Modeling> Convert

Lines/Polylines to
Members/Shells
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GTSCheckPhysicalMembers

GTSCheckDuplicateShells

GTSCheckNames

GTSRenumber

GTSCheckDatabase

GTSMeshlD

GTSMesh2D2L

GTSMesh2D4L

GTSMesh2DPoly

GTSExtrudePoly

GTSMesh3D3L

GTSArray3D

GTSFoundationSprings

GTSExportSTR

GTSDXFRead

2.6.34
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Model Wizard

List (Group)

+Joints (Group)
+Members
(Group)

+Shells (Group)
Self Weight
Load Cases
Load
Combinations
Standardized

Combinations

Joint Load

Member Load

Shell Load

Area Load

Wind Load ASCE
705

Wind Load ASCE
710

Seismic Load

Steel Design
Parameters

Create Input File

Edit GTI

)‘, Model Wizard

List

il +Joints
-*

o
=4 +Members

i0: +Shells

i Self Weight
] Load Cases

2 Combinations
@ Standardized Combinations

* loint Load
- * 5 Member Load

m Shell Load

3 Area Load

: _— Wind Load ASCE 705

: _— Wind Load ASCE 710

Ji|lw- Seismic Load

Axsin
GTS

) Edit GTI

GTS Modeling>Model
Wizard

GTS
Modeling>Groups>Manage

GTS Modeling>Groups>Add
Joints

GTS Modeling>Groups>Add
Members

GTS Modeling>Groups>Add
Shells

GTS Modeling>Loads>Self
Weight

GTS Modeling>Loads>Load
Cases

GTS Modeling>Loads>Load
Combinations

GTS
Modeling>Loads>Standardiz
ed Combinations

GTS Modeling>Loads>Joint
Load

GTS
Modeling>Loads>Member
Load

GTS Modeling>Loads>Shell
Load
GTS Modeling>Loads>Area

Load

GTS Modeling>Loads>Wind
Load ASCE 705

GTS Modeling>Loads>Wind
Load ASCE 710

GTS
Modeling>Loads>Seismic
Load

GTS Modeling>Steel Design
Parameters

GTS Modeling>Create Input
File

GTS Modeling>Edit GTI
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GTSModelWizard

GTSGroups

GTSGroupJoints

GTSGroupMembers

GTSGroupShells

GTSSelfWeight

GTSNewLoadCase

GTSLoadCombination

GTSLoadCombinationStandardized

GTSJointLoad

GTSBeamLoad

GTSShellLoad

GTSAreaload

GTSWindLoadsASCE705

GTSWindLoadsASCE710

GTSSeismicLoading

GTSSteelDesignParameters

GTSExportGTI

GTSEditGTI
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Execute GT
STRUDL

Read Results

Import GTI

Set View

3D View

Analytical/Physical

Frame View

Options (View)

Colors

Annotate

Select

Display Member
Local Axes

Display Member
Releases

Display Shell
Planar Axes

Display Joint
Supports

Display Joint
Loads

Display Member
Loads

Display Shell
Loads

Display Area
Loads

Deformed
Structure

Undeformed
Structure

Annotate
Joint
Displacements

GTS

%9 Read Results
"4 Import GTI

© Set View

= Analytical/Physical
A Frame

{} Options

C Colors

Annotate

& Select

>~ Member Local Axes
/ Releases

Ii7 Shell Planar Axes
& Joint Supports

g Joint Loads
iLtMember Loads
3 srea Loads

J¥ shell Loads

|/ Deformed

|} Undeformed

", }._ Annotate Displacements

GTS Modeling>Execute

GTS Modeling>Read Results

GTS Display>Set View

GTS Display>3D Sections

GTS
Display>Analytical/Physical

GTS Display>Frame

GTS Display>Options

GTS Display>Colors

GTS Display>Annotate

GTS Display>Member Local
Axes

GTS Display> Member
Releases

GTS Display> Shell Planar

Axes

GTS Display> Joint Supports

GTS Display>Joint Loads

GTS Display>Member Loads

GTS Display>Shell Loads

GTS Display>Area Loads

GTS Display>Deformed

Structure

GTS Display> Udeformed
Structure
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GTSExecuteGTI

GTSResultsGTI

GTSGTIRead

GTSSetView

GTSSet3D

GTSDisplayPhysicalMembers

GTSSetlD

GTSDisplay

GTSColorView

GTSAnnotate

GTSSelect

GTSDisplayLocalAxes

GTSDisplayReleases

GTSDisplayPlanarAxes

GTSDisplaySupports

GTSDisplayJointLoads

GTSDisplayMemberLoads

GTSDisplayElementLoads

GTSDisplayArealoads

GTSDisplayJointDisplacements

GTSDisplayJointDisplacements

GTSAnnotateJointDisplacements

Ing
N
o
N

Ing
b
o
[y
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Displacements

Member Diagrams

Finite Element
Results

Finite Element
Results Selection

Member Code
Check Results

Displacements
Datasheets

Member Forces
Datasheets

Section Forces
Datasheets

Reactions
Datasheets

Stresses
Datasheets

Code Check
Datasheets

Report Builder

Clear Results

Current Version

f¥ Displacements

W Diagrams

! Elements

z Selection

(¢, Code Check
E Displacements
: Member Forces
. Section Forces
. Reactions

BB Stresses

51 Code Check

X Clear

GTS Display> Displacements

GTS Display>Member
Diagrams

GTS Display>Element Results

GTS Display>Element Results
Selection

GTS Display>Member Code
Check Results

GTS Display>Results
Datasheets> Displacements

GTS Display>Results
Datasheets> Displacements

GTS Display>Results
Datasheets> Displacements

GTS Display>Results
Datasheets> Displacements

GTS Display>Results
Datasheets> Displacements

GTS Display>Results
Datasheets> Displacements

GTS Display>Clear Results
Layer

GTS Display>Version
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GTSDisplaySectionDisplacements

GTSDisplayMemberForces

GTSDisplayElementResults

GTSDisplayElementResultsSel

GTSColorCodeCheck

GTSDataSheetJointDisp

GTSDataSheetMemberForces

GTSDataSheetSectionForces

GTSDataSheetReactions

GTSDataSheetStresses

GTSDataSheetCodeCheck

GTSReportBuilder

GTSDisplayResultsClear

GTSVersion
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